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Safety Symbols
To prevent the risk of personal injury or loss related to equipment malfunction, Anritsu Corporation uses the following
safety symbols to indicate safety-related information.  Ensure that you clearly understand the meanings of the
symbols BEFORE using the equipment.  Some or all of the following symbols may be used on all Anritsu
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manual.

Symbols used in manual
This indicates a very dangerous procedure that could result in serious injury or
death if not performed properly.

This indicates a hazardous procedure that could result in serious injury or death if
not performed properly.

This indicates a hazardous procedure or danger that could result in light-to-severe
injury, or loss related to equipment malfunction, if proper precautions are not taken.

Safety Symbols Used on Equipment and in Manual
The following safety symbols are used inside or on the equipment near operation locations to provide information
about safety items and operation precautions.  Ensure that you clearly understand the meanings of the symbols
and take the necessary precautions BEFORE using the equipment.

This indicates a prohibited operation.  The prohibited operation is indicated
symbolically in or near the barred circle.

This indicates an obligatory safety precaution.  The obligatory operation is
indicated symbolically in or near the circle.

This indicates a warning or caution.  The contents are indicated symbolically in or
near the triangle.

This indicates a note.  The contents are described in the box.

These indicate that the marked part should be recycled.
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WARNING 
1. ALWAYS refer to the operation manual when working near locations

at which the alert mark shown on the left is attached.  If the advice in
the operation manual is not followed there is a risk of personal injury
or reduced equipment performance.  The alert mark shown on the
left may also be used with other marks and descriptions to indicate
other dangers.

2. IEC 61010 Standard
The IEC 61010 standard specifies four categories to ensure that an
instrument is used only at locations where it is safe to make
measurements.  This instrument is designed for measurement
category I (CAT I).  DO NOT use this instrument at locations
specified as category II, III, or IV as defined below.
Measurement category I (CAT I):
Secondary circuits of a device that is not directly connected to a
power outlet.
Measurement category II (CAT II):
Primary circuits of a device that is directly connected to a power outlet,
e.g., portable tools or home appliance.
Measurement category III (CAT III):
Primary circuits of a device (fixed equipment) to which power is
supplied directly from the distribution panel, and circuits running from
the distribution panel to power outlet.
Measurement category IV (CAT IV):
Building service-line entrance circuits, and circuits running from the
service-line entrance to the meter or primary circuit breaker
(distribution panel).

3. This equipment cannot be repaired by the operator.  DO NOT
attempt to remove the equipment covers or unit covers or to
disassemble internal components.  Only qualified service personnel
with a knowledge of electrical fire and shock hazards should service
this equipment.  There are high-voltage parts in this equipment
presenting a risk of severe injury or fatal electric shock to untrained
personnel.  In addition, there is a risk of damage to precision
components.

Repair
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CAUTION 

Never input a signal of more than the indicated value between the
measured terminal and ground.  Input of an excessive signal may
damage the equipment.

Check Terminal
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Equipment Certificate
Anritsu Corporation certifies that this equipment was tested before
shipment using calibrated measuring instruments with direct traceability
to public testing organizations recognized by national research
laboratories, including the National Institute of Advanced Industrial
Science and Technology, and the National Institute of Information and
Communications Technology, and was found to meet the published
specifications.

Anritsu Warranty
Anritsu Corporation will repair this equipment free-of-charge if a
malfunction occurs within one year after shipment due to a manufacturing
fault, under the condition that this warranty is void when:

• The fault is outside the scope of the warranty conditions described in
the operation manual.

• The fault is due to mishandling, misuse, or unauthorized modification
or repair of the equipment by the customer.

• The fault is due to severe usage clearly exceeding normal usage.
• The fault is due to improper or insufficient maintenance by the

customer.
• The fault is due to natural disaster including fire, flooding, earthquake,

etc.
• The fault is due to use of non-specified peripheral equipment,

peripheral parts, consumables, etc.
• The fault is due to use of a non-specified power supply or in a non-

specified installation location.

In addition, this warranty is valid only for the original equipment
purchaser.  It is not transferable if the equipment is resold.

Anritsu Corporation will not accept liability for equipment faults due to
unforeseen and unusual circumstances, nor for faults due to mishandling
by the customer.

Anritsu Corporation Contact
In the event that this equipment malfunctions, contact an Anritsu Service
and Sales office.  Contact information can be found on the last page of
the printed version of this manual, and is available in a separate file on
the CD version.
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Notes On Export Management
This product and its manuals may require an Export License/Approval by
the Government of the product's country of origin for re-export from your
country.
Before re-exporting the product or manuals, please contact us to confirm
whether they are export-controlled items or not.
When you dispose of export-controlled items, the products/manuals need
to be broken/shredded so as not to be unlawfully used for military purpose.

Disposal Procedure
The product that you have purchased contains a rechargeable battery.
The battery is recyclable.  At the end of its useful life, under various
state and local laws, it may be illegal to dispose of this battery into the
municipal waste stream.  Check with your local solid waste officials for
details in your area for recycling options or proper disposal.
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CE Conformity Marking
Anritsu affixes the CE Conformity marking on the following product(s) in
accordance with the Council Directive 93/68/EEC to indicate that they
conform to the EMC and LVD directive of the European Union (EU).

CE marking

1. Product Model
Plug-in Units: MU163220C 3.26 Pulse Generator Unit

MU163240C 3.26 Error Detector Unit

2. Applied Directive and Standards
When the MU163220C 3.26 Pulse Generator Unit and MU163240C
3.26 Error Detector Unit is installed in the MP1632C, the applied
directive and standards of this unit conform to those of the MP1632C
main frame.

PS: About main frame
Please contact Anritsu for the latest information on the main frame
types that MU163220C and MU163240C can be used with.
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C-tick Conformity Marking
Anritsu affixes the C-tick marking on the following product(s) in
accordance with the regulation to indicate that they conform to the EMC
framework of Australia/New Zealand.

C-tick marking

1. Product Model
Plug-in Units: MU163220C 3.26 Pulse Generator Unit

MU163240C 3.26 Error Detector Unit

2. Applied Directive and Standards
When the MU163220C 3.26 Pulse Generator Unit and MU163240C
3.26 Error Detector Unit is installed in the MP1632C, the applied
directive and standards of this unit conform to those of the MP1632C
main frame.

PS: About main frame
Please contact Anritsu for the latest information on the main frame
types that MP163220C and MU163240C can be used with.



I

INTRODUCTION

Organization of Operation Manuals
The MU163220C 3.2G Pulse Pattern Generator and MU163240C 3.2G Error Detector are the
plug-in units which are inserted into MP1632C Digital Data Analyzer.  Operation manuals are
prepared for the main unit and the other units, respectively, and consist of the following four
operation manuals.  Read the operation manual of the unit you are going to use.

Organization of Operation
Manual pertaining to the

MP1632C and plug-in units

MP1632C 3.2G Digital Data Analyzer Operation Manual

MP1632C 3.2G ディジタルデータアナライザ取扱説明書MU163220C 3.2G Pulse Pattern Generator
and

MU163240C 3.2G Error Detector Operation Manual

MP1632C Remote Control Operation Manual

ETHERNET Operation Manual

• MP1632C Digital Data Analyzer Operation Manual
This manual describes a brief overview, preparations before starting operation, the panel, speci-
fications, performance, and operation procedures of the MP1632C and the internal 3.2G synthe-
sizer option.

• MU163220C 3.2G Pulse Pattern Generator and MU163240C 3.2G Error Detector
Operation Manual
This manual describes a brief overview, specifications, performance, and operation procedures
related to the units of the 3.2G pulse pattern generator and the error detector.

• MP1632C Remote Control Operation Manual
This manual describes the controls using the external interface (RS-232C, GPIB option or
ETHERNET option) and sample programs.

• ETHERNET operation manual
This manual describes how to connect the MP1632C connect to LAN, using FTP, sample pro-
gram which controls MP1632C via ethernet.
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1.1 Product Overview

The MU163220C 3.2G Pulse Pattern Generator is a pulse pattern generator with a range be-
tween 10 Mbit/s and 3.2 Gbit/s.  The MU163240C 3.2G Error Detector is an error detector with
a range between 10 Mbit/s and 3.2 Gbit/s.  Both the MU163220C and MU163240C function as a
plug-in unit that can be inserted into the slots of the MP1632C Digital Data Analyzer.  They are
used for evaluation of a variety of digital communication equipment, and modules and devices
for digital communication.  These products are appropriate for research and development, and
also for manufacturing.

Features

• Bit errors can be measured both for continuous signals/burst signals.
• Rich patterns to deal with various kinds of systems

PRBS (2n-1: n=7 to 31, variable mark ratio), PRGM (8,388,608 bits), zero substitute pattern.
• Measurement items

Bit error rate, bit error count, error interval count, error-free interval count, error perform-
ance (conforming to G821), and clock frequency

• Eye margin measuring function
• Auto search function (PRBS identification, automatic setting of the optimal phase for the

pattern and clock)

Targets

• O/E and E/O converter
• Devices such as LSI for communication and ASIC/FPGA
• Device modules such as Giga-bit Ether Fiber Channel etc. for high-speed LAN
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1.2 Organization of the Operation Manual

This operation manual consists of the 11 chapters shown in the following table.

Chapter No.Chapter No.Chapter No.Chapter No. ExplanationExplanationExplanationExplanation
Chapter 1
INTRODUCTION

Product overview, organization of the operation manuals,
equipment configuration, and specifications

Chapter 2
PRECAUTIONS

Environmental conditions for installation locations and
safety measures

Chapter 3
PANELS AND CONNECTIONS

Arrangement of connectors and their connections, and ex-
planation of their functions

Chapter 4
SCREEN CONFIGURATION

Configuration of the screens

Chapter 5
BASIC OPERATIONS

Explanation of basic operations such as interface setting,
and error/alarm measurements

Chapter 6
APPLIED OPERATIONS

Explanation of the functions such as eye margin measure-
ments and impedance settings

Chapter 7
CONCRETE MEASUREMENT

Explanation of connection methods for measurements and
concrete examples of settings methods

Chapter 8
PERFORMANCE TEST

Explanation of methods for testing performance of the unit

Chapter 9
SELF-TEST

Explanation of the self-test software

Chapter 10
MAINTENANCE･SCRAPPING

Preventive maintenance for safety, daily maintenance,
calibration, storage methods, and transportation methods

APPENDIXES Detailed explanation of each function and initial settings
and so on.
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1.3 Equipment Configuration

The following lists the standard configuration of the MU163220C 3.2G Pulse Pattern Generator.

ItemItemItemItem Type and syType and syType and syType and symmmmbolbolbolbol DescriptionDescriptionDescriptionDescription QuantityQuantityQuantityQuantity RemarksRemarksRemarksRemarks
Equipment
configuration

MU163220C 3.2G Pulse Pattern
 Generator

1

W1857AE MU163220C/40C opera-
tion manual

1

J0693A Coaxial cable 1 1 m
J0696A Coaxial cable for

 measurements
2 50 cm

Z0306A Wrist strap 1

Accessories

Z0481 12.5G/3.2G BERTS
 APPLICATION
 SOFTWARE DEMO

1

The following lists the standard configuration of the MU163240C 3.2G Error Detector.

ItemItemItemItem Type and syType and syType and syType and symmmmbolbolbolbol DescriptionDescriptionDescriptionDescription QuantityQuantityQuantityQuantity RemarksRemarksRemarksRemarks
Equipment
configuration

MU163240C 3.2G Error Detector 1

W1857AE MU163220C/40C opera-
tion manual

1 Not attached when
purchased together
with MU163220C

J0693A Coaxial cable 1 1 m
J0696A Coaxial cable for

 measurements
2 50 cm

Z0306A Wrist strap 1

Accessories

Z0481 12.5G/3.2G BERTS
 APPLICATION
 SOFTWARE DEMO

1 Not attached when
purchased together
with MU163220C
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1.4 Specifications

1.4.1 MU163220C 3.2G Pulse Pattern Generator

Table 1-1 lists the specifications of the MU163220C 3.2G Pulse Pattern Generator.

Table Table Table Table 1111----1111  MU163220C  MU163220C  MU163220C  MU163220C    Specifications (1/2Specifications (1/2Specifications (1/2Specifications (1/2))))

ItemItemItemItem SpecificationsSpecificationsSpecificationsSpecifications
Operating frequency 10 M to 3.2 GHz

(50 MHz to 3.2 GHz when using MP1632C-03 3.2G internal
synthesizer)

External clock input
Amplitude
Waveform

0.5 to 2.0 Vp-p
<0.5 GHz : square wave, ≥0.5 GHz : square or sine wave

Generation pattern
Pseudo random pattern (PRBS)
  Pattern length

    Mark ratio
    AND bit shift
       upon mark ratio setting

2N-1 (N=7, 9, 11, 15, 20, 23, 31)
1/2, 1/4, 1/8, 0/8, 1/2, 3/4, 7/8, 8/8

1 bit/3 bits
  Data pattern
    Data length 2 to 8388608 bits
  Zero substitute pattern
    Continuos 0 bit length
    Pattern length

N (N=7, 9, 11, 15) to (pattern length - 1) bits
2N (N=7, 9, 11, 15)

Error insertion
Error ratio
External error input

10-n (n : 3, 4, 5, 6, 7, 8, 9), single error
Provided

Data output
  Number of outputs

Amplitude
Offset voltage

Raise/fail time
  Pattern jitter
  Waveform distortion
  Load impedance
  DATA/DATA tracking

  Cross point adjustment
function

  Connector

2 (DATA/DATA, independent)
0.5 to 2 Vp-p (10 mV steps)
VOH : -2 to +2 V (5 mV steps)
Display: VOH, VTH, VOL  selectable
≤80 ps (10 to 90% of amplitude)
≤30 psp-p
10% or 0.1 V of amplitude, whichever greater
50Ω (with back termination)
DATA amplitude and offset voltage can be set same value
as DATA.
Provided

SMA



6

Table 1-1  MU163220CTable 1-1  MU163220CTable 1-1  MU163220CTable 1-1  MU163220C    Specifications (2/2Specifications (2/2Specifications (2/2Specifications (2/2))))

ItemItemItemItem SpecificationsSpecificationsSpecificationsSpecifications
Clock output
  Number of outputs

Amplitude
Offset voltage

Raise/fall time
  Waveform distortion
  Load impedance
  Clock delay
  Connector

2 (CLOCK/CLOCK independent)
0.5 to 2 Vp-p (10 mV steps)
VOH : -2 to +2 V (5 mV steps)
Display: VOH, VTH, VOL  selectable
≤80 ps (10 to 90% of amplitude)
10% or 0.1 V of amplitude, whichever greater
50Ω (with back termination)
-1 to +1 ns (2ps steps)
SMA

External burst trigger input
  Input level
  Connector

0 V/-1 V
SMA

Internal Burst signal
Burst cycle
Enable length

2 us to 50 ms (1 us steps)
1 us to 49.999 ms (1 us steps)

Burst trigger output
Output level
Connector

0 V/-1 V
SMA

Sync signal output
Number of outputs

Output level
Connector

1 (1/8 clock, variable pattern synchronization output se-
lectable)
0 V/-1 V
SMA

Operating temperature +5 to +45°C
Power ≤200 VA
Dimensions and mass 232 (W)×49 (H)×449 (D) mm, ≤4.5 kg
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1.4.2 MU163240C 3.2G Error Detector

Table 1-2 lists the specifications of the MU163240C 3.2G Error Detector.

Table Table Table Table 1111----2222  MU163240CSpecifications (1/2)  MU163240CSpecifications (1/2)  MU163240CSpecifications (1/2)  MU163240CSpecifications (1/2)

ItemItemItemItem SpecificationsSpecificationsSpecificationsSpecifications
Operationg frequency 10 M to 3.2 GHz

(50 MHz to 3.2 GHz when using MP1632C-03 3.2G internal
synthesizer)

Data input
  Input waveform
  Input voltage
  Variable threshold voltage
  Termination
  Connector

NRZ
0.5 to 4 Vp-p
-4 to +4 V (1 mV steps)
Connected to GND, -2 V, +3 V via 50Ω
SMA

Clock input
Input waveform

Duty
  Input amplitude
  Variable input delay
  Polarity inversion
  Termination
  Connector

Square wave (<0.5 GHz),
square wave or sine wave (≥0.5 GHz)
50%
0.5 to 4 Vp-p
-1 to +1 ns (2ps steps)
POS/NEG inversion selectable
Connected to GND, -2 V, +3 V via 50Ω
SMA

Auto search function Phase, threshold, PRBS pattern (allowed if the mark ration
is between 1/8 and 7/8)

Receive pattern
Pseudo random pattern (PRBS)
  Pattern length

    Mark ratio
    AND bit shift
       upon mark ratio setting

2N-1 (N=7, 9, 11, 15, 20, 23, 31)
1/2, 1/4, 1/8, 0/8, 1/2, 3/4, 7/8, 8/8

1 bit/3 bits
  Data pattern
    Data length 2 to 8388608 bits
  Zero substitute pattern
    Continuos 0 bit length
    Pattern length

N (N=7, 9, 11, 15) to (pattern length - 1) bits
2N (N=7, 9, 11, 15)

Sync mode Normal, frame
Sync threshold AUTO or 10-n (n: 2, 3, 4, 5, 6, 7, 8)
Error detection mode Omission, insertion, total
Measurement items

Error rate
Number of errors
Error interval (async)
Error free inerval (EFI)
Clock frequency

0.0000×10-16 to 1.0000×10-0

0 to 9.9999×1016

0 to 9999999 (interval : 100 ms, 1 s)
0.0000 to 100.0000%
0.01 to 3.2 GHz (resolution : 1 Hz, accuracy : 10 ppm±1 kHz)
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Table Table Table Table 1111-2  MU163240C-2  MU163240C-2  MU163240C-2  MU163240C    Specifications (2/2)Specifications (2/2)Specifications (2/2)Specifications (2/2)

ItemItemItemItem SpecificationsSpecificationsSpecificationsSpecifications
Eye margin measurement
 function Provided
Errorr performance
 calculation function Provided
Measurement channel mask 1 to 8 channels, each channel settable independently
Error output
  Number of outputs
  Output level
  Connector

1 (1/32 bit rate OR error)
0/-1 V
SMA

Sync signal output
  Number of outputs

  Output level
  Connector

1 (switchable among 1/8 clock, fixed pattern sync, sync gain
   output)
0/-1 V
SMA

Burst trigger input
  Input level
  Connector

0/-1 V
SMA

Operating temperature +5 to +45°C
Power ≤250 VA
Dimensions and mass 232 (W)×49 (H)×449 (D) mm, ≤5 kg
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CHAPTER 2  PRECAUTIONS
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2.1 Environmental Conditions of Installation Site

MU163220C 3,2G Pulse Pattern Generator and MU163240C 3.2G Error Detector (here after
called “these units”) operate normally at an ambient temperature of 5°C to 45°C and ambient
humidity of 85% or less.  These units must be stored in an environment where the temperature is
-20°C to 60°C and the humidity does not exceed 85%.  Do not use or store these units in a location
exposed to:

1. A place where oxidization could occur or a place exposed to strong vibrations.

2. A place exposed to direct sunlight or heavy dust.

3. A place exposed to water splashes or active gases.

Using these units at room temperatures after leaving it in at low temperatures for a long period
could cause the internal circuits to short because of condensation.  To avoid this, use these units
after condensation has been allowed to dry.

CAUTIONCAUTIONCAUTIONCAUTION
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2.2 Safety Precautions

1. Users should not replace any plug-in unit by themselves.  Anritsu's Service Department
carries out replacement work.  Contact your nearest Anritsu branch office or distributor if
you need to replace a plug-in unit.  If you try to replace it by yourself, you may get injured or
may receive electric shocks that could cause death

1. These units has been developed only for use with the MP1632C Digital Data Analyzer.  Us-
ing these units with them inserted in any equipment other than the MP1632C could result in
damage or malfunction.  Never use them with equipment other than the MP1632C.

2. When inputting signals, do not apply voltages exceeding the rated values.  This could dam-
age the internal circuit.

3. The output must be terminated with a 50-ohm resistor.  Never pass current through the
output.

4. Before connecting other equipment (including experimental circuits) to the input/output con-
nectors, be sure to establish a ground to prevent static damage.

5. The outer conductor and core wires of a coaxial cable may be charged like a capacitor.  Use
them after discharging electrons using a metallic object.

6. Do not remove the internal radial cooling panel.  If unit performance degradation or trouble
occur by using these units with the internal radial cooling panel removed, it may not be eligi-
ble for maintenance.

WWWWARNINGARNINGARNINGARNING

CCCCAUTIONAUTIONAUTIONAUTION
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CHAPTER 3  PANELS AND CONNECTIONS
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3.1 Panel Layout and Explanation of Panel

3.1.1 MU163220C panel layout

Fig. 3-1 shows the front view of the MU163220C 3.2G Pulse Pattern Generator and Fig. 3-2 shows
its rear view.

MU163220A 3.2G PPG
Output

Data

50Ω !

Clock

50Ω !

Data

50Ω !

Clock

50Ω !

Burst Trigger
   Output

0/-1V 50Ω

!

Trigger Output

0/-1V 50Ω

!

(1) (2) (3)

(4) (5) (6)

Fig. Fig. Fig. Fig. 3333----1111  Front panel of MU163220C  Front panel of MU163220C  Front panel of MU163220C  Front panel of MU163220C

MU163220A 3.2G Pulse Pattern Generator

Clock

Input

0.5/2.0vp-p 50Ω

!

EXT Error

 Input

0/-1V 50Ω

!

EXT Burst
 Trigger
  Input

0/-1V 50Ω

!

(8)(7) (9)

Fig. Fig. Fig. Fig. 3333----2222  Rear panel of MU163220C  Rear panel of MU163220C  Rear panel of MU163220C  Rear panel of MU163220C

Table Table Table Table 3333----1111  MU163220C panel  MU163220C panel  MU163220C panel  MU163220C panel

NoNoNoNo LabelLabelLabelLabel DescriptionDescriptionDescriptionDescription
(1) Data Output Outputs the data signal. (SMA)
(2) Data Output Outputs the inverse data signal. (SMA)
(3) Burst Trigger Output Outputs the burst trigger signal.

      (SMA, 50Ω to GND termination)
(4) Clock Output Outputs the clock signal. (SMA)
(5) Clock Output Outputs the inverse clock signal. (SMA)
(6) Trigger Output Outputs the sync signal.

      (SMA, 50Ω to GND termination)
(7) EXT Burst Trigger Input Inputs the external burst trigger signal.

      (SMA, 50Ω to GND termination)
(8) EXT Error Input Inputs the external error addition signal.

      (SMA, 50Ω to GND termination)
(9) Clock Input Inputs the clock signal.

      (SMA, 50Ω to GND termination)

C

C
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3.1.2 MU163240C panel layout

Fig. 3-3 shows the front view of the MU163240C 3.2G Error Detector.

Input

Data

0.5-4.0Vp-p 50Ω

!

Burst Trigger
    Input

0/-1V 50Ω

!

Trigger Output

0/-1V 50Ω

!

GND

PECL

ECL

TERM

Clock

0.5-4.0Vp-p 50Ω

!

GND

PECL

ECL

TERMError
Monitor

MU163240A 3.2G ED

(1) (2) (3)

(4)

Fig. Fig. Fig. Fig. 3333----3333  Front panel of MU163240C  Front panel of MU163240C  Front panel of MU163240C  Front panel of MU163240C

Error Output

(1/ 23 Bit rate OR)

0/-1V 50Ω

!

(5)

MU163240C 3.2G Error Detector

Fig. Fig. Fig. Fig. 3333----4444  Rear panel of MU163240C  Rear panel of MU163240C  Rear panel of MU163240C  Rear panel of MU163240C

Table Table Table Table 3333----2222  Explanation of the MU163240C panel  Explanation of the MU163240C panel  Explanation of the MU163240C panel  Explanation of the MU163240C panel

NoNoNoNo LabelLabelLabelLabel ExplanationExplanationExplanationExplanation
(1) Data Input Inputs the data signal. (SMA)
(2) Clock Input Inputs the data signal (SMA)
(3) Trigger Output Outputs the sync signal

      (SMA, 50Ω to GND termination)
(4) Burst Trigger Input Inputs the burst trigger signal.

      (SMA, 50Ω to GND termination)
(5) Error Output Outputs the error signal.

      (SMA, 50Ω to GND termination)

C
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3.2 Connections between Units

This section describes how to connect the MU163220C 3.2G Pulse Pattern Generator and
MU163240C 3.2G Error Detector, and other units that are inserted in the MP1632C.

 Connection to the internal synthesizer optionConnection to the internal synthesizer optionConnection to the internal synthesizer optionConnection to the internal synthesizer option

Slot1: Option03 3.2G internal synthesizer
Slot3: MU163220C 3.2G Pulse Pattern Generator
Slot4: MU163240C 3.2G Error Detector

F 8A

Option-01

～Line 47.5-63Hz

800VA Max

Printer

Option-03 3.2G Internal Synthesizer

Clock(0.01-3.2GHz)
     Output

1.0Vp-p 50Ω

!

Input

0.5-2.0Vp-p 50Ω

!

Output

1.0Vp-p 50Ω

!

Lock(10MHz)

MU163220A 3.2G Pulse Pattern Generator

EXT Burst
 Trigger
  Input

0/-1V 50Ω

!

EXT Error

  Input

0/-1V 50Ω

!

Clock

Input

1.0Vp-p 50Ω

!

MU163240A 3.2G Error Detector

RS-232C
(COM1) Keyboard Mouse CRT

   Error Output

(1/8 Bit Rate OR)

0/-1V 50Ω

!

Fig. Fig. Fig. Fig. 3333----5555  Connection between units  Connection between units  Connection between units  Connection between units

C

C
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3.3 Connecting External Equipment

This section describes how to connect the MU163220C 3.2G Pulse Pattern Generator and
MU163240C 3.2G Error Detector, and external equipment.

 Connection method (front)Connection method (front)Connection method (front)Connection method (front)

Panel Lock

HDD

A

.

1

4

7

m/K

Enter

shift

p/G

n/M

C

_

3

6

9

D

TAB

BS

F

E

B

0

2

5

8MP1632A

Remote

Digital Data Analyzer

MU163220A 3.2G PPG

MU163240A 3.2G ED

Output
Data

50Ω !

Clock

50Ω !

Data

50Ω !

Clock

50Ω !

Burst Trigger
   Output

0/-1V 50Ω

!

SYNC Output

!

0/-1V 50Ω

Input

Data

0. 5-4.0Vp-p 50Ω

!

Burst Trigger
   Input

0/-1V 50Ω

!

SYNC Output

!

0/-1V 50Ω

ECL

GND

RECL

TERM

Clock

0.5-4.0 Vp-p 50Ω

!

ECL

GND

RECL

TERM
Error
Monitor

SyncSync

Burst trigger

Fig. Fig. Fig. Fig. 3333----6666  Connecting External Equipment   Connecting External Equipment   Connecting External Equipment   Connecting External Equipment ((((FrontFrontFrontFront))))

 Connection method (Rear)Connection method (Rear)Connection method (Rear)Connection method (Rear)

F 8A

Option-01

～Line 47.5-63Hz
800VA Max

Printer

Option-03 3.2G Internal Synthesizer

Clock(0.01-3.2GHz)
     Output

1.0Vp-p 50Ω

!

Input

0.5-2.0Vp-p 50Ω

!

Output

1.0Vp-p 50Ω

!

Lock(10MHz)

MU163220A 3.2G Pulse Pattern Generator

EXT Burst
 Trigger
  Input

0/-1V 50Ω

!

EXT Error

  Input

0/-1V 50Ω

!

Clock

Input

1.0Vp-p 50Ω

!

MU163240A 3.2G Error Detector

External error

RS-232C
(COM1) Keyboard Mouse CRT

   Error Output

(1/8 Bit Rate OR)

0/-1V 50Ω

!

Fig. Fig. Fig. Fig. 3333----7777  Connecting External Equipment   Connecting External Equipment   Connecting External Equipment   Connecting External Equipment ((((RearRearRearRear))))

C

C

C

C

C
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CHAPTER 4  SCREEN CONFIGURATION
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The following lists a hierarchical structure of the subwindows and panels when the PPG (Pulse
Pattern Generator) and ED (Error Detector) units are inserted in the main unit of MP1632C.
For explanations of the screens of the half-tone parts, see the operation manual of the MP1632C
Digital Data Analyzer.

Table Table Table Table 4444----1111  Hierarchical structure of the screens  Hierarchical structure of the screens  Hierarchical structure of the screens  Hierarchical structure of the screens

SubwindowSubwindowSubwindowSubwindow PanelPanelPanelPanel Setup itemSetup itemSetup itemSetup item
System System Sets the date and time, remote control functions, and system op-

eration mode.
Option Displays the configuration of the units installed in the instrument.

Setup Setup Sets basic setup items.
Frequency Sets the frequency
Clock I/F Sets the clock I/O interface.
Data I/F Sets the data I/O interface.
Pattern Sets transmitted/received patterns, bursts, and synchronization.
Trigger I/F Sets trigger/sync I/O signals.
Utility Sets the others

Test Menu Measurement Sets measurement conditions.
Error Addition Sets error addition and delay measurement pattern insertion con-

ditions.
Result Error/Alarm Displays error/alarm measurement data and starts or stops meas-

urement.
Eye Margin Displays eye margin measurement data and starts or stops meas-

urement.
Customize Displays setup and error measurement data (item selection and

setup by immediate value entry).
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CHAPTER 5  BASIC OPERATIONS
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5.1 Setting a Send/Receive Pattern

5.1.1 Selecting a send/receive pattern

In the MU163220C 3.2G Pulse Pattern Generator (hereafter called the PPG unit) and
MU163240C 3.2G Error Detector (hereafter called the ED unit), the programmable pattern
(PRGM), pseudo-random pattern (PRBS), and zero substitute pattern (Zero-Subst) can be set as a
send/receive pattern.  This section describes how to set these send/receive patterns.  For details
of each pattern, see "Appendix A  Send/Receive Patterns".

1. Open the 'Setup: Pattern' panel.

2 2

Fig. Fig. Fig. Fig. 5555----1111  Setup: Pattern panel  Setup: Pattern panel  Setup: Pattern panel  Setup: Pattern panel
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2. To set the send pattern, press the Setup button in the PPG group box.  To set the receive
pattern, press the Setup button in the ED group box.  The Pattern dialog box will be opened.
Fig. 5-2 shows the Pattern dialog box for the PPG unit, and it for the unit has the same con-
figuration as far as the settings explained in this section are concerned.  We continue our
explanation, presenting the case of the PPG unit.

3

Fig. Fig. Fig. Fig. 5555----2222  Pattern dialog box  Pattern dialog box  Pattern dialog box  Pattern dialog box

3. See the setting method below according to the pattern you will use.

How to set the PRGM pattern See "5.1.2  Setting the PRGM pattern".
How to set the PRBS pattern See "5.1.3  Setting the PRBS pattern".
How to set the Zero-Subst pattern See "5.1.4  Setting the zero substitute pattern".

4. When editing PRGM pattern, press the Edit Pattern button. Pattern Editor dialogue box will
open.  For operation of the Pattern Editor dialogue box, see “5.2 Creating and Editing the
Pattern.”

5. Setting is completed.  Click OK to validate the change.
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5.1.2 Setting the PRGM pattern

This section describes how to set the PRGM pattern as the send/receive pattern.

1

2 3

4 5

Fig. Fig. Fig. Fig. 5555----3333  Pattern dialog box   Pattern dialog box   Pattern dialog box   Pattern dialog box ((((when PRGM is setwhen PRGM is setwhen PRGM is setwhen PRGM is set))))

1. Select PRGM from the Pattern drop-down list box of the Pattern Setting group box.

2. Set the pattern length by entering it in the Pattern Length text box in the PRGM group box.
The pattern length ranges from 2 to 8,388,608 bits.  The following lists the correspondence
between the pattern length and bit resolution.

2 to 131072 bits resolution of 1 bit
131072 to 262144 bits resolution of 2 bits
262144 to 524288 bits resolution of 4 bits
524288 to 1048576 bits resolution of 8 bits
1048576 to 2097152 bits resolution of 16 bits
2097152 to 4194304 bits resolution of 32 bits
4194304 to 8388608 bits resolution of 64 bits

3. Set the pattern logic by selecting from the Logic drop-down list box in the PRGM group box.

4. To edit the PRGM pattern, press the Edit Pattern button.  The Pattern Editor dialog box will
be opened.  For operations of the Pattern Editor dialog box, see "5.2  Creating/Editing a
Pattern".

5. Now the setting is completed.  To enable the change, press the OK button.
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5.1.3 Setting the PRBS pattern

This section describes how to set the PRBS pattern as the send/receive pattern.

1

2 3

4

Fig. Fig. Fig. Fig. 5555----4444  Pattern dialog box   Pattern dialog box   Pattern dialog box   Pattern dialog box ((((when PRBS is setwhen PRBS is setwhen PRBS is setwhen PRBS is set))))

1. Select from the Pattern drop-down list box in the Pattern Setting group box.

PRBS7 Sets the pattern to PRBS of 27-1.
PRBS9 Sets the pattern to PRBS of 29-1.
PRBS11 Sets the pattern to PRBS of 211-1.
PRBS15 Sets the pattern to PRBS of 215-1.
PRBS20 Sets the pattern to PRBS of 220-1.
PRBS23 Sets the pattern to PRBS of 223-1.
PRBS31 Sets the pattern to PRBS of 231-1.

2. Set the mark ratio by selecting from the Mark Ratio drop-down list box in the PRBS group
box.

1/2 Sets the mark ratio to 1/2.
1/4 Sets the mark ratio to 1/4.
1/8 Sets the mark ratio to 1/8.
0/8 Sets all to the 0 pattern   
1/2INVT Sets the mark ratio to 1/2.
3/4 Sets the mark ratio to 3/4.
7/8 Sets the mark ratio to 7/8.
8/8 Sets all to the 1 pattern
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3. Set the bit shift by selecting from the Bit Shift drop-down list box in the PRBS group box.

1 bit Shift Sets to the 1-bit shift
3 bit Shift Sets to the 3-bit shift

NoteNoteNoteNote
The bit shift cannot be set if the mark ratio has been set to 1/2, 1/2INVT, 0/8, or 8/8 in
procedure 2.

4. Now the setting is completed.  To enable the change, press the OK button.
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5.1.4 Setting the zero substitute pattern

This section describes how to set the zero substitute pattern as the send/receive pattern.

1

2 2

3

4

Fig. Fig. Fig. Fig. 5555----5555  Pattern dialog box   Pattern dialog box   Pattern dialog box   Pattern dialog box ((((when Zero-Subst is setwhen Zero-Subst is setwhen Zero-Subst is setwhen Zero-Subst is set))))

1. Select Zero-Subst from the Pattern drop-down list box in the Pattern Setting group box.

2. Set the pattern length and zero bit insertion length by selecting the pattern length from the
Pattern Length drop-down list box in the Zero-Subst group box, and setting the zero bit inser-
tion length in the Zero Length text box.

The following lists the relations between the pattern length and the Min./Max. values of the
zero bit insertion length.

Pattern Length Min. value of the Zero bit Max. value of the Zero bit
2^7 7 127
2^9 9 511
2^11 11 2,047
2^15 15 32,767

3. Set the pattern logic by selecting from the Logic drop-down list box in the Zero-Subst group
box.

4. Now the setting is completed.  To enable the change, press the OK button.
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5.2 Creating/Editing a Pattern

5.2.1 Selecting the display mode

MU163220C 3.2G Pulse Pattern Generator (here after called the PPG unit) and MU163240C 3.2G
Error Detector (hereafter called the ED unit) have a Pattern Editor dialog box which allows to
create/edit a PRGM pattern.  In the Pattern Editor dialog box, you can create/edit PRGM pat-
terns.
This section describes how to create/edit a PRGM pattern using the Pattern Editor dialog box.
You can open the Pattern Editor dialog box by pressing the Edit Pattern button on the Pattern
dialog box opened from the 'Setup: Pattern' panel.

NoteNoteNoteNote
1. If the system operation mode allows measurements during power failure, you cannot open

the Pattern Editor dialog box.  You should either edit in a Customize subwindow or
change the system operation mode.

2. For details on operations of the Customize subwindow, see "5.9  For Users of the Exist-
ing BERTS"

3. For details on how to change the system operation mode, see "6.4  Setting System Opera-
tions" of the MP1632C Digital Data Analyzer operation manual.

4. Depending on the color setting of Windows, the cursor on the editor may become hard to
see.  You can set the color of Windows using Control Panel in the Main group of Program
Manager.  If you want to know how to use the Control Panel, see the online help of it
that is attached to Control Panel.

5. When Remote mode is changed to Local mode during pattern loading in progress, the pat-
tern on Pattern Editor screen may not be displayed.
So, wait the pattern loading till the Pattern Loading lamp is off.
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1

Fig. Fig. Fig. Fig. 5555----6666  Pattern Editor dialog box  Pattern Editor dialog box  Pattern Editor dialog box  Pattern Editor dialog box

1. Set the display mode of the Pattern Editor by selecting from the Display drop-down list box of
the Pattern Editor dialog box.

Time Displays/Edits a pattern in one horizontal line, taking the time
base in the cross direction.  You can display/edit it as images of
waveform, or binary numbers.

Table Displays/Edits a pattern as images of memory dumps.  You can
display/edit it as binary numbers or hexadecimal numbers.

2. See the following editing method according to the display mode you selected in the Display
drop-down list box.

For the editing method in Time mode, see "5.2.2  How to edit in Time display mode".
For the editing method in Table mode, see "5.2.3  How to edit in Table display mode".
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5.2.2 How to edit in Time display mode

This section describes how to create/edit a pattern in "Time" display mode.

1. Select the display format from the Format drop-down list box of the Pattern Editor dialog box.

Wave Displays/Edits as images of waveform.  The display can be scaled
using the Zoom Up and Zoom Down buttons.

BIN Displays/Edits in binary numbers.

1

2

3 3

1 3 4 5

Fig. Fig. Fig. Fig. 5555----7777  Pattern Editor dialog box   Pattern Editor dialog box   Pattern Editor dialog box   Pattern Editor dialog box ((((Time display modeTime display modeTime display modeTime display mode))))

2. The cursor address is displayed here.

3. Set the marker display by pressing the Marker button, which toggles between the display and
non-display of the marker.  The marker address is displayed at the Marker Addr, and the
distance between the cursor and marker is displayed at the Distance.

4. Select the target for operation by pressing the Focus button, which toggles between the cursor
and marker.  You can move the cursor or marker selected as the target for operation using
the click, arrow keys, or rotary encoder.

5. Set the edit mode by pressing the Edit Mode button, which toggles between the insertion
mode and overwrite mode.
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6. Use the keys 0 and 1 for pattern input.  If you double-click on the touch panel, the cursor
moves to the position where you double-clicked and the bit at the position is inverted.

7. For other functions, see "5.2.4  Selecting the areas" or subsequent sections.
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5.2.3 How to edit in Table display mode

This section describes how to create/edit a pattern in "Table" display mode.

12
3

Fig. Fig. Fig. Fig. 5555----8888  Pattern Editor dialog box   Pattern Editor dialog box   Pattern Editor dialog box   Pattern Editor dialog box ((((Table display modeTable display modeTable display modeTable display mode))))

1. Select the display format from the Format drop-down list box of the Pattern Editor dialog box.

BIN Displays/Edits in binary numbers.
HEX Displays/Edits in hexadecimal numbers.

2. You can change the amount of data displayed in one line.  Open the Line dialog box by se-
lecting Line from the Edit pull down menu.  Enter the desired number of bytes in the spin
box and then press the OK button.

Fig. Fig. Fig. Fig. 5555----9999  Line dialog box  Line dialog box  Line dialog box  Line dialog box

3. Set the edit mode by pressing the Edit Mode button, which toggles between the insertion
mode and overwrite mode.
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4. For pattern input, use the keys 0 and 1 when the binary number display is used, and use the
keys 0 to 9 and A to F when the hexadecimal number display is used.

5. If you double-click on the touch panel when the binary number display is used, the cursor
moves to the position where you double-clicked and the bit at the position is inverted.

6. For other functions, see "5.2.4  Selecting the area" or subsequent sections.
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5.2.4 Selecting the areas

In the Pattern Editor dialog box, you can specify a selected area consisting of multiple bits, and
perform editing work for this area collectively.  The selected areas can be used when performing
substitute input using the Fill group box, using Cut, Copy, and Paste of the edit commands, and
saving PRGM patterns.
This section describes how to set the selected areas using the Range group box.

To set the selected area, use each button in the Range group box.  The following lists the func-
tions of each button.

Button Function
Whole Specifies the whole pattern as the selected area.
Any Specifies any area as a selected area by specifying an address.

The address is specified by input in the Input Range dialog box.
Direct Specifies any area as a selected area by specifying an address.

The address is specified using the cursor.

 We explain how to specify a selected area using the Any button.

Fig. Fig. Fig. Fig. 5555----10101010  Input Range dialog box  Input Range dialog box  Input Range dialog box  Input Range dialog box

1. Enter the start address of the selected are in the Start Address spin box.

2. Enter the end address of the selected are in the End Address spin box.

3. If you press the OK button, the specified area becomes the selected area and is displayed in
reverse mode.
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 We explain how to specify a selected area using the Direct button.

1. Press the Direct button.  The button is held pressed and the Direct mode is set.  You cannot
enter/edit patterns in Direct mode.

2. Specify the starting point of the selected area.  Double-click the starting point of the selected
area or move the cursor to the point and then press Enter.

3. Specify the ending point of the selected area.  Display the ending point of the selected area
on the screen by using Jump of the Edit pull down menu or other ways.  Double-click the
ending point of the selected area or move the cursor to the point and then press Enter.

4. Now the selected area is set.

 You can also specify an area in the following ways.

1. You can specify a selected area by dragging.

2. You can specify a selected area by clicking on the starting point of the selected area, and then
clicking on the ending point while pressing the Shift key.

3. You can specify a selected area by moving the cursor to the starting point, and then specifying
the ending point by the cursor key while pressing the Shift key.

4. You can expand the area by clicking or moving the cursor while pressing the Shift key in a
state in which the area has been established.
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5.2.5 Pattern input

This section describes how to enter a pattern using the buttons in the Fill group box.  The fol-
lowing lists the functions of each button in the Fill group box.

Button Function
0 Replaces the bit at the cursor position with 0.
1 Replaces the bit at the cursor position with 1.
Reverse Inverts the bit at the cursor position.
Pattern Enters repetition of any pattern.

 We explain about pattern input using the Pattern button.

Fig. Fig. Fig. Fig. 5555----11111111  Input Pattern dialog box  Input Pattern dialog box  Input Pattern dialog box  Input Pattern dialog box

1. Enter the number of bits to be entered in the Length spin box.

2. Enter the number of times of repetition of the specified pattern in the Repeat spin box.

3. If you press the Set All button, all bits are set to 1.

4. If you press the Reset All button, all bits are set to 0.

5. Enter the pattern in the BIN or HEX text box.

6. If you press the OK button, the pattern is entered at the cursor position.

NoteNoteNoteNote
If you open the Input Pattern dialog box when a selected area has been specified, the
selected area will be replaced by repetition of the specified pattern regardless of the
number of times of repetition specified in the Repeat spin box.
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5.2.6 Edit commands

This section describes the commands that can be selected from the Edit pull-down menu in the
Pattern Editor dialog box.

Table Table Table Table 5555----1111  Edit commands of Pattern Editor  Edit commands of Pattern Editor  Edit commands of Pattern Editor  Edit commands of Pattern Editor

Command Function
Undo Cancel the preceding operation.
Cut Remove the data in the selection area or at the cursor and stores

it in the buffer.
Copy Copies the data in the selection area or at the cursor to the buffer.
Paste If a selection area has been set, substitute it with the data stored

in the buffer.  If not set, the data stored in the buffer is added at
the cursor position.

Jump-Head Jump to the beginning of the pattern.
Jump-Tail Jump to the end of the pattern.
Jump-Marker If the marker is ON, jump the marker to the center of the screen.
Jump-Address Jump to the specified address.
Jump-Pattern Search for the specified pattern, and jump to the head of the first

searched pattern.
Jump-Next Search for the next pattern under the same condition as that of

the Jump-Pattern command executed directly before.
Line Specify how many bytes display per line.

 Specifying the address at the jump destination

1. Selecting Jump-Address will open the Input Address dialog box.

Fig. Fig. Fig. Fig. 5555----12121212  Input Address dialog box  Input Address dialog box  Input Address dialog box  Input Address dialog box

2. Enter the jump destination address in the spin box in the Input Address dialog box, then
press the OK button.
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 Specifying the pattern to search

1. Selecting Jump-Pattern will open the Input Pattern dialog box.

Fig. Fig. Fig. Fig. 5555----13131313  Input Pattern dialog box  Input Pattern dialog box  Input Pattern dialog box  Input Pattern dialog box

2. Pressing the SetALL button will set all bits to 1s.

3. Pressing the ResetALL button will set all bits to 0s.

4. Pressing ALL X sets all the bits to “Don’t Care.”

5. Enter a pattern in the BIN or HEX text box.  To enter a Don't Care bit, press the 0 key with
the Shift key pressed down.  Pattern length you can reference is variable from 1 bit to 32
bits.

6. Select the search direction by pressing the Forward or Backward option button.

7. Press the OK button.
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5.2.7 Panel key and keyboard operations

This section lists the operations that can be performed using the keys on the Pattern Editor dialog
box and external keyboard.

Table Table Table Table 5555----2222  Panel key operations  Panel key operations  Panel key operations  Panel key operations

Arrow keys Move the cursor.
Shift + arrow keys Perform the same operation as area specification per

formed by dragging the mouse.
Enter Performs the same operation as double clicking
Numeric characters Input a pattern
and A to F
Shift+0 Specifies Don't Care.
Back Space Deletes the data to the left of the cursor.

Table Table Table Table 5555----3333  Keyboard key operations  Keyboard key operations  Keyboard key operations  Keyboard key operations

Arrow keys Move the cursor.
Shift + arrow keys Performs the same operation as area specification 

performed by dragging the mouse.
Home Moves the cursor to the left end of the screen.
Ctrl + Home Jumps the cursor to the head of the pattern.
End Moves the cursor to the right end of the screen.
Ctrl + End Jumps to the end of the pattern.
Page Up Scrolls the screen one page rightward or downward.
Page Down Scrolls the screen one page leftward or upward.
Enter Performs the same operation as double clicking
Numeric characters Input a pattern.
         and A to F
Shift + 0 or X Specifies Don't Care.
Delete Removes the data in the selection area or at the

cursor and stores it in the buffer.
Back Space Deletes the data to the left of the cursor.
Insert Switches between insert and overwrite modes.
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5.2.8 PRGM  Saving a PRGM pattern

There are two methods available to save patterns edited in the Pattern Editor dialog box in a file.
One method is to save patterns as a pattern setting data file.  The other method is to save pat-
terns as a pattern clip file.  The pattern setting data file contains the setting state concerning the
pattern as well as bit strings of the pattern.  The pattern clip file consists simply of bit strings of
the pattern.
This section describes how to save a created PRGM pattern as a pattern clip file.  For the pattern
setting data file, see "5.10  Saving Settings in a Data File/Opening a Data File".

1. Select "Save" from the File pull down menu of the Pattern Editor dialog box.  The Save dia-
log box will be opened.

2 3

4

Fig. Fig. Fig. Fig. 5555----14141414  Save dialog box  Save dialog box  Save dialog box  Save dialog box

2. Enter the start address in the Start Address spin box.

3. Enter the end address in the End Address spin box.

4. Enter the drive, directory, and file names and then press the OK button.  When you enter a
file name, do not change the extension.
NoteNoteNoteNote
If you select an area and then open the Save dialog box, the selected area will be set in
the Start Address spin box and End Address spin box.
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5.2.9 Opening the PRGM pattern

A pattern saved as a pattern clip file can be read from the file and then inserted into pattern being
edited, or they can be overwritten.  This section describes how to read the pattern clip file.

1. Patterns that have been read in the pattern clip file are entered at the cursor position.  Move
the cursor to any position you want for pattern input.

2. Select "Open" from the File pull down menu of the Pattern Editor dialog box.  The Open
dialog box will be opened.

Fig. Fig. Fig. Fig. 5555----15151515  Open dialog box  Open dialog box  Open dialog box  Open dialog box

3. Enter the drive, directory, and file names and then press the OK button.  The pattern will be
entered at the cursor position.
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5.2.10 Printing the pattern

This section describes how to print the created pattern.  There are two printing methods avail-
able.  One method is to print from the Pattern Editor dialog box.  The other method is to print
from the parent window.  We show printing examples in "Appendix F Printer Output Format".

Printing from the Pattern EditorPrinting from the Pattern EditorPrinting from the Pattern EditorPrinting from the Pattern Editor

1. Select "Print" from the File pull down menu of the Pattern Editor dialog box.  The Print
dialog box will be opened.

2

3

Fig. Fig. Fig. Fig. 5555----16161616  Print dialog box  Print dialog box  Print dialog box  Print dialog box

2. Specify the range of the pattern to be printed in the Start Address and End Address text
boxes.

3. If you press the OK button, printing starts.

NoteNoteNoteNote
The output format is the same as the pattern display format of the Pattern Editor dialog
box when the Print dialog box is opened.  However, the output format is the "BIN" in-
stead of the "Wave" in time display mode.
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Printing from the parent windowPrinting from the parent windowPrinting from the parent windowPrinting from the parent window

1. Select Print from the File pull down menu of the parent window.  The Print dialog box will
be opened.

2

5

3

4

6

Fig. Fig. Fig. Fig. 5555----17171717  Print dialog box  Print dialog box  Print dialog box  Print dialog box

2. Select Pattern from the Type of Print List drop-down list box.

3. Select the unit which owns the desired pattern from the Unit drop-down list box.

4. Specify the pattern format to be printed in the Format drop-down list box.

5. If you want to print the whole range of the pattern, check ALL.  If you want to print any
arbitrary range, check Address and then specify the range in the Start Address and End Ad-
dress text boxes.

6. If you press the OK button, printing starts.
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5.3 Sending/Receiving the Burst Pattern

5.3.1 Sending the burst pattern

The MU163220C 3.2G Pulse Pattern Generator (here after called the PPG unit) can send the
burst pattern.
The burst trigger signals for burst control can be selected from internal signals and external sig-
nals.  If you select internal signals, you must set the burst cycle and enable length.  For more
details, see "Appendix B  Burst Patterns Generation Principle".
The burst trigger signals are output from the Burst Trigger Output on the front panel of the PPG
unit.
This section describes the procedures for sending the burst pattern.

1. Open the 'Setup: Pattern' panel.

12

Fig. Fig. Fig. Fig. 5555----18181818  Setup: Pattern panel  Setup: Pattern panel  Setup: Pattern panel  Setup: Pattern panel
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2. Press the Setup button in the group box on the PPG unit side.  The Pattern dialog box will be
opened.

3 6

4 5 5

Fig. Fig. Fig. Fig. 5555----19191919  Pattern dialog box  Pattern dialog box  Pattern dialog box  Pattern dialog box

3. Set the Pattern Output mode to burst by selecting "Burst" from the Pattern Output drop-
down list box.  Setting items in the Burst Setting group box will be enabled.

4. Specify the source of the burst signals.  Specify either "INT" for internal, or "EXT" for exter-
nal.
NoteNoteNoteNote
When external signal is used as the burst source, high input shows valid period and low
does invalid period.  Its pulse width must exceed (64 / fundamental frequency).

5. Enter the burst cycle and enable length in the Burst Cycle spin box and Enable Length spin
box respectively.  The following lists the ranges that can be set for each item.

Item Range that can be set
Burst cycle 2 to 50000 us
Enable length 1 to 49999 us

NoteNoteNoteNote
The enable length must be less than the burst cycle.

6. Now the setting is completed.  To enable the change, press the OK button.
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5.3.2 Receiving the burst pattern

The MU163240C 3.2G Error Detector (hereafter called the ED unit) can measure the burst pat-
tern.  This section describes the procedures for receiving the burst pattern.

1. Open the 'Setup: Pattern' panel.

1 2

Fig. Fig. Fig. Fig. 5555----20202020  Setup: Pattern panel  Setup: Pattern panel  Setup: Pattern panel  Setup: Pattern panel
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2. Press the Setup button in the group box on the ED unit side.  The Pattern dialog box will be
opened.

3 4

Fig. Fig. Fig. Fig. 5555----21212121  Pattern dialog box  Pattern dialog box  Pattern dialog box  Pattern dialog box

3. Select "Burst" from the Pattern Output drop-down list box.

4. Now the setting is completed.  To enable the change, press the OK button.

NoteNoteNoteNote

The ED measurement burst pattern only when the burst trigger signal is high.  The
period that the burst trigger signal is low, the ED stops measuring.  The specifications
of the burst trigger signal is described bellow.

Amplitude 1 Vp-p ±20%
Offset 0 ±0.2 V (VIH)
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5.4 Setting the Amplitude/Offset Level/Termination/Phase

5.4.1 Setting the Data output interface

This section describes the procedures for setting the Data output interface of the MU163220C
3.2G Pulse Pattern Generator (hereafter called the PPG unit).

1. Open the 'Setup: Data I/F' panel.

1

2

Fig. Fig. Fig. Fig. 5555----22222222  Setup: Data I/F panel  Setup: Data I/F panel  Setup: Data I/F panel  Setup: Data I/F panel

2. Press the Setup button in the PPG group box.  The Data Interface dialog box will be opened.

3

4

5

6

6

7

8

Fig. Fig. Fig. Fig. 5555----23232323  Data Interface dialog box  Data Interface dialog box  Data Interface dialog box  Data Interface dialog box
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NoteNoteNoteNote
If MU163220C mounts OPT01 , the Amplitude range and Offset range are as following.
                         VOH                VTH               VOL

Amplitude (0.50 to 4.00) (0.50 to 4.00) (0.50 to 4.00)
Offset (-3.500 to 4.250) (-3.750 to 4.000) (-4.000 to 3.750)

3. Select the data port to be set.

4. Set ON/OFF of the Data output by selecting from the Output drop-down list box.
NoteNoteNoteNote
It is high impedance while the Output is OFF

5. Set the level by selecting from the Level drop-down list box.  If you select “ECL” or “TTL”,
you cannot carry out the setting in Procedure 6.

VAR Sets to any arbitrary level.
ECL Sets to the ECL level.
TTL Sets to the TTL level. (Equipped with OPT01)

NoteNoteNoteNote
Selection of ECL is not allowed if 50Ω is selected for Data I/F on the 'Setup: Utility'
panel.

6. Set the amplitude and offset.  Select the potential as a reference for offset from the drop-
down list box on the right side of the Offset text box.  The values you can select are listed
below.  The range of the offset that can be set depends on how the amplitude is set.  For
more details, see "Appendix D Relationships among Amplitude, Offset, and Termination".

Voh Sets the offset value as a High level.
Vth Sets the offset value as a center value between the High level and

Low level
Vol Sets the offset value as a Low level.

7. Set the cross point.  The range that can be set is between 25% and 75%.

8. Now the setting is completed.  To enable the change, press the OK button.

Measured systems may be destroyed depending on the settings.  A message is display-
ed for confirmation.  Start measurements after checking the settings you specified and
measuring targets adequately.

CAUTIONCAUTIONCAUTIONCAUTION
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5.4.2 Setting the Clock output interface

This section describes the procedures for setting the Clock output interface of the MU163220C
3.2G Pulse Pattern Generator (hereafter called the PPG unit).

1. Open the 'Setup: Clock I/F' panel.

1 2

Fig. Fig. Fig. Fig. 5555----24242424  Setup Clock I/F panel  Setup Clock I/F panel  Setup Clock I/F panel  Setup Clock I/F panel

2. Press the Setup button in the PPG group box.  The Clock Interface dialog box will be opened.
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Fig. Fig. Fig. Fig. 5555----25252525  Clock Interface dialog box  Clock Interface dialog box  Clock Interface dialog box  Clock Interface dialog box
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NoteNoteNoteNote
If MU163220C mounts OPT02 , the Amplitude range and Offset range are as following.
                         VOH                VTH               VOL

Amplitude (0.50 to 4.00) (0.50 to 4.00) (0.50 to 4.00)
Offset (-3.500 to 4.250) (-3.750 to 4.000) (-4.000 to 3.750)

3. Select the port to be set.

4. Set On/Off of the clock output by selecting from the Output drop-down list box.
NoteNoteNoteNote
It is high impedance while the Output is OFF

5. Set the level by selecting from the Level drop-down list box.  If you select “ECL” or “TTL”,
you cannot carry out the setting in Procedure 6.

VAR Sets to any arbitrary level.
ECL Sets to the ECL level.
TTL Sets to the TTL level. (Equipped with OPT02)

NoteNoteNoteNote
Selection of "ECL" is not allowed if 50Ω is selected for Clock I/F on the 'Setup: Utility'
panel.

6. Set the amplitude and offset.  Select the potential as a reference for offset from the drop-
down list box on the right side of the Offset text box.  The range of the offset that can be set
depends on how the amplitude is set.  For more details, see "Appendix D  Relationships
among the Amplitude, Offset, and Termination".

Voh Sets the offset value as a High level.
Vth Sets the offset value as a center value between the High level and

Low level.
Vol Sets the offset value as a Low level.

7. Set the delay by entering a value in the Delay spin box.  The setting range that can be set is
between -1000 ps and +1000 ps , and the resolution is 2 ps.

8. Set the duty by entering a value in the Duty spin box.  The setting range is 50 steps between
-25 and +25.

9. Now the setting is completed.  To enable the change, press the OK button.

Measured systems may be destroyed depending on the settings.  A message is display-
ed for confirmation.  Start measurements after checking the settings you specified and
measuring targets adequately.

CCCCAUTIONAUTIONAUTIONAUTION



52

5.4.3 Setting the Data input interface

This section describes the procedure for setting the Data input interface of the MU163240C 3.2G
Error Detector (hereafter called the ED unit).

1. Open the 'Setup: Data I/F' panel.

1 2

Fig. Fig. Fig. Fig. 5555----26262626  Setup: Data I/F panel  Setup: Data I/F panel  Setup: Data I/F panel  Setup: Data I/F panel

2. Press the Setup button in the ED group box.  The Data Interface dialog box will be opened.

3

4 5

6

Fig. Fig. Fig. Fig. 5555----27272727  Data Interface dialog box  Data Interface dialog box  Data Interface dialog box  Data Interface dialog box
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3. Set the level by selecting from the Level drop-down list box.  If you select ECL, PECL or
TTL, you cannot carry out the settings in Procedures 4 and 5.

VAR Sets to any arbitrary level.
ECL Sets to the ECL level.
PECL Sets to the PECL level.
TTL Sets to the TTL level.

4. Set Threshold by entering a value in the Threshold spin box.  The range that can be set is
between -4,000 V and +4,000 V.

5. Set the termination condition of the data input by selecting from the Termination drop-down
list box.

GND Ground termination
-2 V Termination for ECL level signals
+3 V Termination for PECL level signals

6. Now the setting is completed.  To enable the change, press the OK button.
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5.4.4 Setting the Clock input interface

This section describes the procedures for setting the Clock input interface of the MU163240C 3.2G
Error Detector (hereafter called the ED unit).

1. Open the 'Setup: Clock I/F' panel.

1 2

Fig. Fig. Fig. Fig. 5555----28282828  Setup: Clock I/F panel  Setup: Clock I/F panel  Setup: Clock I/F panel  Setup: Clock I/F panel

2. Press the Setup button in the ED group box.  The Clock Interface dialog box will be opened.

3
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6

Fig. Fig. Fig. Fig. 5555----29292929  Clock Interface dialog box  Clock Interface dialog box  Clock Interface dialog box  Clock Interface dialog box

3. Set the Clock polarity by selecting from the Polarity drop-down list box.
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4. Set the termination condition for clock input by selecting from the Termination drop-down
list box.

GND Ground termination
-2 V Termination for ECL level signal
+3 V Termination for PECL level signal

5. Set the delay by entering a value in the Delay spin box.  The setting range is between
-1000 ps and +1000 ps, and the resolution is 2 ps.

6. Now the setting is completed.  To enable the change, press the OK button.
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5.5 Synchronizing with the Receive Pattern

5.5.1 Selecting a synchronization method

The MU163240C 3.2G ED unit (hereafter called the ED unit) has the auto sync function to pre-
vent excessive error occurrence resulting from cycle shifts by automatically taking the pattern
cycles of the reference pattern inside the ED unit and input pattern during measurements.
Two modes of "Normal" and "Frame" are available as the Pattern Sync mode for the synchroniza-
tion of pattern cycles.  For differences of the synchronization methods between these two modes,
see "Appendix C Auto Sync".  Each mode is under the following restrictions depending on the
types and contents of patterns being received.

((((PRBS patternPRBS patternPRBS patternPRBS pattern))))
The Pattern Sync mode cannot be selected.

((((PRGM patternPRGM patternPRGM patternPRGM pattern))))
The Frame synchronization cannot be selected if the pattern length is less than 8 bits, or
there is no change of 0 → 1 or 1 → 0 in the first 32 bits of the PRGM pattern.

(Zero-Subst pattern)(Zero-Subst pattern)(Zero-Subst pattern)(Zero-Subst pattern)
Both Pattern Sync modes can be selected.
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5.5.2 Synchronizing with the receive pattern

1. Open the 'Setup: Pattern' panel.

1 2

Fig. Fig. Fig. Fig. 5555----30303030  Setup: Pattern panel  Setup: Pattern panel  Setup: Pattern panel  Setup: Pattern panel

2. Press the Setup button in the group box of the ED unit.  The Pattern dialog box will be
opened.  Carry out the following settings in the Sync Setting group box.
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Fig. Fig. Fig. Fig. 5555----31313131  Pattern dialog box  Pattern dialog box  Pattern dialog box  Pattern dialog box
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3. Set ON/OFF of the auto sync function by selecting from the Auto Sync drop-down list box.

4. Set the threshold value for determining asynchronization by selecting from the Sync Loss
Threshold drop-down list box and Sync Gain Threshold drop-down list box, or Internal
Threshold check box.

Sync Loss Threshold 1E-2, 1E-3, 1E-4, 1E-5, 1E-6, 1E-7
Sync Gain Threshold 1E-3, 1E-4, 1E-5, 1E-6, 1E-7, 1E-8

NoteNoteNoteNote
Only greater values can be selected for Sync Loss Threshold than those for Sync Gain
Threshold.  If Internal Threshold is checked, Sync Loss Threshold and Sync Gain
Threshold cannot be set.  For the threshold values for synchronization / asynchroniza-
tion when Internal Threshold is checked, refer "Appendix J  Internal Threshold".

5. Set the pattern synchronization method by selecting from the Pattern Sync Mode drop-down
list box.

Normal Synchronized by rearrangement of Demux and bit shifts
Frame Synchronized using the specified frame

6. Set the frame length if you have set the pattern synchronization mode in Procedure 5 to
"Frame" by selecting from the Frame Length drop-down list box.

8 bit Sets the frame length to 8 bits.
16 bit Sets the frame length to 16 bits.
24 bit Sets the frame length to 24 bits.
32 bit Sets the frame length to 32 bits.

NoteNoteNoteNote
A frame longer than the pattern length cannot be set.  If there is no change of 0 → 1 or
1 → 0 in the starting part of the PRGM pattern to be specified, its frame length cannot
be specified.

7. Now the setting is completed.  To enable the change, press the OK button.



59

5.6 Auto Searching

MU163240C 3.2G Error Detector (hereafter called the ED unit) has two kinds of search functions.

Auto Search function for the phase/threshold levelAuto Search function for the phase/threshold levelAuto Search function for the phase/threshold levelAuto Search function for the phase/threshold level
Optimal values for the phase relation between data and clock, and threshold level for input data
are respectively detected automatically based on the error rate.  You can also search the optimal
values for both the phase relation and threshold level simultaneously.

Pattern search functionPattern search functionPattern search functionPattern search function
The number of steps and the mark ratio are searched, assuming that the input data signal is the
PRBS pattern.

NoteNoteNoteNote
Under bellow condition the auto search function is invalid.
(1) The auto sync function is "OFF"
(2) Pattern input mode (on the 'Setup:Pattern' of ED) is "Burst".
For details on how to set the auto sync function, see procedure 3 of "5.5.2  Synchronizing
with the receive pattern".  For details on how to set the burst pattern, see "5.3.2  Receiving
the burst pattern ".

1. Open the Result subwindow.

2

Fig. Fig. Fig. Fig. 5555----32323232  Result: All panel  Result: All panel  Result: All panel  Result: All panel
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2. Press the Auto Search button.  The Auto Search dialog box will be opened.  Figure 5-32
shows the case of a Result subwindow when the error/alarm measurement is specified in the
Test Menu subwindow.  This operation is the same if other measurements are specified.

Fig. Fig. Fig. Fig. 5555----33333333  Auto Search dialog box  Auto Search dialog box  Auto Search dialog box  Auto Search dialog box

3. Set the operation mode of the Auto Search by selecting from the Mode drop-down list box.

Phase & Threshold Searches the optimal values for both the threshold level and
phase.

Threshold Searches the optimal value for the threshold level.
Phase Searches the optimal value for the phase.
OFF Do not perform the Auto Search of the threshold level and phase

4. Set ON/OFF of the pattern search by selecting from the PRBS Pattern Search drop-down list
box.

NoteNoteNoteNote
If the mark ratio of the whole receive pattern is extremely low or extremely high, the
auto search in the threshold direction cannot work normally.  The auto search may fail
if "Normal" is set as the synchronization method for the PRGM pattern, and the fre-
quency is low.

5. If you press the Start button, the auto search starts.
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6. When the Auto Search starts, a dialog box for monitoring opens.  If you want to cancel the
Auto Search, press the Cancel button.

Fig. Fig. Fig. Fig. 5555----34343434  Auto Searching dialog box  Auto Searching dialog box  Auto Searching dialog box  Auto Searching dialog box

NoteNoteNoteNote
You cannot press the Start button if both the auto search operation mode and pattern
search are "OFF".
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5.7 Measuring Errors/Alarms

5.7.1 Functions

The MU163240C 3.2G Error Detector (called the ED unit) can measure the following items as
error/alarm measurements.

Error measuring itemsError measuring itemsError measuring itemsError measuring items
ER EC EI %EFI Threshold EI Threshold %EFI

Error performance (conforming to ITU-T G.821)Error performance (conforming to ITU-T G.821)Error performance (conforming to ITU-T G.821)Error performance (conforming to ITU-T G.821)
ES EFS SES DM US ES
%ES %EFS %SES %DM %US

Alarm measuring itemsAlarm measuring itemsAlarm measuring itemsAlarm measuring items
⋅ Power failure/recovery time ⋅ Power failure interval
⋅ Clock loss/recovery time ⋅ Clock loss interval
⋅ Sync loss/recovery time ⋅ Sync loss interval

As the error detection mode, you can select from the insertion error (INS error), loss error (OMI
error), and Total error.  The INS error is an error in which the bit 0 of the reference pattern is
inverted into the bit 1.  Conversely, the OMI error is an error in which the bit 1 of the reference
pattern is inverted into the bit 0.  In Total error detection mode, both types of errors are detected
without making any distinction.
If you select INS/OMI as the error detection mode, INS errors and OMI errors can be measured
simultaneously.

×

× × × × ×
×××××

×××××××××

Reference pattern

Input pattern

Total
INS
OMI

: Detected error×

Fig. Fig. Fig. Fig. 5555----35353535  Differences of errors depending on the error detection mode  Differences of errors depending on the error detection mode  Differences of errors depending on the error detection mode  Differences of errors depending on the error detection mode
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5.7.2 Setting measuring conditions

1. Open the 'Test Menu: Measurement' panel and then select "Error/Alarm" from the Test Item
drop-down list box.

1

2

3
4

56

7

Fig. Fig. Fig. Fig. 5555----36363636  Test Menu: Measurement panel (Error/Alarm)  Test Menu: Measurement panel (Error/Alarm)  Test Menu: Measurement panel (Error/Alarm)  Test Menu: Measurement panel (Error/Alarm)

2. Set the measuring mode by selecting from the MEAS. Mode drop-down list box.  If you select
"Untimed", you need not set for procedure 3.

Repeat Repeats measurements of the measuring interval.
Single Ends measurements after one measuring interval.
Untimed Performs measurements from the measurement start instruction

to the end instruction.

3. Set the time for one measuring cycle.  Press the Setup button, and the Measurement Time
dialog box will be opened.  Enter the time for one measuring interval in the spin box and
then press the OK button.

Fig. Fig. Fig. Fig. 5555----37373737  Measurement Time dialog box  Measurement Time dialog box  Measurement Time dialog box  Measurement Time dialog box
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4. To set the measurement start time, press the Setup button.  The Timed Start dialog box will
be opened.

Fig. Fig. Fig. Fig. 5555----38383838  Timed Start dialog box  Timed Start dialog box  Timed Start dialog box  Timed Start dialog box

4-1. Select "ON" from the Timed Start drop-down list box.

4-2. Enter the date and time in the spin box.

4-3. To enable the change, press the OK button.

5. To set a variety of measuring conditions, press the Setup button in the MEAS Condition
group box.  The Measurement Condition dialog box will be opened.

5-3

5-2

5-4

5-5

5-6

5-7

5-85-1

Fig. Fig. Fig. Fig. 5555----39393939  Measurement Condition dialog box  Measurement Condition dialog box  Measurement Condition dialog box  Measurement Condition dialog box

5-1. Set the intervals for EI and %EFI.  Select either 100 ms or 1 s from the Interval drop-
down list box.

5-2. Set ON/OFF of the performance measurement by selecting from the Measurement drop-
down list box.
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5-3. Select the threshold value for calculating SES and DM from the Threshold drop-down list
box.  You cannot set this value if the Measurement is "OFF".

SES:1E-3/DM:1E-6 Threshold value 10-3 for calculating SES and 10-6 for calcu-
lating DM

SES:1E-4/DM:1E-8 Threshold value 10-4 for calculating SES and 10-8 for calcu-
lating DM

5-4. Set ON/OFF of the Threshold EI and Threshold %EFI measurements by selecting from
the Measurement drop-down list box in the Threshold EI/%EFI group box.

5-5. Set ON/OFF of the power failure measurements by selecting from the Measurement
drop-down list box in the Power Fail group box.

NoteNoteNoteNote
When carrying out settings on the 'System: System' panel, you cannot specify this set-
ting if the system operation mode does not allow measurements during power failure.
For details on the system operation modes, see "6.4  Setting System Operations" of the
operation manual of the MP1632C Digital Data Analyzer.

5-6. Set the processing during clock loss by selecting from the Clock Loss Evaluation drop-
down list box.

ON The interval of clock loss is counted as a clock loss interval and also in the
total interval calculation, but it is not counted as an error interval.
The interval of clock loss becomes an unavailable interval.  If it is
counted as an available period, it is also counted in the error second cal-
culation.

OFF The interval of clock loss is counted only as a clock loss interval and is not
counted for any other item.
The interval of clock loss is counted neither as an unavailable nor an
available period.  Also an interval being determined is counted neither
as an available nor an available period.

In each case, the error count and clock count made during clock loss are excluded from the
calculation.
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5-7. Set the processing during sync loss by selecting from the Sync Loss Evaluation drop-
down list box.

ON The interval of sync loss is counted as a sync loss interval and also in the
total interval calculation, but it is not counted as an error interval.
The interval of sync loss becomes an available interval.  If it is counted
as an available period, it is also counted in the error second calculation.

OFF 　The interval of sync loss is counted only as a sync loss interval and is not
counted for any other item.
The interval of sync loss is counted neither as an unavailable nor an
available period.  Also an interval being determined is counted neither
as an unavailable nor an available period.

In each case, the error count and clock count made during sync loss are excluded from the
calculation.

5-8. Now the setting is completed.  To enable the change, press the OK button.

6. Set the error detection method by selecting from the Error Type drop-down list box in the
group box of the ED unit.

Total Detects the insertion errors and omission errors together.
INS/OMI Detects the insertion errors and omission errors separately.

7. To mask the internal route of the ED unit, press the Route Mask Setting button.  The
Route Mask dialog box will be opened.

 

7-1 7-2

7-3

Fig. Fig. Fig. Fig. 5555----40404040  Route Mask dialog box  Route Mask dialog box  Route Mask dialog box  Route Mask dialog box

7-1. To mask all routes press the Mask All button.

7-2. To unmask all routes press the Clear All button.

7-3 Now the setting is completed.  To enable the change, press the OK button.

NoteNoteNoteNote
For details of internal route mask, refer to "Appendix I  Internal Route Mask".

8. Before starting measurements, see the next section.
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5.7.3 Starting error/alarm measurements

You can start and stop measurements using a Result subwindow or the toolbar.  Open the Result
subwindow after checking that Error/Alarm is selected from the Test Item drop-down list box on
the 'Test Menu: Measurement' panel.  You can start measurements by pressing the Start button
at upper right corner of the Result subwindow.

Fig. Fig. Fig. Fig. 5555----41414141  Measurement start button  Measurement start button  Measurement start button  Measurement start button
The gauge in the parent window works during measurements to indicate that measurements are
being performed.  Measurement progress is displayed in the Result subwindow.  The following
three modes are available for displaying the measurement progress.  You can switch these dis-
play modes using the tab in the Result subwindow.

⋅ ALL Displays error and alarm measuring results simultaneously.
You must select the performance measuring count or % value.

⋅ Zoom Up to four measuring items are selected and then displayed with
scale-up.

⋅ Monitor Whether errors or alarms have occurred is displayed using images
on the LED display.

"*****" or "-----" may be displayed as measuring results.  The meanings of each of them are listed
below.  They are common to the whole display mode.

***** Indicates a measuring item that is excluded from measurement.
----- Indicates that, for some reason, valid measuring results are not

obtained.
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((((1111) ) ) ) ALL display modeALL display modeALL display modeALL display mode

1. Open the 'Result: All' panel.

2 3

Fig. Fig. Fig. Fig. 5555----42424242  Result: All panel   Result: All panel   Result: All panel   Result: All panel ((((during error/alarm measurementsduring error/alarm measurementsduring error/alarm measurementsduring error/alarm measurements))))

2. Set the display format of measurement progress by selecting from the Display drop-down list
box.

Current Displays accumulated results of measured data up to now in real
time.

Last Displays the results of the last completed measuring cycle.  The
display content is not updated until the next measuring cycle is
completed.

3. Set the mode of the time display by selecting from the Time drop-down list box.

Elapsed Displays the elapsed time.  If Meas. mode "Repeat" is selected,
the elapsed time of the current measuring cycle is displayed.

Timed Displays the remaining time of the measuring cycle.  If Meas.
mode "Repeat" is selected, the remaining time of the current
measuring cycle is displayed.  If Meas. mode Untimed is selected,
this item cannot be selected.

Start Displays the start time of measurements.  If Meas. mode "Re-
peat" is selected, the start time of the current measuring cycle is
displayed.

Date & Time Displays the current date and time.
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((((2222) ) ) ) Zoom display modeZoom display modeZoom display modeZoom display mode

1. Open the 'Result: Zoom' panel.

2

3

4

Fig. Fig. Fig. Fig. 5555----43434343  Result: Zoom panel  Result: Zoom panel  Result: Zoom panel  Result: Zoom panel

2. Set the display format of measurement progress by selecting from the Display drop-down list
box.

Current Displays accumulated results of measured data up to now in real
time.

Last Displays the results of the last completed measuring cycle.  The
display content is not updated until the next measuring cycle is
completed.
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3. To select items to be displayed in each of the four scaled-up display areas.  Press the Display
Item button to open the Display Item Select dialog box.

3-1

3-2

3-4

Fig. Fig. Fig. Fig. 5555----44444444  Display Item Select dialog box  Display Item Select dialog box  Display Item Select dialog box  Display Item Select dialog box

3-1. Open the panel corresponding to the display area to be set.

3-2. Select ON/OFF of the display from the Display drop-down list box.

3-3. Select items to be displayed marking the option button.

NoteNoteNoteNote
You cannot select the Power Fail as a display item if the system operation mode does not
allow power failure measurement.  For details on the system operation mode, see "6.4
Setting System Operations" of the MP1632C Digital Data Analyzer operation manual.

3-4. If you select "Threshold EI" or "Threshold %EFI" as an item to be displayed, the Select
button becomes valid.  Press the Select button to open the Threshold EI/%EFI Select
dialog box.  Press the OK button after selecting the threshold value marking the option
button.

Fig. Fig. Fig. Fig. 5555----45454545  Threshold EI/%EFI Select dialog box  Threshold EI/%EFI Select dialog box  Threshold EI/%EFI Select dialog box  Threshold EI/%EFI Select dialog box
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3-5. If you select Performance as an item to be displayed, the Select button becomes valid.
Press the Select button to open the Performance Item Select dialog box.  Press the OK
button after selecting the Performance item marking the option button.

Fig. Fig. Fig. Fig. 5555----46464646  Performance Item Select dialog box  Performance Item Select dialog box  Performance Item Select dialog box  Performance Item Select dialog box

Carry out the above setting for each display area.

3-6. To enable the change, press the OK button.

4. Select the display mode of the measuring time from the Time drop-down list box.

Elapsed Displays the elapsed time.  If Meas. mode "Repeat" is selected,
the elapsed time of the current measuring cycle is displayed.

Timed Displays the remaining time of the measuring cycle.  If Meas.
mode "Repeat" is selected, the remaining time of the current
measuring cycle is displayed.  If Meas. mode "Untimed" is se-
lected, this item cannot be selected.

Start Displays the start time of measurements.  If Meas. mode "Re-
peat" is selected, the start time of the current measuring cycle is
displayed.

Date & Time Displays the current date and time.
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((((3333) ) ) ) Monitor display modeMonitor display modeMonitor display modeMonitor display mode

1. Open the 'Result: Monitor' panel.

2 3

Fig. Fig. Fig. Fig. 5555----47474747  Result: Monitor panel  Result: Monitor panel  Result: Monitor panel  Result: Monitor panel

2. Set the display mode of the measuring time by selecting from the Time drop-down list box.

Elapsed Displays the elapsed time.  If "Repeat" is selected, the elapsed
time of the current measuring cycle is displayed.

Timed Displays the remaining time of the measuring cycle.  If Meas.
mode "Repeat" is selected, the remaining time of the current
measuring cycle is displayed.  If Meas. mode "Untimed" is se-
lected, this item cannot be selected.

Start Displays the start time of measurements.  If "Repeat" is selected,
the start time of the current measuring cycle is displayed.

Date & Time Displays the current date and time.

3. Two LEDs on the right and left sides of the measuring result display field signify the follow-
ing.
Left LED (red): Real-time monitor.  When an error/alarm occurs, it is turned ON

in real time.  If no error/alarm occurs, it is not turned ON.
Right LED (Yellow): History monitor.  If an error/alarm occurs in the current meas-

uring interval, it is turned ON and is not turned OFF until the
end of the measuring cycle.
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5.7.4 Printing measuring results

This section describes how to print measuring results of error/alarm measurements.  When
printing is requested, measuring results (intermediate measuring data created every second) at
the time of the request are output once by this function.  "Appendixes F Printer Output Format"
shows output examples to a printer.

1. Select Print from the File menu of the parent window.  The Print dialog box will be opened.

Fig. Fig. Fig. Fig. 5555----48484848  Print dialog box  Print dialog box  Print dialog box  Print dialog box

2. Select "Error/Alarm" from the Type of Print List drop-down list box.

3. Check the items to be printed in the Item Select group box.

Error Outputs EC, ER, EI, and %EFI to end data.
Threshold EI/%EFI Outputs Threshold EI and Threshold %EFI to end data.
Performance Count Outputs EC, ES, EFS, SES, US, and DM to end data.
Performance % Outputs %ES, %EFS, %SES, %US and %DM to end data.
Alarm Interval Outputs the alarm interval to end data.
Clock Frequency Data Outputs frequency measuring results to end data.

NoteNoteNoteNote
1. If the Threshold EI/%EFI is "OFF", the Threshold EI/%EFI cannot be checked.
2. If the Performance is "OFF", the Performance Count and Performance % cannot be

checked.

4. If you press the OK button, printing starts.



74

5.8 Sending with Added Errors

5.8.1 Setting error addition conditions

The MU163220C 3.2G Pulse Pattern Generator (hereafter called the PPG unit) can send patterns
with added errors.  For details of error addition, see "Appendix E  Error Addition".

1. Open the 'Test Menu: Error Addition' panel.  You can see here the setting of the error addi-
tion method.

2

3

Fig. Fig. Fig. Fig. 5555----49494949  Test Menu: Error Addition panel  Test Menu: Error Addition panel  Test Menu: Error Addition panel  Test Menu: Error Addition panel

2. Select the rate of errors to be added by selecting from the Rate drop-down list box.

1E-3 to 1E-9 Adds errors at the rate of 10-3 to 10-9

Single Adds one error at the timing of the Single button press.
EXT Adds errors through input of the EXT Error Input connector

Specification of signal from the EXT Error Input is described bellow.

Amplitude 1 Vp-p ±20%
Offset (VIH) 0 V ±0.2 V
Pulse width exceeding (8 / fundamental frequency)

3. Set the route of addition by selecting from the Addition Route drop-down list box.
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5.8.2 Adding errors

To add errors under the condition set in "5.8.1  Setting error addition conditions", operation is
needed on the 'Test Menu: Error Addition' panel during transmission.

Fig. Fig. Fig. Fig. 5555----50505050  Test Menu: Error Addition panel  Test Menu: Error Addition panel  Test Menu: Error Addition panel  Test Menu: Error Addition panel
((((If Rate is SingleIf Rate is SingleIf Rate is SingleIf Rate is Single))))

Press the Error Addition button.  The lamp at the side is turned ON.  If you press the Single
button while the lamp is turned ON, one bit of error is added at the timing of the button press.

((((If Rate is other than SingleIf Rate is other than SingleIf Rate is other than SingleIf Rate is other than Single))))

Press the Error Addition button.  The lamp at the side is turned ON to indicate that errors are
being added.  If you press the Error Addition button again, the lamp is turned OFF and error
addition is stopped.
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5.9 For the Users of the Existing BERTS

5.9.1 Customize subwindow

Customize subwindow is useful especially for BERTS users who are familier with 'one key one
parameter' operation.  With this subwindow, setting various parameters and monitoring the
result can be done on one screen.  For example, error rate can be measured with continuous
changing delay of ED clock.
Customize subwindow consists of eight frames: (maximum) six Setup group boxes, one Result
group box, and one ETC/ Pattern Edit group box.

C

Setup
group

Result
group

ETC/
Pattern
Edit
group

Fig. Fig. Fig. Fig. 5555----51515151  Customize subwindow  Customize subwindow  Customize subwindow  Customize subwindow
To input the value of the parameters,
1. Press the button shown at the left of the parameter box (Frequency, Amplitude, etc at Fig.5-51)

and the LED at the left of the button will turn on to indicate that the value is ready to be input.
2. Input the value with the numeric value entry keys or with the spin box at the right side of the

parameter.  Some parameters like POS or NEG can be set with drop-down list box.  The val-
ue is effective as soon as the value is set.

3. Press the button shown at the left side of the parameter box again, and the LED will turn off to
indicate that the value cannot be input until the button is pressed again.  It is useful to pre-
vent from accidental value changing.
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Table 5-4 lists the setting items that can be assigned to the six Setup group boxes.

Table Table Table Table 5555----4444  Setting items that can be assigned to Setup group boxes  Setting items that can be assigned to Setup group boxes  Setting items that can be assigned to Setup group boxes  Setting items that can be assigned to Setup group boxes

Setting items related to MU163220C
Clock output interface Amplitude*1, Offset*1, Delay*3, Duty
Data output interface Amplitude*2, Offset*2, Cross Point
Send pattern Mark Ratio, Logic, Pattern

Setting items related to MU163240C
Clock input interface Delay, Polarity
Data input interface Threshold*2

Receive pattern Mark Ratio, Logic, Pattern
Error/Alarm Measurement Error Type, MEAS. Mode, MEAS. Time

In addition, the parameters related to the internal synthesizer can be assigned.  For details,
refer to “6.15  For the Users of the Existing BERTS” in the MP1632C Digital Data Analyzer
operation manual.

*1 This item cannot be assigned if "VAR" is not selected from the Level drop-down list box on
the 'Setup: Clock I/F' panel.

*2 This item cannot be assigned if "VAR" is not selected from the Level drop-down list box on
the 'Setup: Data I/F' panel.

*3 This item is common setting to Clock / X Clock
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5.9.2 Assigning setting items to the Setup group boxes

This section describes the procedure for assigning setting items to Setup group boxes.  A maxi-
mum of six items can be assigned.

1. Press the Display Setup button in the Customize subwindow.

C

Display Setup
button

Fig. Fig. Fig. Fig. 5555----52525252  Display Setup button in Customize subwindow  Display Setup button in Customize subwindow  Display Setup button in Customize subwindow  Display Setup button in Customize subwindow

 The Customize Window Display Setup dialog box will open.

Fig. Fig. Fig. Fig. 5555----53535353  Customize Window Display Setup dialog box  Customize Window Display Setup dialog box  Customize Window Display Setup dialog box  Customize Window Display Setup dialog box

2. Select a group box to which a setting item is to be assigned.  Press a tab (Setup1 to Setup6)
to open the desired panel.

3. When multiple units are used in combination, select the target unit from the Unit drop-down
list box.  When it is not necessary to assign any setting item, select "OFF".  For the setting
item assignment procedure to be followed when a unit other than "3.2G PPG" and "3.2G ED"
is selected, refer to the Operation Manual that comes with the selected unit.

4. Select setting items from the Item drop-down list boxes.  For the selectable setting items, see
Table 5-4.

5. Perform steps 2 through 4 as many times as the number of items to be assigned.

6. This completes the setting.  Press the OK button to make the new setting effective.
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5.9.3 Assigning measurement items to the Result group box

This section describes the procedures for assigning measurement items to the Result group box.
Without the ED unit, you cannot assign measurement items.

1. Press the Display Setup button in the Customize subwindow.  The Customize Window Dis-
play Setup dialog box will open.

Fig. Fig. Fig. Fig. 5555----54545454  Customize Window Display Setup dialog box  Customize Window Display Setup dialog box  Customize Window Display Setup dialog box  Customize Window Display Setup dialog box

2. Press the Result tab.
NoteNoteNoteNote
It is an impossible to assign the measurement item except on Error/Alarm measurement.
When the selection in Test Item drop-down list box on Test Menu subwindow Measure-
ment panel is "Eye Margin", Result tab is invalid.

3. Select the measurement items to be displayed in the Result group box, from the Item drop-
down list.

Error Rate Displays an error rate item in the Result group box.
Error Count Displays an error count item in the Result group box.

4. This completes the setting.  Press the OK button to make the new setting effective.

NoteNoteNoteNote
It is possible to select the measurement item in the Result group box.
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5.9.4 Editing a pattern in the Customize subwindow

This section describes how to edit a pattern in the Customize subwindow.  When editing a pat-
tern, assign target channels to the Panel Editor group box following the procedure described be-
low.

 Assigning to the Pattern Edit group boxAssigning to the Pattern Edit group boxAssigning to the Pattern Edit group boxAssigning to the Pattern Edit group box

1. Press the Display Setup button in the Customize subwindow.  The Customize Window Dis-
play Setup dialog box will open.

Fig. Fig. Fig. Fig. 5555----55555555  Customize Window Display Setup dialog box  Customize Window Display Setup dialog box  Customize Window Display Setup dialog box  Customize Window Display Setup dialog box

2. Press the Edit Pattern tab.

3. When multiple units are used in combination, select the target unit from the Unit drop-down
list box.  When it is not necessary to assign any setting item, select "OFF".

4. Select “Pattern” by pressing the Select Display Pattern/Etc button.  Its Pattern/Etc status
changes as often as the Select Display Pattern/Etc button is pressed.

5. Press the OK button to make the new setting effective.  The Customize Display Window
Setup dialog box will close.
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 Editing a patternEditing a patternEditing a patternEditing a pattern
After assigning the unit to the group box, edit a pattern.  It should be noted that PRBS and
Zero-Subst patterns cannot be edited.

C

1 2

Fig. Fig. Fig. Fig. 5555----56565656  Customize subwindow  Customize subwindow  Customize subwindow  Customize subwindow

1. Specify the bit positions of the target pattern.  Use the Offset spin box for this specification.

2. Input the pattern byte by byte.  Press the Edit button to open the Pattern Edit dialog box.

Fig. Fig. Fig. Fig. 5555----57575757  Edit dialog box  Edit dialog box  Edit dialog box  Edit dialog box

3. Press bit number buttons.  The selected bits will be inverted.

4. Press the OK button to allow the new pattern take effect.

5. Repeat steps 2-4 as required.
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5.9.5 Starting Error/Alarm measurements in the Customize subwindow

This section describes the procedures for assigning “start measurement” and “stop measurement”
buttons to the Pattern group box.

1. Press the Display Setup button in the Customize subwindow.  The Customize Window Dis-
play Setup dialog box will open.

Fig. Fig. Fig. Fig. 5555----58585858  Customize Window Display Setup dialog box  Customize Window Display Setup dialog box  Customize Window Display Setup dialog box  Customize Window Display Setup dialog box

2. Select “Etc” by pressing the Select Display Pattern/Etc button.  Its Pattern/Etc status
changes as often as the Select Display Pattern/Etc button is pressed.

3. This completes the setting.  Press the OK button to make the new setting effective.
C

4 5 6

Fig. Fig. Fig. Fig. 5555----59595959  Customize subwindow  Customize subwindow  Customize subwindow  Customize subwindow

4. Start measurement by pressing the start button.

5. Stop measurement by pressing the stop button,

6. Set On/Off of the data/clock output by pressing the Output button.  Its On/Off status
changes as often as the Output button is pressed.
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5.9.6 Result group box in Customize subwindow

Result group box shows,

1. Elapsed or Timed (Remaining) Measurement Time
* Elapsed / Timed indication is toggled by clicking the Elapsed / Timed selection button.

        
2. Error Indication and Error Rate or Error Count

* INS/OMI Error / TOTAL Error can be selected at Error Type box, Measurement panel in
Test Menu subwindow. See '5.7.2  Setting measuring conditions'.

* Error Rate / Error Count is toggled by clicking the Rate/Count selection button
        

3. Clock Loss Indication and Sync Loss Indication
        

4. The frequency gotten by counting the frequency of Clock Input at ED (Error Detector).

C

Elapsed / Timed
selection button

Rate / Count
selection button

Result group box

Fig. Fig. Fig. Fig. 5555----60606060  Result group box in Customize subwindow  Result group box in Customize subwindow  Result group box in Customize subwindow  Result group box in Customize subwindow
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5.10 Saving Setting Data in a Data File and Opening a Data File

5.10.1 Saving Setting Data in Data Files

The MU163220C 3.2G Pulse Pattern Generator (hereafter called the PPG unit) and the
MU163240C 3.2G Error Detector (hereafter called the ED unit) allow you to save the setting data
in data files.
Data files are classified by unit type.  The PPG unit setting data file can be distinguished from
the ED unit setting data file according to their file name extensions.  The file name extension of
the PPG unit setting data file is “.PPG”.  The file name extension of the ED unit setting data file
is “.ED”.
The above setting data files do not contain pattern-related setting data (setting items that exists
on the 'Setup: Pattern' panel).  Pattern-related setting data of the PPG and ED units are saved
as pattern data files with a file name extension ".PTN".
For example, when the PPG unit and the ED unit are installed, a total of four files, a .PPG file,
an .ED file, and two .PTN files-are generated.

Data file Description
.PPG A PPG unit setting data file (not including pattern-related setting

data).
.ED An ED unit setting data file (not including pattern-related setting

data).
.PTN A pattern data file including pattern-related setting data of ED

and the PPG units.

1. Select "Save" from the File menu in the parent window to open the Save dialog box.

Fig. Fig. Fig. Fig. 5555----61616161  Save dialog box  Save dialog box  Save dialog box  Save dialog box
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2. Select a save file type from the Type of Save File drop-down list box.

PPG Setup (*.PPG) Saves setting data of the PPG unit.
ED Setup (*.ED) Saves setting data of the ED unit.
Pattern Data (*.PTN) Saves pattern-related setting data and the generated pattern

data.

3. When multiple units are used in combination and file type is "*.PTN", select the target unit
from the Unit drop-down list box.

4. Specify the names of the drive, directory, and file, then press the OK button.  Do not change
the file name extension.  If drive D is specified, setting data will not be saved.
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5.10.2 Opening Data Files

The MU163220C 3.2G Pulse Pattern Generator (hereafter called the PPG unit) and the
MU163240C 3.2G Error Detector (hereafter called the ED unit) allow you to open the data files
storing setting data.
Data files are opened on a unit basis.  The PPG unit setting data file can be distinguished from
the ED unit setting data file according to their file name extensions.  The file name extension of
the PPG unit setting data file is “.PPG”.  The file name extension of the ED unit setting data file
is “.ED”.
The above setting data files do not contain pattern-related setting data (setting items that can be
checked on the 'Setup: Pattern' panel).  Pattern-related setting data of the PPG and ED units are
saved as pattern data files with a file name extension ".PTN".

Data file Description
.PPG A PPG unit setting data file (not including pattern-related setting

data).
.ED An ED unit setting data file (not including pattern-related setting

data).
.PTN A pattern data file including pattern-related setting data of the

ED or the PPG units.

1. Select "Open" from the File menu in the main window to select the Open dialog box.

Fig. Fig. Fig. Fig. 5555----62626262  Open dialog box  Open dialog box  Open dialog box  Open dialog box

2. Select an open file type from the Type of Open File drop-down list box.

PPG Setup (*.PPG) Opens setting data of the PPG unit.
ED Setup (*.ED) Opens setting data of the ED unit.
Pattern Data (*.PTN) Opens pattern-related setting data and the generated pattern

data.

3. When multiple units are used in combination and file type is "*.PTN", select the target unit
from the Destination Unit drop-down list box.
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4. Specify the names of the drive, directory, and file, then press the OK button.
NoteNoteNoteNote
In opening *.PTN file, you don't need to care which unit creates it.  For example you
can open *.PTN file saved by the ED unit to the PPG unit.  In such a case, Setting
items particular to the ED unit is ignored.  All items in the Sync Setting group box are
such items.  Setting items particular to the PPG unit are the Mode and Burst Cycle in
the Burst Setting group box.
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CHAPTER 6  APPLICABLE OPERATIONS
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6.1 Setting Multiple Ports at a Time

6.1.1 Tracking function

The MU163220C 3.2G Pulse Pattern Generator (hereafter called the PPG unit) has setting items
of each output ports separately.  'Setup: Clock I/F' and 'Setup: Data I/F' panels are provided with
a tracking function which allows those setting items to be set at a time.

6.1.2 Making settings for Tracking

This section describes how to enable the tracking function taking as an example the clock inter-
face setting.

1. Press the Setup button on the 'Setup: Clock I/F' panel to open the Clock Interface dialog box.

2

Fig. Fig. Fig. Fig. 6666----1111  Clock Interface dialog box  Clock Interface dialog box  Clock Interface dialog box  Clock Interface dialog box

2. Select "ON" from the Tracking drop-down list box.  Setting items subject to tracking are
highlighted.

NoteNoteNoteNote
Duty on the Clock Interface dialog box and Cross Point on the Data Interface dialog box
are not subject to tracking.  In Addition, delay setting on the Clock Interface dialog box
is always common to Clock and X Clock.
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6.2 Making Pattern Settings Common to Units

When MU163220C 3.2G Pulse Pattern Generator (hereafter called the PPG unit) and
MU163240C 3.2G Error Detector (hereafter called the ED unit) are inserted into the MP1632C
main frame, setting items of each units exist separately.
For above reason, if you want the PPG unit and ED unit to be same pattern type, you must set
pattern twice on each dialog boxes.  To save such trouble, there is function which allows pattern
setting items to be common to the units.
Although setting items which influence only the PPG or the ED unit (e.g. setting items in the
Sync Setting group box is not for the PPG but for the ED) also appear, operation of such items
doesn't influence the other one of units.
This section describes here how to make pattern setting common to units.

1. Open the 'Setup: Setup' panel.

C

Fig. Fig. Fig. Fig. 6666----2222  Setup: Setup panel  Setup: Setup panel  Setup: Setup panel  Setup: Setup panel

2. Select "ON" from the Pattern drop-down list box in the Slot3 & Slot4 Common Setting group
box.
NoteNoteNoteNote
After selecting "ON" from the Pattern drop-down list box, pattern settings of the PPG
unit are made same as the ED unit's.

3. Now the pattern settings become common to units.  For setting, refer "5.1    Setting a
Send/Receive Pattern"
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6.3 Setting the Trigger Output

MU163220C 3.2G Pulse Pattern Generator (hereafter called the PPG unit) and MU163240C 3.2G
Error Detector (hereafter called the ED unit) have a Trigger Output connector.  This section
describes here the procedure for setting the Trigger Output.

1. Open the 'Setup: Trigger I/F' panel.

Fig. Fig. Fig. Fig. 6666----3333  Setup: Trigger I/F panel  Setup: Trigger I/F panel  Setup: Trigger I/F panel  Setup: Trigger I/F panel

2. Set signal type of the Trigger Output connector by selecting from the Source drop-down list
box. Divide

1/8 Clock Sync This output is the output clock (PPG unit) or the input clock (ED
unit) divided by 8.

Pattern Sync This output is 8 bit width pulse signal synchronized with the pat-
tern cycle.

SYNC Gain/Loss This output is low under SYNC loss state and high under SYNC
(MU163240C only) gain state.

3. When the Pattern Sync is selected on the PPG side, enter the position that the trigger starts
in the Position spin box.
NoteNoteNoteNote
The step of the Position setting is 1 when pattern type is PRBS, and 8 when pattern type
is PRGM or Zero-Subst.
SYNC Gain/Loss can be selected only for ED unit.  For details of SYNC Gain/Loss
during burst signal receiving, refer "Appendix H  Measurement Extent During Burst
Signal Receiving".
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6.4 Eye Margin Diagram

6.4.1 Functions

The MU163240C 3.2G Error Detector (hereafter called the ED unit) has a margin measurement
function and a diagram measurement function to measure eye margins.

((((1111) ) ) ) Margin measurementMargin measurementMargin measurementMargin measurement

Threshold voltages and phases which are within the specified error rate range (i.e. margin) are
measured.  Both the threshold voltage and phase can be measured at the same time.  The
threshold margin is measured, starting with the threshold voltage set for the data interface.  The
phase margin is measured, starting with the delay value set for the clock interface.  The error
rate setting range is from 10-3 to 10-9.  There are two error rate accuracy, "Fine" and "Coarse".
The number of measurement bits of the "Fine" mode is 100 time as many as the number of meas-
urement bits of the "Coarse" mode.

((((2222)))) Diagram measurement Diagram measurement Diagram measurement Diagram measurement

In the two-dimensional coordinate system (the X-axis phases represents and the Y-axis represents
threshold voltages), the points where the error rate is as specified are plotted.  Select the number
of the points of the same error rate from 8, 16, 32, and 64.

Vth

Phase

((((1111) ) ) ) Margin measurementMargin measurementMargin measurementMargin measurement ((((2222) ) ) ) Diagram measurementDiagram measurementDiagram measurementDiagram measurement
Fig. Fig. Fig. Fig. 6666----4444  Eye margin measurements  Eye margin measurements  Eye margin measurements  Eye margin measurements

NoteNoteNoteNote
If the input data signal level is set to ECL, PECL, TTL on the 'Setup: Data I/F' panel,
only the phase margin can be measured.

NoteNoteNoteNote
In case of high input amplitude, the result of eye margin and eye diagram at the
Threshold direction may be higher than real input amplitude.
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6.4.2 Setting margin measurement conditions

This section describes how to make the settings necessary for margin measurement.

1. Select "Repeat" as the pattern input mode.

1-1. To open the Pattern dialog box, press the Setup button of the ED unit on the 'Setup: Pat-
tern' panel.

1-2. Select "Repeat" from the Pattern Input drop-down list box.

2. Open the 'Text Menu: Measurement' panel.

2

5

3 3

4

Fig. Fig. Fig. Fig. 6666----5555  Test Menu: Measurement panel   Test Menu: Measurement panel   Test Menu: Measurement panel   Test Menu: Measurement panel ((((during margin measurementduring margin measurementduring margin measurementduring margin measurement))))

3. Select "Eye Margin" from the Test Item drop-down list box.  Select "Margin" from the MEAS.
Mode drop-down list box.

4. Select a subject of measurement from the MEAS. Mode drop-down list box.

Threshold Measures the threshold voltage margin.
Phase Measures the phase margin.
Threshold & Phase Measures threshold and phase margins at the same time.
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5. Select an error rate and error rate accuracy from the Error Threshold drop-down list box.
Relationships between the accuracies shown in the drop-down list box, and the error rates are
as follows:

Table Table Table Table 6666----1111  Error rates and accuracy  Error rates and accuracy  Error rates and accuracy  Error rates and accuracy
Coarse Fine

1E-3 1/103 100/105

1E-4 1/104 100/106

1E-5 1/105 100/107

1E-6 1/106 100/108

1E-7 1/107 100/109

1E-8 1/108 100/1010

1E-9 1/109 100/1011

1E-10 1/1010 100/1012

1E-11 1/1011 100/1013

1E-12 1/1012 100/1014

NoteNoteNoteNote
The lower error rate is selected, the more time will take.  For example Threshold &
Phase measurement will need a few days when 1E-12 and Fine is selected.

6. This completes the setting.  For how to start measurement, see Section "6.4.3  Performing
margin measurement”.

NoteNoteNoteNote
If you change the setting made on the 'Test Menu: Measurement' panel after completion
of measurement, then the result of the last measurement will be cleared.
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6.4.3 Performing margin measurement

The Result subwindow is used to start, stop, or monitor measurement.  Open the Result subwin-
dow after making sure that 'Test Menu: Measurement' panel is set as follows:

⋅ "Eye Margin" has been selected from the Test Item drop-down list box.
⋅ "Margin" has been selected from the MEAS. Mode drop-down list box.

1

Fig. Fig. Fig. Fig. 6666----6666  Result subwindow   Result subwindow   Result subwindow   Result subwindow ((((during maduring maduring maduring marrrrgin measurementgin measurementgin measurementgin measurement))))

Pressing the Start button at the upper-right corner of the subwindow will start measurement.
Pressing the Stop button will stop measurement.  During measurement, the gauge is displayed
to indicate that measurement is being performed.  At the lower-left corner of the subwindow is
the Clock Loss monitor lamp which lights up when clock loss occurs.

 The procedure for displaying the measurement result is as follows:

1. Select a time display mode from the Time drop-down list box.

Elapsed Displays the elapsed time.
Start Displays the measurement start time.
Date & Time Displays the current date and time.

NoteNoteNoteNote
If error exceeds the specified error rate with the starting threshold voltage and phase,
eye margin measurement results in failure.

NoteNoteNoteNote
In case of high input amplitude, the result of eye margin at the Threshold direction may
be higher than real input amplitude.
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6.4.4 Setting diagram measurement conditions

This section describes how to make the settings necessary for diagram measurement.

1. Select "Repeat" as the pattern input mode.

1-1. To open the Pattern dialog box, press the Setup button of the ED unit on the 'Setup: Pat-
tern' panel.

1-2. Select Repeat from the Pattern Input drop-down list box.

2. Open the 'Text Menu: Measurement' panel.

2

3 3

4

5

Fig. Fig. Fig. Fig. 6666----7777  Test Menu: Measurement panel   Test Menu: Measurement panel   Test Menu: Measurement panel   Test Menu: Measurement panel ((((during diagram measurementduring diagram measurementduring diagram measurementduring diagram measurement))))

3. Select Eye Margin from the Test Item drop-down list box.  Select "Diagram" from the MEAS.
Mode drop-down list box.

4. Select the number of the points (8, 16, 32, or 64) from the drop-down list box at the right of
the MEAS. Mode drop-down list box.
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5. Select an error rate.  Press the Select button to open the Threshold Select dialog box.  After
checking the error rate to be plotted in the two-dimensional space shown in Fig.6-4 (2), press
the OK button to close the dialog box.

Fig. Fig. Fig. Fig. 6666----8888  Threshold Select dialog box  Threshold Select dialog box  Threshold Select dialog box  Threshold Select dialog box

6. This completes the setting.  For how to start measurement, see Section 6.4.5, "Performing
dialog measurement”.

NoteNoteNoteNote
If you change the setting made on the 'Test Menu: Measurement' panel after completion
of measurement, then the result of the last measurement will be cleared.
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6.4.5 Performing dialog Measurement

The Result subwindow is used to start, stop, or monitor measurement.  Open the Result subwin-
dow after making sure that 'Test Menu: Measurement' panel is set as follows:

⋅ Eye Margin has been selected from the Test Item drop-down list box.
⋅ Diagram has been selected from the MEAS. Mode drop-down list box.

2 3 4

6

7

8 1 5

Fig. Fig. Fig. Fig. 6666----9999  Result window   Result window   Result window   Result window ((((during margin measurementduring margin measurementduring margin measurementduring margin measurement))))

Pressing the Start button at the upper-right corner of the subwindow will start measurement.
Pressing the Stop button will stop measurement.  During measurement, the gauge is displayed
to indicate that measurement is being performed.  At the lower-left corner of the subwindow is
the Clock Loss monitor lamp which lights up when clock loss occurs.

NoteNoteNoteNote
If error exceeds the specified error rate with the starting threshold voltage and phase, eye
margin measurement results in failure.

The Result subwindow allows you to change the scale of display, and to display a marker.  In
addition, you can switch on or off diagrams display by specifying the corresponding error rates.

NoteNoteNoteNote
In case of high input amplitude, the result of eye diagram at Threshold direction may be
higher than real input amplitude.
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 The procedure for displaying the measurement result is as follows:

1. Specify the desired error rate for the diagram.  Tick the corresponding error rate check but-
ton in the Display group box.

2. Turn on or off the marker.  Press the button on the right of Marker or ∆Marker.  Applica-
tions of the two marker are as follows:

Marker A reference marker which indicates the absolute values of the
threshold and phase at the marker position.

∆Marker A relative marker which indicates the distances of the threshold
and phase from the reference marker.

3. Bring a marker into focus.  Pressing the red cross button will bring the reference marker
into focus.  Pressing the blue cross button will bring the relative marker into focus.  The
marker in focus can be moved with arrow keys or rotary encoder.

4. Specify a marker movement mode.  Press the button (see fig.6-9).  The selected mode will
appear on the button.  There are the following two marker movement modes:

Fix Moves the marker along one of the plotted diagrams.
Free Moves the marker within the display area irrespective of the

measurement result.

5. When you have selected "Fix", select the diagram on which the marker is to be located.  Se-
lect it by pressing the corresponding option switch in the Marker group box.

6. Select a time display mode from the Time drop-down list box.

Elapsed Displays the elapsed time.
Start Displays the measurement start time.
Date & Time Displays the current date and time.
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7. Set the scales of the threshold axis and the phase axis respectively.  Press the Scale button.
The Scale dialog box will open.

Fig. Fig. Fig. Fig. 6666----10101010  Scale dialog box  Scale dialog box  Scale dialog box  Scale dialog box

7-1. Enter the minimum values and graduations of the threshold and phase.  The setting
ranges are as follows:

Setting item Setting range
MIN (Threshold) -4.000 to +3.990 V
Step (Threshold) 0.001 to 0.800 V
MIN (Phase) -1000 to +980 ps
Step (Phase) 2 to 200 ps

7-2. Press the OK button to define the setting made above.

8. To adjust the scale automatically so that the entire measurement result is included in the
display area, press the Auto Scale button.
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 Moving Markers

To move markers, use the arrow keys or rotary encoder at the front of the main frame.  Marker
movements depend on the selected movement mode.  Functions of the marker movement keys
are described below.

Fix mode
Turing clockwise Move the marker clockwise along the measurement points.
Turning Move the marker counter clockwise along the measurement points.
counterclockwise
↑, →key Move the marker clockwise along the measurement points.
↓, ←key Move the marker counterclockwise along the measurement points.

Freemode
Turning clockwise Moves the marker to the right when  is displayed on the vertical bar

of the marker.  Moves the marker up when  is displayed on the
horizontal bar of the marker. 

Turning Moves the marker to the left when  is displayed on the vertical bar
counterclockwise of the marker.  Moves the marker down when  is displayed on the

horizontal bar of the marker.
↓key Move the marker down.
↑key Move the marker up.
←key Move the marker to the left.
→key Moves the marker to the right.
Shift + Enter Change the  position.
Clicking the edge Change the  position.
of the Markers
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6.4.6 Printing the measurement result

This section describes how to print out the result of the last measurement.

1. Select "Print" from File menu of the parent window after the measurement.  The Print dia-
log box will be opened.

2
3

Fig. Fig. Fig. Fig. 6666----11111111  Print dialog box  Print dialog box  Print dialog box  Print dialog box

2. Select "Eye Margin" from the Type of Print List drop-down list box.

3. If you press the OK button, printing starts.



104

6.5 Diagram Template

6.5.1 Functions
The MU163240C 3.2 G Error Detector (hereinafter, ED unit) has the function of displaying the
mask template (hereinafter, template) used as pass/fail judgement reference for the measurement
results on the eye diagram measurement results display window.

Following functions are provided:

• Editing up to four templates and displaying them on the same window as eye diagram measurement results
· Template colors can be changed.

• Saving and recalling the created templates
· The template format is CSV that allows edit on a text editor.
· Eye diagram measurement results can be saved in the CSV format and edited on a text

editor into templates.
• Moving templates according to eye diagram measurement results
• Printing displayed templates

· Text data and display image can be printed.
• Handling templates by remote control

· SCPI-format remote commands are provided.



105

6.5.2 Activating Template Window
Activate the Eye Diagram Template window as in the following way:·

1. On Test Menu: Measurement panel; set the eye diagram measurement, as below.
Test Item: Eye Margin
MEAS. Mode: Diagram

C

Fig. Fig. Fig. Fig. 6666----12121212  Test Menu: Measurement panel  Test Menu: Measurement panel  Test Menu: Measurement panel  Test Menu: Measurement panel
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2. At this time, the Result sub-window is set for edit template display.
Set as beloe.
Template: ON
Select: Check the template in the Template selection dialog box for edit and display.

(After selecting the template, click OK to close the dialog box.)

C

Fig. Fig. Fig. Fig. 6666----13131313  Displaying template on Result sub-window  Displaying template on Result sub-window  Displaying template on Result sub-window  Displaying template on Result sub-window
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6.5.3 Outline of Window

The preparatory operations explained in 6.5.2 allow template display on the Result sub-window.
Operation of this window is now explained.

C

1

Fig. Fig. Fig. Fig. 6666----14141414  Result sub-window  Result sub-window  Result sub-window  Result sub-window

1. Result sub-window open/close button
Click or double-click the Result button to activate the sub-window and display the eye dia-
gram measurement results and templates.  Eye diagram measurement is also performed on
this window.  For eye diagram measurements, refer to the "6.4.5 Performing dialog Meas-
urement”.
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C

2 3 4 5 6

1

Fig. Fig. Fig. Fig. 6666----15151515  Template-related settings on Result sub-window  Template-related settings on Result sub-window  Template-related settings on Result sub-window  Template-related settings on Result sub-window

1. File menu title [File]
Click here to save, recall, or print templates.

2. Template ON/OFF button [ON/OFF]
Click here to display or hide all templates.

3. Template and color selection button [Select]
Click this button to open the template and color selection dialog box.  After a selection is
made, click the OK button in the dialog box to make the selected items valid.

4. Template edit button [Edit]
Click this button to open the template editor dialog box.  After editing, click the OK button
in the dialog box to make the edit results valid.
NoteNoteNoteNote

When entering a numeric value directly into the dialog box, be sure to press the Enter
key on the keyboard after confirming the numeric value.  If you go to another input
dialog without pressing the Enter key, the numeric input becomes invalid.

5. Template movement button
Click this button to move the template selected in the move template selection box 6 using the
rotary encoder or the up/down/right/left keys on the front panel.

6. Move template selection box
Select the template to be moved when the template movement button 5 is clicked for selec-
tion.
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6.5.4 Editing Template

This subsection explains template editing.
For this operation, enable template display by the operations explained in 6.5.2.

6.5.4.16.5.4.16.5.4.16.5.4.1   Editing by Template Editor  Editing by Template Editor  Editing by Template Editor  Editing by Template Editor

1 2 3 4

5

6

Fig. Fig. Fig. Fig. 6666----16161616  Template Editor dialog box  Template Editor dialog box  Template Editor dialog box  Template Editor dialog box

NoteNoteNoteNote

When entering a numeric value directly into the dialog box, be sure to press the Enter
key on the keyboard after confirming the numeric value.  If you go to another input
dialog without pressing the Enter key, the numeric input becomes invalid.

1. Edit template selection button [Editing Template No.]
Select a template to edit.  Template 1 to Template 4 can be selected.

2. Points setting box [Number of Points]
Enter the number of points from 2 to 32 for the template.
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3. Offset value setting boxes [Voltage Offset, Phase Offset]
Enter the voltage and phase offset values for the entire template.

Voltage Offset: Voltage offset value from –4.000 to +4.000 [V]
Phase Offset: Phase offset value from –1000 to +1000 [ps]

When the template is moved using the rotary encoder or the up/down/right/left keys on the
front panel, the offset values change automatically.

4. End-point connection ON/OFF button [Connect end to start]
Select whether to connect or not to connect the end point to start point of the template.
If the eye diagram measurement results exceed the MP1632C display frame, a template can
be created accordingly.

5. Point coordinate setting boxes [Setting Point, Voltage, Phase]
Enter the setting values for each point of the template.
Setting Point Setting point number: 1 to Number of Points
Voltage Voltage for the point entered at Setting Point: –8.000 to +8.000 [V]
Phase Phase for the point entered at Setting Point: –2000 to +2000 [ps]

6. Point coordinate list
This area lists the coordinates of set points.

 Editing template

1. Set the template ON/OFF button on the Result sub-window to ON.

2. Click the template edit button to open the Template Editor dialog box.

3. At 1, select a template to edit.

4. At 2, set the number of points for the template.

5. At 3, enter offset values for the entire template.  Values can also be set automatically by
moving the template after editing is finished.

6. If not connecting the end and start points of the template, set OFF at 4.

7. At 5, enter the coordinates of each point in the template.  The entered point coordinates can
be confirmed at 6.

8. After entering the point coordinates, click the OK button at the upper right of the dialog box
to close the dialog box.  Clicking the button makes the input values valid.
For terminating the editor without making the values valid, click the Cancel button to close
the dialog box.
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6.5.4.26.5.4.26.5.4.26.5.4.2   Creating a template using eye diagram measurement results  Creating a template using eye diagram measurement results  Creating a template using eye diagram measurement results  Creating a template using eye diagram measurement results

This section explains how to create a template using the eye diagram measurement results.
First, save a template in TPT format.  Then, open the file as a text-format file to display the in-
formation shown in Fig. 6-17.  Change the number of template points (Points) to the number of
eye diagram measurement points.
Next, open the eye diagram measurement results (which is saved in CSV format) in text format,
and copy-and-paste this at the coordinate description field of each point of the template in Fig. 6-
17.
The last, save the copy-and-paste file in TPT format, then open this on file menu to create a tem-
plate of the eye diagram measurement results.

C
1
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4

Fig. Fig. Fig. Fig. 6666----17171717  Example of Template Format  Example of Template Format  Example of Template Format  Example of Template Format

1. Number of template points
Enter the number of points obtained through the eye diagram measurement.

2. End point connection ON or OFF setting
When connecting the end template point with the start template point: 1
When not connecting the end template point with the start template point: 0

3. Offset value
This is the offset value for the entire template.
Offset, [Voltage value (V; down to three decimal places)], [Phase value (in units of ps / 2 ps
step)]

4. Value at each point of template
This is the value at each point of the template
[Item No. 1 to the followings: point number], [Voltage value (V; down to three decimal places)],
[Phase value (in units of ps / 2 ps step)]
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 [File] menu
Saves, recalls and prints the eye diagram measurement results and the template.

C

Fig. Fig. Fig. Fig. 6666----18181818  Example of Eye Diagram Measurement Results  Example of Eye Diagram Measurement Results  Example of Eye Diagram Measurement Results  Example of Eye Diagram Measurement Results
Shown in the Result sub-windowShown in the Result sub-windowShown in the Result sub-windowShown in the Result sub-window
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 Items in the [File] menu – Save
By selecting [Save] in the [File] menu, the dialog box for saving file is opened as shown in
Fig.6-19.

1

2

3 4 5

Fig. Fig. Fig. Fig. 6666----19191919  Dialog Box for Saving File  Dialog Box for Saving File  Dialog Box for Saving File  Dialog Box for Saving File

1. File Name (A box to enter a file name for saving data.)
Enter a file name to save data.  The extension for a CSV-format file to contain the eye dia-
gram measurement results is CSV.  The extension for a template file is TPT.

2. Type of Save File (A drop-down list box to select an item to be saved.)
Select an item to be saved.
If saving an eye diagram measurement result in CSV format, select

Eye Diagram CSV Data (*.CSV).
If saving a template, select

Eye Template Data (*.TPT).

3. Source Template (A drop-down list box to select a source data.)
Template 1 through 4 may be selected when saving a template.

4. Drives (A drop-down list box to select a drive as the saving destination.)
Select a drive to save data.  Drive A represents the floppy disk drive, while Drive C repre-
sents the hard disk drive.

5. Directories (A box to select a directory as the saving destination.)
Displays directories on the drive selected at 4 as the saving destination.  Select a directory to
save a file.
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Editing template

Describes the procedure for editing template, below.

 Measure an eye diagram.
(Refer to "6.4.5 Performing dialog Measurement" for more information on eye diagram meas-
urement.)

Fig. Fig. Fig. Fig. 6666----20202020  Example of Eye Diagram measurement results on the Result sub-window  Example of Eye Diagram measurement results on the Result sub-window  Example of Eye Diagram measurement results on the Result sub-window  Example of Eye Diagram measurement results on the Result sub-window

 Save the eye diagram measurement results.
Open the Save window on the [File] menu, and save the measurement results in CSV format.

Fig. Fig. Fig. Fig. 6666----21212121  Save window  Save window  Save window  Save window

1

2
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 Save the template data.
Open the Save window on the [File] menu, and save a template data in TPT format.

Fig. Fig. Fig. Fig. 6666----22222222  Save window  Save window  Save window  Save window

 Open the template data file using Notepad, as described below.
Open [Program Manager].

Fig. Fig. Fig. Fig. 6666----23232323  Program Manager window  Program Manager window  Program Manager window  Program Manager window

Open [Accessories] on [Program Manager].

Fig. Fig. Fig. Fig. 6666----24242424  Accessories window  Accessories window  Accessories window  Accessories window

C
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Activate [Notepad] on [Accessories].

Fig. Fig. Fig. Fig. 6666----25252525  Notepad window  Notepad window  Notepad window  Notepad window

Open the CSV-format measured data file using Notepad.

Fig. Fig. Fig. Fig. 6666----26262626  Open window  Open window  Open window  Open window

The CSV-format file opens as a text-format file.

Fig. Fig. Fig. Fig. 6666----27272727  CSV file data  CSV file data  CSV file data  CSV file data
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 Activate new Notepad in another window, as described below.
Open the template data file using another Notepad.

Fig. Fig. Fig. Fig. 6666----28282828  Open window  Open window  Open window  Open window

New template file opens as a text-format file.

Fig. Fig. Fig. Fig. 6666----29292929  Template data file  Template data file  Template data file  Template data file
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 Copy/paste the data field of the CSV-format measurement file at the template data file, as
described below.
Copy the coordinate data contained in the CSV-format measurement data file.

Fig. Fig. Fig. Fig. 6666----30303030  CSV data file  CSV data file  CSV data file  CSV data file

Paste (overwrite) the copied data on the coordinate data in the template data window.

Fig. Fig. Fig. Fig. 6666----31313131  Template data window  Template data window  Template data window  Template data window
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Change the "Points" to the number of points of the measurement data.

Fig. Fig. Fig. Fig. 6666----32323232  Editing template file  Editing template file  Editing template file  Editing template file

Save the template data as a new template file.

Fig. Fig. Fig. Fig. 6666----33333333  Save window  Save window  Save window  Save window

Open the saved data on the [File] menu of the MP1632C.
The eye diagram measurement results are now available as a template file.
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6.5.5 Displaying Template and Selecting Color

This subsection explains how to display the template and select its color.
For this operation, enable the template display by the operations explained in 6.5.2.

1 2 3

Fig. Fig. Fig. Fig. 6666----34343434  Template and color editor dialog box  Template and color editor dialog box  Template and color editor dialog box  Template and color editor dialog box

1. Display template selection checkboxes
Click in the checkbox of a template to display.

2. Template color display field
This field displays the current template colors.

3. Template color selection buttons
When changing the template color, click the corresponding button to open the template color
selection dialog box.
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 Displaying template

1. Set the template ON/OFF button on the Result sub-window to ON.

2. Click the template and color selection button on the Result sub-window to open the template
and color editor dialog box.

3. Check the template to display.

4. Click the OK button at the upper right of the dialog box to close the dialog box.  Clicking the
button makes the input values valid.
For terminating the editor without making the values valid, click the Cancel button to close
the dialog box.

1

2

3

Fig. Fig. Fig. Fig. 6666----35353535  Template color selection dialog box  Template color selection dialog box  Template color selection dialog box  Template color selection dialog box

1. Basic color buttons

2. Custom color buttons

3. Custom color edit button
When changing a custom color, click this button to open the custom color palette, as shown
below.
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1

32
Fig. Fig. Fig. Fig. 6666----36363636  Custom color palette  Custom color palette  Custom color palette  Custom color palette

1. Custom color direct selection buttons

2. Custom color numeric input dialog boxes
Specify a custom color by numeric input.
Hue: Hue
Sat: Saturate
Lum: Luminosity

3. Custom color replacement button
Clicking the button replaces the selected custom color with the color specified on 1 or 2.
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 Changing template color

1. Set the template ON/OFF button on the Result sub-window to ON.

2. Click the template and color selection button on the Result sub-window to open the template
and color editor dialog box.

3. Click the template color selection button corresponding to the template to change its color.
Clicking the button opens the template color selection dialog box.

4. Select and click the basic or custom color button.

5. Click the OK button at the lower right of the dialog box to close the dialog box.  Clicking the
button makes the selected color valid.
For terminating the editor without making the color valid, click the Cancel button to close the
dialog box.

 Changing custom color

1. Open the template color selection dialog box.

2. Click the custom color button to be changed.

3. Click the custom color edit button to open the custom color palette.

4. Select a color from the custom palette using the custom color direct select buttons or the cus-
tom color numeric input dialog box.

5. Click the custom color replacement button to change the custom color.
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6.5.6 Moving Template

This subsection explains template movement.
For this operation, enable template display by the operations explained in 6.5.2.

6.5.6.16.5.6.16.5.6.16.5.6.1  Moving template (1): Using the rotary encoder or the up/down/right/left keys Moving template (1): Using the rotary encoder or the up/down/right/left keys Moving template (1): Using the rotary encoder or the up/down/right/left keys Moving template (1): Using the rotary encoder or the up/down/right/left keys

1
2

Fig. Fig. Fig. Fig. 6666----37373737  Rotary encoder and up/down/right/left keys  Rotary encoder and up/down/right/left keys  Rotary encoder and up/down/right/left keys  Rotary encoder and up/down/right/left keys

1. Rotary encoder

2. Up/down/right/left keys
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C

1 2

Fig. Fig. Fig. Fig. 6666----38383838  Template movement buttons on Result sub-window  Template movement buttons on Result sub-window  Template movement buttons on Result sub-window  Template movement buttons on Result sub-window

1. Template movement button
Click this button to move a template selected in the template movement selection box 2 using
the rotary encoder or the up/down/right/left keys on the front panel.

2. Template movement selection box
Select a template to move when the template movement button is clicked.

 Moving template (1)

1. Click the template movement button on the Result sub-window.

2. Select the template to be moved in the template movement selection box.

3. The template can be moved using the up/down/right/left keys on the front panel.

4. When moving the template using the rotary encoder, set the direction to vertical or horizontal
in advance with the rotary encoder direction selection button on the sub-window, as described
below.
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Fig. Fig. Fig. Fig. 6666----39393939  Selecting vertical movement with the rotary encoder  Selecting vertical movement with the rotary encoder  Selecting vertical movement with the rotary encoder  Selecting vertical movement with the rotary encoder

Rotary encoder clockwise turn: Move up
Rotary encoder counterclockwise turn: Move down

Fig. Fig. Fig. Fig. 6666----40404040  Selecting horizontal movement with the rotary encoder  Selecting horizontal movement with the rotary encoder  Selecting horizontal movement with the rotary encoder  Selecting horizontal movement with the rotary encoder

Rotary encoder clockwise turn: Move right
Rotary encoder counterclockwise turn: Move left
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6.5.6.26.5.6.26.5.6.26.5.6.2   Moving template (2):  Moving template (2):  Moving template (2):  Moving template (2):    Using the offset value setting boxUsing the offset value setting boxUsing the offset value setting boxUsing the offset value setting box

1 2

Fig. Fig. Fig. Fig. 6666----41414141  Template editor dialog box  Template editor dialog box  Template editor dialog box  Template editor dialog box

1. Edit template selection button [Editing Template No.]
Select a template to edit.  Template 1 to Template 4 can be selected.

2. Offset value setting boxes [Voltage Offset, Phase Offset]
Enter the voltage and phase offset values for the entire template.

Voltage Offset: Voltage offset value from –4.000 to +4.000 [V]
Phase Offset: Phase offset value from –1000 to +1000 [ps]

NoteNoteNoteNote

When entering a numeric value directly into the dialog box, be sure to press the Enter
key on the keyboard after confirming the numeric value.  If you go to another input
dialog without pressing the Enter key, the numeric input becomes invalid.
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 Moving template (2)

1. Set the template ON/OFF button on the Result sub-window to ON.

2. Click the template edit button to open the template editor dialog box.

3. At 1, select the template to be edited.

4. At 2, enter offset values for the entire template.

NoteNoteNoteNote
When entering a numeric value directly into the dialog box, be sure to press the Enter
key on the keyboard after confirming the numeric value.  If you go to another input
dialog without pressing the Enter key, the numeric input becomes invalid.

5. After entering the offset values, click the OK button at the upper right of the dialog box to
close the dialog box.  Clicking the OK button makes the input values valid.
For terminating the editor without making the values valid, click the Cancel button to close
the dialog box.
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6.5.7 Saving and Recalling Template

This subsection explains how to save and recall a template.
For this operation, enable template display by the operations explained in 6.5.2.

6.5.7.16.5.7.16.5.7.16.5.7.1   Saving template  Saving template  Saving template  Saving template

Save a template as follows:

C

1

Fig. Fig. Fig. Fig. 6666----42424242  [Save] on the File menu  [Save] on the File menu  [Save] on the File menu  [Save] on the File menu

1. [Save] on the File menu
Select [Save] from the File menu to save a file.
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1

2

3 4 5

Fig.Fig.Fig.Fig.    6666----43434343  File save dialog box  File save dialog box  File save dialog box  File save dialog box

1. Save file name input box
Enter the name of a file to save.  The template extension is TPT.

2. Save item selection dropdown list box
Select an item to save.
When saving a template, select: Eye Template Data (*.TPT)

3. Save source data selection dropdown list box
Select a template to save.  Template 1 to Template 4 can be selected.

4. Save destination drive selection dropdown list box
Select a save destination drive.  Drive A is a floppy disk drive (FDD) and Drive C is a hard
disk drive (HDD).

5. Save destination directory selection box
This box lists directories in the save destination drive.  Select a directory to save a file into.
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 Saving template

1. Select [Save] from the File menu to open the file save dialog box.

2. On the save item selection dropdown list box, select:
Eye Template Data (*.TPT)

3. On the save source data selection dropdown list box, select a template to save.  Template 1 to
Template 4 can be selected.

4. On the save destination drive selection dropdown list box, select a save destination drive.
Drive A is a floppy disk drive (FDD) and Drive C is a hard disk drive (HDD).

5. On the save destination directory selection box, select a directory to save a file into.

6. At the save file name input box, enter the filename to save.  The template extension is TPT.
Set the file name:

(File name).TPT

7. Click the OK button at the upper right of the dialog box to close the dialog box.  Clicking the
button makes the input items valid.
For terminating the editor without making the items valid, click the Cancel button to close
the dialog box.
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6.5.7.26.5.7.26.5.7.26.5.7.2    Recalling template   Recalling template   Recalling template   Recalling template

C

1

Fig. Fig. Fig. Fig. 6666----44444444  [Open] on the File menu  [Open] on the File menu  [Open] on the File menu  [Open] on the File menu

1. [Open] on the File menu
Select Open on the File menu to recall a file.
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2

3 4 5

1

Fig. Fig. Fig. Fig. 6666----45454545  File recall dialog box  File recall dialog box  File recall dialog box  File recall dialog box

1. Recall file selection box
Select a file to recall.  The template extension is TPT.

2. Recall item selection dropdown list box
Select an item to recall.  When recalling a template, select:

Eye Template Data (*.TPT)

3. Recall destination data selection dropdown list box
Select a template to recall.  Template 1 to Template 4 can be selected.

4. Recall source drive selection dropdown list box
Select a recall destination drive.  Drive A is a floppy disk drive (FDD) and Drive C is a hard
disk drive (HDD).

5. Recall source directory selection box
This box lists directories in the recall source drive.  Select a directory to recall a file from.
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 Recalling template

1. Select [Open] on the File menu to open the file recall dialog box.

2. On the recall item selection dropdown list box, select:
Eye Template Data (*TPT)

3. On the recall source data selection dropdown list box, select a template to recall.  Template 1
to Template 4 can be selected.

4. On the recall source drive selection dropdown list box, select a recall source drive.  Drive A is
a floppy disk drive (FDD) and Drive C is a hard disk drive (HDD).

5. On the recall source directory selection box, select a directory to recall a file from.

6. On the recall file selection box, select a recall source file.  The template extension is TPT.

7. Click the OK button at the upper right of the dialog box to close the dialog box.  Clicking the
button makes the input items valid.
For terminating the editor without making the items valid, click the Cancel button to close
the dialog box.

NoteNoteNoteNote
When the software version of the MP1632A is less than 1.17, the eye-diagram template
file saved by the MP1632C cannot be read.  Change the model name MP1632C in the
template to the MP1632A to read the file.
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6.5.8 Printing Template

This subsection explains the template printing.
Template printing can be classified into two: numeric value printing of template data and hard-
copy printing of template image.

6.5.8.16.5.8.16.5.8.16.5.8.1   Printing template data  Printing template data  Printing template data  Printing template data
Numeric value of template data is printed, digitally as follows:

C

1

Fig. Fig. Fig. Fig. 6666----46464646  [Print] on the File menu  [Print] on the File menu  [Print] on the File menu  [Print] on the File menu

1. [Print] on the File menu
Select this command on the File menu to print the measurement result data.
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1

2

Fig. Fig. Fig. Fig. 6666----47474747  Print setting dialog box  Print setting dialog box  Print setting dialog box  Print setting dialog box

1. Print item selection dropdown box
Select a print item.  [Eye Margin] or [Recall Eye Margin] can be selected.
Eye Margin: Eye diagram measurement results
Recall Eye Margin: Eye margin measurement results once saved (.EYE format) and then 

recalled

2. Template print checkbox
Check this box to print template data.  All the data of the currently displayed templates are
printed.

 Printing

1. Select [Print] on the File menu to open the print setting dialog box.

2. On the print item selection dropdown box, select [Eye Margin] or [Recall Eye Margin].

3. Check in the template print checkbox.  All the data of the currently displayed templates are
printed.

4. Click the OK button at the upper right of the dialog box to close the dialog box.  Clicking the
button starts printing.
For not printing, click the Cancel button to close the dialog box.
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 Sample template print
>> Template <<
******************************_Template1_******************************
Number of points  12               Offset  ( –384, –1.012)
 1.(  320, –1.120) 2.(  420,  1.400)   3.(  450,  1.200)   4.(  550,  1.200)
 5.(  580,  1.400) 6.(  680,  1.120)   7.(  680,  2.880)   8.(  580,  2.600)
 9.(  550,  2.800) 10.(  450,  2.800)  11.(  420,  2.600)  12.(  320,  2.880)

Fig. Fig. Fig. Fig. 6666----48484848  Sample template print  Sample template print  Sample template print  Sample template print
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6.5.8.26.5.8.26.5.8.26.5.8.2   Outputting template hard copy  Outputting template hard copy  Outputting template hard copy  Outputting template hard copy

A template image can be printed directly as a hard copy.

C

1

Fig. Fig. Fig. Fig. 6666----49494949  [Hard Copy] on the File menu  [Hard Copy] on the File menu  [Hard Copy] on the File menu  [Hard Copy] on the File menu

1. [Hard Copy] on the File menu
Select this command on the File menu to output a hard copy of the measurement result win-
dow image.

 Printing

1. Select [Hard Copy] on the File menu to start the hard copy output.
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 Sample hard copy

C

Fig. Fig. Fig. Fig. 6666----50505050  Sample hard copy  Sample hard copy  Sample hard copy  Sample hard copy
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6.6 Setup: Utility panel

In the 'Setup: Utility' panel you can set three setting items, the Logic and the DC Impedance and
the Meas. Restart.  This section describes meanings of those setting and setting procedures.

1. LogicLogicLogicLogic

You can decide the voltage level of bit "1" high or low by selecting from the Logic drop-down
list box.

Mark High : "1" corresponds to high level output and "0" corresponds to low level output.
Mark Low : "1" corresponds to low level output and "0" corresponds to high level output.

Table Table Table Table 6666----2222  Voltage level of "1" according to the Logic selection on  Voltage level of "1" according to the Logic selection on  Voltage level of "1" according to the Logic selection on  Voltage level of "1" according to the Logic selection on
the 'Setup: Utility' panel and Setup: Pattern panel.the 'Setup: Utility' panel and Setup: Pattern panel.the 'Setup: Utility' panel and Setup: Pattern panel.the 'Setup: Utility' panel and Setup: Pattern panel.

PRGM MarkPRGM MarkPRGM MarkPRGM Mark PRBS MarkPRBS MarkPRBS MarkPRBS Mark

HighHighHighHigh LowLowLowLow HighHighHighHigh LowLowLowLow

POSPOSPOSPOS High LowPRGM, Zero-SubPRGM, Zero-SubPRGM, Zero-SubPRGM, Zero-Sub

LogicLogicLogicLogic NEGNEGNEGNEG Low High

1/2,1/4,1/8,0/81/2,1/4,1/8,0/81/2,1/4,1/8,0/81/2,1/4,1/8,0/8 Low HighPRBSPRBSPRBSPRBS

Mark RatioMark RatioMark RatioMark Ratio 1/2INVT,3/4,7/8,8/81/2INVT,3/4,7/8,8/81/2INVT,3/4,7/8,8/81/2INVT,3/4,7/8,8/8 High Low

2. DC ImpedanceDC ImpedanceDC ImpedanceDC Impedance

This setting decides the impedance of the clock and data outputs in DC area.  You can select
0Ω or 50Ω.  If 0Ω is selected, the signal from the PPG has proper offset without fluctuations
even though the load does not have 50Ω DC impedance owing to AC connection and so on.
Appositely, if the DUT is designed on the assumption that it is driven under 50Ω in DC area,
set DC impedance of the PPG to 50Ω to operate the DUT in normal condition.

3. MEAS. RestartMEAS. RestartMEAS. RestartMEAS. Restart

This setting decides whether ED should restart measuring when clock delay (on 'Setup:
Clock' panel) or threshold (on 'Setup: Data' panel) are changed.
If 'ON' is selected ED will restart measuring immediately after changing those settings.
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 PPG side settingPPG side settingPPG side settingPPG side setting

2

4

3

5

6

Fig. Fig. Fig. Fig. 6666----51515151  3.2G PPG Utility dialog box  3.2G PPG Utility dialog box  3.2G PPG Utility dialog box  3.2G PPG Utility dialog box

1. Open the 'Setup: Utility' panel and press the Setup button in the PPG group box.  The 3.2G
PPG Utility dialog box will be opened.

2. Set PRBS pattern logic by selecting from the PRBS Logic drop-down list box.

3. Set PRGM pattern logic by selecting from the PRGM Logic drop-down list box.

4. Set DC impedance of clock interface by selecting from the Clock I/F drop-down list box.
NoteNoteNoteNote
You cannot select "50 ohm" when "VAR" is not selected from the Level drop-down list
box on the 'Setup: Clock' panel.

5. Set DC impedance of data interface by selecting from the Data I/F drop-down list box.
NoteNoteNoteNote
You cannot select "50 ohm" when "VAR" is not selected from the Level drop-down list
box on the 'Setup: Data' panel.

6. Now the setting is completed.  To enable the change, press the OK button.
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 ED side settingED side settingED side settingED side setting

2

3

4

5

Fig. Fig. Fig. Fig. 6666----52525252  3.2G ED Utility dialog box  3.2G ED Utility dialog box  3.2G ED Utility dialog box  3.2G ED Utility dialog box

1. Open the 'Setup: Utility' panel and press the Setup button in the ED group box.  The 3.2G
ED Utility dialog box will be opened.

2. Set PRBS pattern logic by selecting from the PRBS Logic drop-down list box.

3. Set PRGM pattern logic by selecting from the PRGM Logic drop-down list box.

4. Select ON or OFF from the MEAS. Restart drop-down list box.

5. Now the setting is completed.  To enable the change, press the OK button.
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CHAPTER 7  APPLICABLE MEASUREMENT
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7.1 ECL DFF IC Test

This section shows a measuring example that tests DEF IC with ECL interface.

(1) ConnectionConnectionConnectionConnection

1. Fig. 7-1 shows the connection of the front panel.

Panel Lock

HDD

A

.

1

4

7

m/K

Enter

shift

p/G

n/M

C

_

3

6

9

D

TAB

BS

F

E

B

0

2

5

8MP1632A

Remote

Digital Data Analyzer

MU163220A 3.2G PPG

MU163240A 3.2G ED

Output
Data

50Ω !

Clo ck

50Ω !

D ata

50Ω !

Clock

50Ω !

Burs t Trig ger
   O utput

0 /-1V  50Ω

!

S YNC O utput

!

0 /-1V  50Ω

Input

Data

0.5 -4.0V p-p 50Ω

!

Burs t Trig ger
   I nput

0 /-1V  50Ω

!

S YNC O utput

!

0 /-1V  50Ω

ECL

GND

RECL

TERM

Clock

0.5- 4.0V p-p 50Ω

!

E CL

G ND

R ECL

TERM

E rror
M onit or

D

C

Q

Q

DFFIC

Fig. Fig. Fig. Fig. 7777----1111  Front panel connection  Front panel connection  Front panel connection  Front panel connection

2. Fig. 7-2 shows the connection of the rear panel.
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(2) Measurement condition settingMeasurement condition settingMeasurement condition settingMeasurement condition setting

1. Make settings on each panel of the Setup subwindow same condition as Table7-1

Table Table Table Table 7777----1111  Setting on the Setup subwindow  Setting on the Setup subwindow  Setting on the Setup subwindow  Setting on the Setup subwindow

PanelPanelPanelPanel Setting itemSetting itemSetting itemSetting item ValueValueValueValue
Setup Pattern Common Setting ON

(To set pattern commonly to PPG and ED)
Frequency Reference INT

Frequency 3200000 kHz*

Clock I/F (PPG) Output ON
Delay 0 ps
Level ECL

Clock I/F (ED) Polarity POS
Termination -2 V
Delay 0 ps

Data I/F (PPG) Output ON
Level ECL

Data I/F (ED) Level ECL
Pattern Pattern PRBS15

Mark Ratio 1/2
Auto Sync ON
Internal Threshold ON

* For setting procedure, refer to the "MP1632C 3.2G Digital Data Analyzer operating manual".

2. Make settings on the Measurement panel of the Test Menu subwindow same condition as
Table7-2

Table Table Table Table 7777----2222  Setting on the Test Menu subwindow  Setting on the Test Menu subwindow  Setting on the Test Menu subwindow  Setting on the Test Menu subwindow

PanelPanelPanelPanel Setting itemSetting itemSetting itemSetting item ValueValueValueValue
Measurement Test Item Error/Alarm

MEAS. Mode Repeat
Meas. Time 00:00:00:10 (10 seconds)

If you want to measure EI, %EFI, or error performance, measuring condition setting is required.
For detail of the procedure, refer to "5.7.2  Setting measuring conditions".
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3. To display error count and alarms, open the ALL panel of the Result subwindow, and make
setting same condition as Table 7-3.

Table Table Table Table 7777----3333  Setting on the Result subwindow  Setting on the Result subwindow  Setting on the Result subwindow  Setting on the Result subwindow

PanelPanelPanelPanel Setting itemSetting itemSetting itemSetting item ValueValueValueValue
ALL Display Current

time display mode Elapsed

Now, press the Start button to start measuring.
If the phase relation between Data and Clock seems to slip out, press the Auto Search button.
The Auto Search dialog will open.  Make settings same condition as Table 7-4.

Table Table Table Table 7777----4444  Setting on the Auto Search dialog box  Setting on the Auto Search dialog box  Setting on the Auto Search dialog box  Setting on the Auto Search dialog box

Setting itemSetting itemSetting itemSetting item ValueValueValueValue
Auto Search Mode Phase

PRBS Pattern Search OFF

To start auto search, press the Start button on the Auto Search dialog box.

NoteNoteNoteNote
In PRBS Pattern Search, when the input pattern mark rate is 0/8 or 8/8, it cannot be detected.
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7.2 STM-16 Optical Module Noise Tolerance Test

A measurement example in testing noise tolerance by measuring the bit error rate using a 3R
receiver as the STM-16 Optical Module is shown below.

(1) Connection

1. The connection diagram for each instrument is shown in Figure 7-3.

Coupler

Noise light
source

Optical
Attenuator B

Optical
Attenuator A

3R Receiver

E / O

Fig. Fig. Fig. Fig. 7777----3333        Connecting instrumentsConnecting instrumentsConnecting instrumentsConnecting instruments
Connect the Data output on the front panel of the PPG Unit to the E/O Module.  Connect the
clock signal from the 3R Receiver to the Clock input on the front panel of the ED Unit, and the
data signal to the Data Input.  Set Attenuation on both attenuators to the maximum value.

2. Connect the rear panel as shown in Figure 7-4.
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(2) Setting measurement conditions

1. Set each panel for the Setup sub windows to the same conditions as shown in Table 7-5.

Table Table Table Table 7777----5555        Setting of Setup sub windowsSetting of Setup sub windowsSetting of Setup sub windowsSetting of Setup sub windows

PanelPanelPanelPanel Setting itemSetting itemSetting itemSetting item Setting valueSetting valueSetting valueSetting value
Setup Pattern Common Setting ON

Both PPG and ED unit pattern can
be set at once.

Frequency Reference INT
Frequency 2488320 kHz*

Clock I/F(ED) Polarity POS
Termination Set to the value conforming to the 3R

Receiver specifications.
Delay 0 ps

Data I/F(PPG) Output ON
Level VAR
Amplitude Set to the value conforming to the
Offset E/O receiver specifications.
Cross Points 50%

Data I/F(ED) Level VAR
Threshold Set to the value conforming to the 3R
Termination Receiver specifications.

Pattern Pattern Input/Output Repeat
Pattern PRBS15
Mark Ratio 1/2
Auto Sync ON
Internal Threshold Check

* To set, see the MP1632C 3.2G Digital Data Analyzer Operation Manual.

2. Set each panel for the Test Menu sub windows to the same conditions as shown in Table 7-6.

Table Table Table Table 7777----6666        Setting of Test Menu sub windowsSetting of Test Menu sub windowsSetting of Test Menu sub windowsSetting of Test Menu sub windows

PanelPanelPanelPanel Setting itemSetting itemSetting itemSetting item Setting valueSetting valueSetting valueSetting value
Measurement Test Item Error/Alarm

MEAS. Mode Repeat
Meas. Time 00:00:00:01 (1 sec.)

3. To display the error count and alarm, open ALL panel on the Result sub window and set it to
the same conditions as shown in Table 7-7.

Table Table Table Table 7777----7777        Setting of Result sub windowsSetting of Result sub windowsSetting of Result sub windowsSetting of Result sub windows

PanelPanelPanelPanel Setting itemSetting itemSetting itemSetting item Setting valueSetting valueSetting valueSetting value
ALL Display Current

Time display mode Elapsed
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4. Press Auto Search to open the Auto Search dialogue after setting the attenuation of Optical
Attenuator B in Figure 7-3 to 0 dB.  Set the dialogue box as shown in Table 7-8.

Table Table Table Table 7777----8888        Setting Auto Search Dialogue BoxSetting Auto Search Dialogue BoxSetting Auto Search Dialogue BoxSetting Auto Search Dialogue Box

---- Setting itemSetting itemSetting itemSetting item Setting valueSetting valueSetting valueSetting value
Auto Search Mode Phase & Threshold

PRBS Pattern Search OFF

Press Start on Auto Search to start it.

5. Measurement starts when the measurement start button is pressed.  Noise tolerance char-
acteristics of the 3R Receiver can be measured by adjusting the attenuation of Optical At-
tenuator A in Figure 7-3.
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7.3 Burst Signal Measurement

It is popular to use optical fiber circulating loop for testing long distance transmission.  In this
case, data signal is burst signal.  Pulse Pattern Generator unit can generate burst signals and
Error Detector unit can measure BER of input burst signal.

PG

Tunable BPF

EDFA

Fiber
SW1

SW2Data

LiNbO3
Modulator

Clock

Burst gate signal

Burst data

O/E

Burst signal measurement for fiber loop test
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CHAPTER 8  PERFORMANCE TEST
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8.1 Introduction

Performance tests are used to check the main function of the MU163220C 3.2G Pulse Pattern
Generator (hereafter called “the PPG unit”) and MU163240C 3.2G Error Detector (hereafter
called “the ED unit”), and verify that they meets specifications.  This chapter explain how to
execute the performance tests.  The test items of the performance tests are described bellow.

Tests for the PPG unitTests for the PPG unitTests for the PPG unitTests for the PPG unit
 Trigger output interface
 Clock output interface
 Data output interface
 Burst trigger output interface

Test for the ED unitTest for the ED unitTest for the ED unitTest for the ED unit
 Trigger output interface
 Clock counter

To test other functions, use self-test software.  The self-test tests systematically as combination
of internal synthesizer option and pulse pattern generator and error detector.  For detail of the
self-diagnosis, refer to "CHAPTER 9  SELF-TEST"

The performance tests requires a sampling oscilloscope and a frequency counter and a clock gen-
erator.  Required performance characteristics of each equipment is described bellow.

(Sampling oscilloscope)
Use an equipment that covers frequency band more than 20 GHz.

(Frequency counter)
Use an equipment whose range is from 10 kHz to 3.2 GHz, resolution is less than 1 kHz.

(Clock generator)
Use an equipment whose output level is +4 to +10 dBm/50Ω, frequency range is from 50 MHz
to 3.2 GHz, frequency accuracy is ±10 ppm or less.  OPT03 3.2G Internal synthesizer, the op-
tion of MP1632C is suitable.
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8.2 Test for MU163220C 3.2G Pulse Pattern Generator

8.2.1 Trigger output interface

This section describes how to test the waveform of trigger signal from the PPG unit with the os-
cilloscope.  Fig. 8-1 shows how to connect each equipment.

Front panel

Rear panel

3.2G internal synthesizer
(3)

MU163220A 3.2G PPG
Output

Data

50Ω !

Clock

50Ω !

Data

50Ω !

Clock

50Ω !

Burst Trigger
   Output

0/-1V 50Ω

!

Trigger Output

0/-1V 50Ω

!

MU163220A 3.2G Pulse Pattern Generator

Clock

Input

0.5/2.0vp-p 50Ω

!

EXT Error

 Input

0/-1V 50Ω

!

EXT Burst
 Trigger
  Input

0/-1V 50Ω

!

Option-03 3.2G Internal Synthesizer

Clock(0.01-3.2GHz)
     Output

1.0Vp-p 50Ω

!

Input

0.5-2.0Vp-p 50Ω

!

Output

1.0Vp-p 50Ω

!

Lock(10MHz)

Sampling oscilloscope

IN1 Trig

(1)

(2)
Power
Splitter
(-6dB)

(1)  Connect the Trigger Output to the signal input of the oscilloscope through a power
splitter.

(2)  Connect the Trigger Output to the trigger input of the oscilloscope through a power
splitter.

(3)  Connect the clock output of the internal synthesizer option to the Clock Input.

Fig. Fig. Fig. Fig. 8888----1111  Connection for trigger output test  Connection for trigger output test  Connection for trigger output test  Connection for trigger output test

1. Before starting test, disconnect all connectors.
2. To clear all settings, select Initialize from the File menu.
3. Set clock frequency from the clock generator 3.2 GHz.  In case the internal synthesizer op-

tion is used as clock generator, refer to MP1632C 3.2G Digital Data Analyzer operation man-
ual "6.13  Setting a Frequency".  In other case refer to its own operation manual.

Confirm that proper attenuator to input level of the sampling oscilloscope is used before
starting test.  There is risk of damage the equipment if sampling oscilloscope is con-
nected directly.

C

C

CAUTIONCAUTIONCAUTIONCAUTION
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4. To display waveform, connect all connectors according to Fig. 8-1.  Confirm that the level of

the waveform is in the range according to Fig. 8-2.

-1 V ±0.2 V

0 V ±0.2 V

Fig. Fig. Fig. Fig. 8888----2222  Specifications of Trigger output wav  Specifications of Trigger output wav  Specifications of Trigger output wav  Specifications of Trigger output waveeeeformformformform
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8.2.2 Clock output interface

This section describes how to test the waveform of clock from the PPG unit with the sampling
oscilloscope.  Fig. 8-3 shows how to connect each equipment.

 Specification
    Amplitude 0.5 to 2.0 Vp-p/10 mV step

            0.5 to 4.0 Vp-p/10 mV step (Equipped with OPT02)
Setting error Larger of bellow two values or less

 ±15% for the set value
 ±0.1 V

Uncertainty ±9.2 mV
Guard band 1.00

    Offset +2.000 to -3.500 V/5 mV step (Voh)
            +4.250 to -3.500 V/5 mV step (Voh)(Equipped with OPT02)

Setting error Larger of bellow three values pr less
 ±15% for the set value
 ±0.1 V
 or ±15% of the amplitude

Uncertainty ±9.2 mV
Guard band 1.00

Front panel

Rear panel

3.2G internal synthesizer
(3)

Sampling scilloscope

IN1 Trig

(1)

(2)
MU163220A 3.2G PPG

Output
Data

50Ω !

Clock

50Ω !

Data

50Ω !

Clock

50Ω !

Burst Trigger
   Output

0/-1V 50Ω

!

Trigger Output

0/-1V 50Ω

!

MU163220A 3.2G Pulse Pattern Generator

Clock

Input

0.5/2.0vp-p 50Ω

!

EXT Error

 Input

0/-1V 50Ω

!

EXT Burst
 Trigger
  Input

0/-1V 50Ω

!

Option-03 3.2G Internal Synthesizer

Clock(0.01-3.2GHz)
     Output

1.0Vp-p 50Ω

!

Input

0.5-2.0Vp-p 50Ω

!

Output

1.0Vp-p 50Ω

!

Lock(10MHz)

(1)  Connect the Trigger Output to the trigger input of the sampling oscilloscope.                           
(2)  Connect Clock or Clock Output to the signal input of the sampling oscilloscope.
(3)  Connect the clock output of the internal synthesizer option to the Clock Input.

Fig. Fig. Fig. Fig. 8888----3333  Connection for clock output test  Connection for clock output test  Connection for clock output test  Connection for clock output test

C

C
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(1) ECL level signal
 

1. Before starting test, disconnect all connectors.
2. To clear all settings, select Initialize from the File menu.
3. Set clock frequency from the clock generator 3.2 GHz.  In case the internal synthesizer

option is used as clock generator, refer to MP1632C 3.2G Digital Data Analyzer opera-
tion manual "6.13  Setting a Frequency".  In other case refer to its own operation
manual.                                      

4. Set output level of Clock and Clock output.  Select "ECL" from each Level drop-down
list box on the 'Setup: Clock I/F' panel of the PPG unit

Confirm that proper attenuator to input level of the sampling oscilloscope is used before
starting test.  There is risk of damage the equipment if sampling oscilloscope is con-
nected directly.

5. To display waveform, connect all connectors according to Fig. 8-3.  Confirm that the
level of both waveform is in the range according to Fig. 8-4 and rise/fall time is 80 ps or
less.

Tr Tr, Tf ≤80 ps

-1.7 V±0.255 V

-0.9 V±0.135 V

10%

90%

Tf

Fig. Fig. Fig. Fig. 8888----4444  Specifications of clock output wav  Specifications of clock output wav  Specifications of clock output wav  Specifications of clock output waveeeeform (ECL)form (ECL)form (ECL)form (ECL)
NoteNoteNoteNote
If MU163220C mounts OPT02, confirm that the rise/fall time is as following.
          Tr, Tf ≤120 ps

CAUTIONCAUTIONCAUTIONCAUTION
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(2) VAR level signal (Part 1)

1. Before starting test, disconnect all connectors.
2. To clear all settings, select Initialize from the File menu.
3. Set clock frequency from the clock generator 3.2 GHz.  In case the internal synthesizer

option is used as clock generator, refer to MP1632C 3.2G Digital Data Analyzer opera-
tion manual "6.13  Setting a Frequency".  In other case refer to its own operation
manual.                                       

4. Set output level of Clock and Clock output.  Make settings on the 'Setup: Clock I/F'
panel of the PPG unit same condition as described bellow.
 Delay spin box :  Enter -1.0 ns.
 Offset spin box :  Enter -3.000
 Offset drop-down list box :  Select "Voh"

Confirm that proper attenuator to input level of the sampling oscilloscope is used before
starting test.  There is risk of damage the equipment if sampling oscilloscope is con-
nected directly.

5. To display waveform, connect all connectors according to Fig. 8-3.  Confirm that the
level of both waveform is in the range shown as Fig. 8-5 and rise/fall time is 80 ps or less.

Tr Tr, Tf ≤80 ps

-4.000 V±0.6 V

-3.000 V±0.45 V

10%

90%

Tf

Fig. Fig. Fig. Fig. 8888----5555  Specifications of clock output wav  Specifications of clock output wav  Specifications of clock output wav  Specifications of clock output waveeeeform (VAR part1)form (VAR part1)form (VAR part1)form (VAR part1)
NoteNoteNoteNote
If MU163220C mounts OPT02, confirm that the rise/fall time is as following.
          Tr, Tf ≤120 ps

CAUTIONCAUTIONCAUTIONCAUTION
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(3) VAR level signal (Part 2)

1. Before starting test, disconnect all connectors.
2. To clear all settings, select Initialize from the File menu.
3. Set clock frequency from the clock generator 3.2 GHz.  In case the internal synthesizer

option is used as clock generator, refer to MP1632C 3.2G Digital Data Analyzer operation
manual "6.13 Setting a Frequency".  In other case refer to its own operation manual.

            
4. Set output level of Clock and Clock output.  Make settings on the 'Setup:Clock I/F' panel

of the PPG unit same condition as described bellow.
 Delay spin box :  Enter +1.0 ns.
 Offset spin box :  Enter +2.000
 Offset drop-down list box :  Select "Voh"

Confirm that proper attenuator to input level of the sampling oscilloscope is used before
starting test.  There is risk of damage the equipment if sampling oscilloscope is con-
nected directly.

5. To display waveform, connect all connectors according to Fig. 8-3.  Confirm that the
level of both waveform is in the range shown as Fig. 8-6 and rise/fall time is 80 ps or less.

Tr Tr, Tf ≤80 ps

1.000 V±0.15 V

2.000 V±0.3 V

10%

90%

Tf

Fig. Fig. Fig. Fig. 8888----6666  Specifications of clock output wav  Specifications of clock output wav  Specifications of clock output wav  Specifications of clock output waveeeeform (VAR part2)form (VAR part2)form (VAR part2)form (VAR part2)
NoteNoteNoteNote
If MU163220C mounts OPT02 , confirm that the rise/fall time is as following.
          Tr, Tf≤120 ps

CAUTIONCAUTIONCAUTIONCAUTION
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(4) VAR level signal (Part 3)

1. Before starting test, disconnect all connectors.
2. To clear all settings, select Initialize from the File menu.
3. Set clock frequency from the clock generator 3.2 GHz.  In case the internal synthesizer

option is used as clock generator, refer to MP1632C 3.2G Digital Data Analyzer operation
manual "6.13  Setting a Frequency".  In other case refer to its own operation manual.

            
4. Set output level of Clock and Clock output.  Make settings on the 'Setup: Clock I/F'

panel of the PPG unit same condition as described bellow.
 Delay spin box : Enter +1.0 ns.
 Offset spin box : Enter +4.250
 Offset drop-down list box : Select "Voh"

Confirm that proper attenuator to input level of the sampling oscilloscope is used before
starting test.  There is risk of damage the equipment if sampling oscilloscope is con-
nected directly.

5. To display waveform, connect all connectors according to Fig. 8-3.  Confirm that the
level of both waveform is in the range shown as Fig. 8-7 and rise/fall time is 120 ps or
less.

Tr Tr, Tf ≤120 ps

3.250 V±0.49 V

4.250 V±0.64 V

10%

90%

Tf

Fig. Fig. Fig. Fig. 8888-7  Specifications of clock output wav-7  Specifications of clock output wav-7  Specifications of clock output wav-7  Specifications of clock output waveeeeform (VAR part3)form (VAR part3)form (VAR part3)form (VAR part3)

CAUTIONCAUTIONCAUTIONCAUTION
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8.2.3 Data output interface

This section explains how to test the waveform of data signal from the PPG unit with the sam-
pling oscilloscope.  Fig. 8-8 shows how to connect each equipment.

 Specification
    Amplitude 0.5 to 2.0 Vp-p/10 mV step

              0.5 to 4.0 Vp-p/10 mV step (Equipped with OPT01)
Setting error Larger of bellow two values or less

 ±15% for the set value
 ±0.1 V

Uncertainty ±9.2 mV
Guard band 1.00

    Offset +2.000 to -3.500 V/5 mV step (Voh)
            +4.250 to -3.500 V/5 mV step (Voh)(Equipped with OPT01)

Setting error Larger of bellow three values pr less
 ±15% for the set value
 ±0.1 V
 or ±15% of the amplitude

Uncertainty ±9.2 mV
Guard band 1.00

Front panel

Rear panel

3.2G internal synthesizer
(3)

Sampling oscilloscope

IN1 Trig

(1)

(2)
MU163220A 3.2G PPG

Output
Data

50Ω !

Clock

50Ω !

Data

50Ω !

Clock

50Ω !

Burst Trigger
    Output

0/-1V 50Ω

!

Trigger Output

0/-1V 50Ω

!

MU163220A 3.2G Pulse Pattern Generator

Clock

Input

0.5/2.0vp-p 50Ω

!

EXT Error

 Input

0/-1V 50Ω

!

EXT Burst
 Trigger
  Input

0/-1V 50Ω

!

Option-03 3.2G Internal Synthesizer

Clock(0.01-3.2GHz)
     Output

1.0Vp-p 50Ω

!

Input

0.5-2.0Vp-p 50Ω

!

Output

1.0Vp-p 50Ω

!

Lock(10MHz)

(1)  Connect the Trigger Output to the trigger input of the sampling oscilloscope.                             
(2)  Connect Data or Data Output to the signal input of the sampling oscilloscope.
(3)  Connect the clock output of the internal synthesizer option to the Clock Input.

Fig. Fig. Fig. Fig. 8888-8  Connection for data output test-8  Connection for data output test-8  Connection for data output test-8  Connection for data output test

C

C
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(1) ECL level signal

1. Before starting test, disconnect all connectors.
2. To clear all settings, select Initialize from the File menu.
3. Set clock frequency from the clock generator 3.2 GHz.  In case the internal synthesizer

option is used as clock generator, refer to MP1632C 3.2G Digital Data Analyzer opera-
tion manual "6.13  Setting a Frequency".  In other case refer to its own operation man-
ual.

                                    
4. Set output level of Data and Data output.  Select "ECL" from each Level drop-down list

box on the 'Setup: Data I/F' panel of PPG unit

Confirm that proper attenuator to input level of the sampling oscilloscope is used before
starting test.  There is risk of damage the equipment if sampling oscilloscope is con-
nected directly.

5. To display waveform, connect all connectors according to Fig. 8-8.  Confirm that the
level of both waveform is in the range shown as Fig. 8-9 and rise/fall time is 80 ps or less.

Tr Tr, Tf ≤80 ps

-1.7 V±0.255 V

-0.9 V±0.135 V

10%

90%

Tf

Fig. Fig. Fig. Fig. 8888-9  Specifications of data output wav-9  Specifications of data output wav-9  Specifications of data output wav-9  Specifications of data output waveeeeform (ECL)form (ECL)form (ECL)form (ECL)
NoteNoteNoteNote
If MU163220C mounts OPT02, confirm that the rise/fall time is as following.
          Tr, Tf ≤120 ps

CAUTIONCAUTIONCAUTIONCAUTION
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(2) VAR level signal (Part 1)

1. Before starting test, disconnect all connectors.
2. To clear all settings, select Initialize from the File menu.
3. Set clock frequency from the clock generator 3.2 GHz.  In case the internal synthesizer

option is used as clock generator, refer to MP1632C 3.2G Digital Data Analyzer operation
manual "6.13  Setting a Frequency".  In other case refer to its own operation manual.

                                  
4. Set output level of Data and Data output.  Make settings on the 'Setup: Data I/F' panel

of PPG unit same condition as described bellow.
 Offset spin box :  Enter -3.000
 Offset drop-down list box :  Select "Voh"

Confirm that proper attenuator to input level of the sampling oscilloscope is used before
starting test.  There is risk of damage the equipment if sampling oscilloscope is con-
nected directly.

5. To display waveform, connect all connectors according to Fig. 8-8.  Confirm that the
level of both waveform is in the range shown as Fig. 8-10 and rise/fall time is 80 ps or
less.

Tr Tr, Tf ≤80 ps

-4.000 V±0.6 V

-3.000 V±0.45 V

10%

90%

Tf

Fig. Fig. Fig. Fig. 8888-10  Specifications of data output wav-10  Specifications of data output wav-10  Specifications of data output wav-10  Specifications of data output waveeeeform (VAR part1)form (VAR part1)form (VAR part1)form (VAR part1)
NoteNoteNoteNote
If MU163220C mounts OPT02, confirm that the rise/fall time is as following.
          Tr, Tf ≤120 ps

CAUTIONCAUTIONCAUTIONCAUTION
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(3) VAR level signal (Part 2)

1. Before starting test, disconnect all connectors.
2. To clear all settings, select Initialize from the File menu.
3. Set clock frequency from the clock generator 3.2 GHz.  In case the internal synthesizer

option is used as clock generator, refer to MP1632C 3.2G Digital Data Analyzer operation
manual "6.13  Setting a Frequency".  In other case refer to its own operation manual.

                                   
4. Set output level of Data and Data output.  Make settings on the 'Setup: Data I/F' panel

of PPG unit same condition as described bellow.
 Offset spin box : Enter +2.000
 Offset drop-down list box : Select "Voh"

Confirm that proper attenuator to input level of the sampling oscilloscope is used before
starting test.  There is risk of damage the equipment if sampling oscilloscope is con-
nected directly.

5. To display waveform, connect all connectors according to Fig. 8-8.  Confirm that the
level of both waveform is in the range shown as Fig. 8-11 and rise/fall time is 80 ps or
less.

Tr Tr, Tf ≤80 ps

1.000 V±0.15 V

2.000 V±0.3 V

10%

90%

Tf

Fig. Fig. Fig. Fig. 8888-11  Specifications of data output wav-11  Specifications of data output wav-11  Specifications of data output wav-11  Specifications of data output waveeeeform (VAR part2)form (VAR part2)form (VAR part2)form (VAR part2)
NoteNoteNoteNote
If MU163220C mounts OPT02, confirm that the rise/fall time is as following.
          Tr, Tf ≤120 ps

CAUTIONCAUTIONCAUTIONCAUTION
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(4) VAR level signal (Part 3)

1. Before starting test, disconnect all connectors.
2. To clear all settings, select Initialize from the File menu.
3. Set clock frequency from the clock generator 3.2 GHz.  In case the internal synthesizer

option is used as clock generator, refer to MP1632C 3.2G Digital Data Analyzer operation
manual "6.13  Setting a Frequency".  In other case refer to its own operation manual.

                                   
4. Set output level of Data and Data output.  Make settings on the 'Setup: Data I/F' panel

of PPG unit same condition as described bellow.
 Offset spin box :  Enter +4.250
 Offset drop-down list box :  Select "Voh"

Confirm that proper attenuator to input level of the sampling oscilloscope is used before
starting test.  There is risk of damage the equipment if sampling oscilloscope is con-
nected directly.

5. To display waveform, connect all connectors according to Fig. 8-8.  Confirm that the
level of both waveform is in the range shown as Fig. 8-12 and rise/fall time is 120 ps or
less.

Tr Tr, Tf ≤120 ps

3.250 V±0.49 V

4.250 V±0.64 V

10%

90%

Tf

Fig. Fig. Fig. Fig. 8888-12  Specifications of data output wav-12  Specifications of data output wav-12  Specifications of data output wav-12  Specifications of data output waveeeeform (VAR part3)form (VAR part3)form (VAR part3)form (VAR part3)

CAUTIONCAUTIONCAUTIONCAUTION
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8.2.4 Burst trigger output interface

This section explains how to test the waveform of burst trigger signal from the PPG unit with the
oscilloscope.  Fig. 8-13  shows how to connect each equipment

Front panel

Rear panel

3.2G internal synthesizer
(2)

 oscilloscope

IN1

(1)

Option-03 3.2G Internal Synthesizer

Clock(0.01-3.2GHz)
     Output

1.0Vp-p 50Ω

!

Input

0.5-2.0Vp-p 50Ω

!

Output

1.0Vp-p 50Ω

!

Lock(10MHz)

MU163220A 3.2G PPG
Output

Data

50Ω !

Clock

50Ω !

Data

50Ω !

Clock

50Ω !

Burst Trigger
   Output

0/-1V 50Ω

!

Trigger Output

0/-1V 50Ω

!

MU163220A 3.2G Pulse Pattern Generator

Clock

Input

0.5/2.0vp-p 50Ω

!

EXT Error

 Input

0/-1V 50Ω

!

EXT Burst
 Trigger
  Input

0/-1V 50Ω

!

(1)  Connect the Trigger Output to the trigger input of the oscilloscope.
(2)  Connect the clock output of the internal synthesizer option to the Clock Input.

Fig. Fig. Fig. Fig. 8888-13  Connection for burst trigger output test-13  Connection for burst trigger output test-13  Connection for burst trigger output test-13  Connection for burst trigger output test

1. Before starting test, disconnect all connectors.
2. To clear all settings, select Initialize from the File menu.

                                
3. Set output level of Data and Data output.  Select "ECL" from each Level drop-down list box

on the 'Setup: Data I/F' panel of the PPG unit
4. Set the pattern output mode burst by selecting "Burst" from the Pattern Output drop-down

list box on the 'Setup: Pattern' panel of the PPG unit.

Confirm that proper attenuator to input level of the oscilloscope is used before starting
test.  There is risk of damage the equipment if oscilloscope is connected directly.

 
5. To display waveform, connect all connectors according to Fig. 8-13.  Confirm that the level of

both waveform is in the range shown as Fig. 8-14.

C

C

CAUTIONCAUTIONCAUTIONCAUTION
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-1.0 V±0.2 V

0.0 ±0.2 V

Pattern length

Fig. Fig. Fig. Fig. 8888-14  Specifications of burst trigger output waveform-14  Specifications of burst trigger output waveform-14  Specifications of burst trigger output waveform-14  Specifications of burst trigger output waveform
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8.3 Test for MU163240C 3.2G Error Detector

8.3.1 Trigger output interface

This section explains how to test the waveform of trigger signal from the ED unit with the sam-
pling oscilloscope.  Fig. 8-15 shows how to connect each equipment.

Front panel

3.2G internal synthesizer
(3)

Input

Data

0.5-4.0Vp-p 50Ω

!

Burst Trigger
    Input

0/-1V 50Ω

!

Trigger Output

0/-1V 50Ω

!

GND

PECL

ECL

TERM

Clock

0.5-4.0Vp-p 50Ω

!

GND

PECL

ECL

TERM
Error
Monitor

MU163240A 3.2G ED

Option-03 3.2G Internal Synthesizer

Clock(0.01-3.2GHz)
     Output

1.0Vp-p 50Ω

!

Input

0.5-2.0Vp-p 50Ω

!

Output

1.0Vp-p 50Ω

!

Lock(10MHz)

Sampling oscilloscope

IN1 Trig

(1)

(2)
Power
Splitter
(-6dB)

(1)  Connect the Trigger Output to the signal input of the sampling oscilloscope through a
power splitter.

(2)  Connect the Trigger Output to the trigger input of the sampling oscilloscope through
a power splitter.

(3)  Connect the clock output of the internal synthesizer option to the Clock Input.

Fig. Fig. Fig. Fig. 8888-15  Connection for trigger output test-15  Connection for trigger output test-15  Connection for trigger output test-15  Connection for trigger output test

1. Before starting test, disconnect all connectors.
2. To clear all settings, select Initialize from the File menu.
3. Set clock frequency from the clock generator 3.2 GHz.  In case the internal synthesizer op-

tion is used as clock generator, refer to the MP1632C 3.2G Digital Data Analyzer operation
manual "6.13  Setting a Frequency".  In other case refer to its own operation manual.

Confirm that proper attenuator to input level of the sampling oscilloscope is used before
starting test.  There is risk of damage the equipment if sampling oscilloscope is con-
nected directly.

C

CAUTIONCAUTIONCAUTIONCAUTION
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4. To display waveform, connect all connectors according to Fig. 8-15.  Confirm that the level of

the waveform is in the range shown as Fig. 8-16.

-1 V±0.2 V

0 V±0.2 V

Fig. Fig. Fig. Fig. 8888-16  Specifications of Trigger output wav-16  Specifications of Trigger output wav-16  Specifications of Trigger output wav-16  Specifications of Trigger output waveeeeformformformform
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8.3.2 Clock counter

This section explains how to test whether the clock counter works normally.  Fig. 8-17 shows
connections for this test.

 Specification
Frequency accuracy ±10 ppm ±1 kHz
Uncertainty ±2.31 ppm
Guard band 1.00

Front panel

3.2G internal synthesizer
(1)

Input

Data

0.5-4.0Vp-p 50Ω

!

Burst Trigger
    Input

0/-1V 50Ω

!

Trigger Output

0/-1V 50Ω

!

GND

PECL

ECL

TERM

Clock

0.5-4.0Vp-p 50Ω

!

GND

PECL

ECL

TERM
Error
Monitor

MU163240A 3.2G ED

Option-03 3.2G Internal Synthesizer

Clock(0.01-3.2GHz)
     Output

1.0Vp-p 50Ω

!

Input

0.5-2.0Vp-p 50Ω

!

Output

1.0Vp-p 50Ω

!

Lock(10MHz)

(1)  Connect the clock output of the internal synthesizer to the Clock input.
Fig. Fig. Fig. Fig. 8888-17  Connection for clock counter test-17  Connection for clock counter test-17  Connection for clock counter test-17  Connection for clock counter test

1. To clear all settings, select Initialize from the File menu.
2. Set clock frequency of the clock generator 3.2 GHz.  In case the internal synthesizer option

is used as clock generator, refer to the MP1632C 3.2G Digital Data Analyzer operation man-
ual "6.13  Setting a Frequency".  In other case refer to its own operation manual.

3. Open the ‘Setup:Pattern’ panel and turn Off the Auto Sync.  Refer to “5.5.2 Synchronizing
with the receive pattern.”

4. Open the 'Result: All' panel and start error/alarm measurement there.
5. Confirm that the measured frequency ranges 3.2 GHz ±33 kHz.
6. In a similar way, confirm that the measured frequency ranges 50 MHz ±1500 Hz after set

clock frequency from the clock generator 50 MHz.

C
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CHAPTER 9  SELF-TEST
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9.1 What is Self-Test?

MP1632C Digital Data Analyzer has self-test function to determine whether instruments operate
normally.  The self-test performs the diagnosis below that do not require peripheral equipment.
Hereafter MU163220C 3.2G Pulse Pattern Generator is called "the PPG" and MU163240C 3.2G
Error Detector is called "the ED" simply.

1. Clock loss detection and recovery test
Tests whether the instrument detects clock loss alarm when it occurs, and whether the in-
strument erroneously detects clock loss alarm when no alarm occurs.

2. SYNC loss detection and recovery test
Tests whether the instrument detects SYNC loss alarm when it occurs, and whether the in-
strument erroneously detects SYNC loss alarm when no alarm occurs.

3. Input-output interface test
Tests whether the data output level of the PPG and data input threshold of the ED are nor-
mal.

4. PRBS mark ratio switching test
Tests whether the PPG outputs the set mark ratio and bit shift of PRBS, whether the ED
normally measures the pattern.

5. DC Impedance switching test
Tests whether the DC impedance switches normally.

6. Frequency accuracy test
Tests whether the OPT-03 3.2G Internal Synthesizer normally outputs the set frequency and
the ED normally measures a frequency.

7. PRBS steps switching test
Tests whether the PPG outputs PRBS pattern of the set steps, whether the ED normally
measures the pattern.

8. PDH/SDH frequency test
Tests whether OPT-03 3.2G Internal Synthesizer and the ED operate normally at PDH/SDH
frequency.

9. Error addition and measurement test
Tests whether the PPG adds errors and the ED measures them normally.

10. PRBS Synchronous determination test
Tests whether the synchronous determination circuit of the ED operates normally when pat-
tern type is PRBS.

11. Burst measurement test
Tests whether the ED measures burst signal from the PPG normally.

12. Zero-Subst Normal Synchronous determination test
Tests whether the synchronous determination circuit of the ED operates normally when pat-
tern type is Zero-Subst.
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13. Maximum length PRGM pattern test
Tests whether the PPG and the ED operate normally when their pattern type is PRGM whose
length is maximum.

14. PRGM logic inversion test
Tests whether logic inversion operates normally when pattern type is PRGM whose length is
maximum.

15. PRGM Frame Synchronous determination test
Tests whether the synchronous determination circuit of the ED operates normally when pat-
tern type is Zero-Subst and Frame is selected as synchronization method.

16. INS error counter test
Tests whether the ED detects errors which are added by the PPG as insertion error.

17. OMI error counter test
Tests whether the ED detects errors which are added by the PPG as omission error.

18. Clock delay test
Tests whether the clock delay circuit of the PPG and the ED operates normally.

NoteNoteNoteNote
The self-test function is limited for use as follows:
The self-test function is available only when the MU163220C 3.2G Pulse Pattern Gen-
erator and the MU163240C 3.2G Error Detector are inserted in the MP1632C Digital
Data Analyzer.  Those units may be mounted in either of slot 3 and slot 4.
It is not available when the MP1632C Digital Data Analyzer control software is in prog-
ress.  In this case, be sure to exit the control software before executing the self-test pro-
gram.
Confirm that the System Mode of the previously terminated application is not Power
Fail, before executing the self-test program.
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9.2 Connecting Instruments

This section describes how to connect signals between units used before executing the self-test
function.
The following paragraphs show how to connect signals of each unit.

 Connecting signals of the 3.2G Internal Synthesizer option

Fig. 9-1 shows the rear view of the 3.2G Internal Synthesizer and its connection.

Option-03 3.2G Internal Synthesizer

Clock(0.01-3.2GHz)
     Output

1.0Vp-p 50Ω

!

Input

0.5-2.0Vp-p 50Ω

!

Output

1.0Vp-p 50Ω

!

Lock(10MHz)

(1)
Fig. Fig. Fig. Fig. 9999----1111  Rear view of internal synth  Rear view of internal synth  Rear view of internal synth  Rear view of internal syntheeeesizersizersizersizer

(1) Clock Output

Connect this Clock Output to the Clock Input on the MU163220C rear panel.
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 Connecting signals of the MU163220C 3.2G Pulse Pattern Generator

Fig. 9-2 and Fig. 9-3 show the front and rear view of the MU163220C 3.2G Pulse Pattern Genera-
tor and its connection.

MU163220A 3.2G PPG
Output

Data

50Ω !

Clock

50Ω !

Data

50Ω !

Clock

50Ω !

Burst Trigger
   Output

0/-1V 50Ω

!

Trigger Output

0/-1V 50Ω

!

(1)

(2)

(3)

Fig. Fig. Fig. Fig. 9999----2222  Front view of MP163220A  Front view of MP163220A  Front view of MP163220A  Front view of MP163220A
        
(1) Data Output

Connect this to the Data Input on the front panel of the MU163240C 3.2G Error Detector.
        
(2) Clock Output

Connect this to the Clock Input on front panel of the MU163240C 3.2G Error Detector.

(3) Burst Trigger Output

Connect this to the Burst Trigger Input on the front panel of the MU163240C 3.2G Error
Detector.

MU163220A 3.2G Pulse Pattern Generator

Clock

Input

0.5/2.0vp-p 50Ω

!

EXT Error

 Input

0/-1V 50Ω

!

EXT Burst
 Trigger
  Input

0/-1V 50Ω

!

(4)

Fig. Fig. Fig. Fig. 9999----3333  Rear view of MP163220A  Rear view of MP163220A  Rear view of MP163220A  Rear view of MP163220A

(4) Clock Input

Connect this to the Clock Output on the rear panel of the 3.2G internal synthesizer.

C

C
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 Connecting signals of the MU163240C 3.2G Error Detector

Fig. 9-4 shows the front view of the MU163240C 3.2G Error Detector and its connection.

Input

Data

0.5-4.0Vp-p 50Ω

!

Burst Trigger
    Input

0/-1V 50Ω

!

Trigger Output

0/-1V 50Ω

!

GND

PECL

ECL

TERM

Clock

0.5-4.0Vp-p 50Ω

!

GND

PECL

ECL

TERM
Error
Monitor

MU163240A 3.2G ED

(1) (2)

(3)

Fig. Fig. Fig. Fig. 9999----4444  Front view of MP163240A  Front view of MP163240A  Front view of MP163240A  Front view of MP163240A

(1) Data Input
                         

Connect this to the Data Output on the front panel of the MU163220C 3.2G Pulse Pattern
Generator.

(2) Clock Input
                          

Connect this to the Clock Output on the front panel of the MU163220C 3.2G Pulse Pattern
Generator.

(3) Burst Trigger Input

Connect this to the Burst Trigger Output on the front panel of the MU163220C 3.2G Pulse
Pattern Generator.

C
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9.3 Basic Operation

The self-test consists of the following four types of panels:

1) System panel
Displays the current state of the MP1632C.

2) Connection panel
Displays a connection diagram referenced to connect terminals on the front and rear of each
unit depending on the current set state and device state.

3) Setup panel
Used to select the contents to be executed by the self-test program.

4) Result panel
Displays the self-test execution result.

The self-test is executed in the procedure below.

NoteNoteNoteNote
The self-test is not available when the MP1632C control software is in progress.
To execute the self-test, exit the MP1632C control software.

The self-test is registered in the MP1632C Digital Data Analyzer group.

C

C
 C

Fig. Fig. Fig. Fig. 9999----5555  MP1632C Digital Data Analyzer group  MP1632C Digital Data Analyzer group  MP1632C Digital Data Analyzer group  MP1632C Digital Data Analyzer group

The self-test is registered with icon name "SELF TEST".  Use this icon to start the self-test.  For
details on the screen operation and functions, see the subsequent chapters.

Quit the MP1632C control software

Make connection each connector

Display the result

If you want to cancel the diagnosis press the Abort button

Start the diagnosis on the Result panel

Select diagnosis item on the Setup panel
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9.4 Detail Operation

This section describes how to operate the self-test screens.

9.4.1 Master window

Fig. 9-6 shows the MP1632C Selftest master window.

C

C

C

Fig. Fig. Fig. Fig. 9999----6666  Master window screen  Master window screen  Master window screen  Master window screen

Menu configuration
 File pull-down menu

Save Saves the self-test result in the text format.  Invalid when
the result does not exist.

Print Outputs the self-test result to an external printer.  Invalid
when the result does not exist.

Printer Setup Sets an external printer.
Exit Exits the self-test program.

 Help pull-down menu
About MP1632C Selftest   Displays self-test version information.
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9.4.2 System panel

Fig. 9-7 shows the System panel
C

C

C

Fig. Fig. Fig. Fig. 9999----7777  System panel  System panel  System panel  System panel

(1) Main Frame
Displays the supported main fame version, and supported options by pressing the Option
button.

(2) Slot1
Displays the name and supported version of main frame option inserted into slot1.

(3) Slot2
Displays the name and supported version of unit inserted into the slot2.

(4) Slot3
Displays the name and supported version of unit inserted into the slot3.

(5) Slot4
Displays the name and supported version of unit inserted into the slot4.

(6) Software Version
Displays the version of the self-test software.
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9.4.3 Connection panel

This panel displays connection of each unit.  Make connection in accordance with this panel.

C

C

C

C

C

Fig. Fig. Fig. Fig. 9999----8888  Connection panel  Connection panel  Connection panel  Connection panel

(1) Front View
Display connection of the front panels

(2) Rear View
Display connection of the rear panels

(3) Attentions
Display messages to pay attentions.
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9.4.4 Setup panel

This panel permits you to select diagnosis items.  Whole diagnosis are classified into five groups.
Mark the check boxes of groups you want to perform.

C

Fig. Fig. Fig. Fig. 9999----9999  Setup panel  Setup panel  Setup panel  Setup panel

(1)  Clock Loss/Sync Loss/Threshold&Margin/Mark Ratio/DC Impedance Test
This group includes 1, 2, 3, 4, 5 numbered at page 172.

(2)  PLL Unlock&Frequency/PRBS Pattern/PDH/SDH Frequency Test
This group includes 6, 7, 8 numbered at page 172.

(3)  Total Error Addition/PRBS Sync Threshold/PRBS Burst Test
This group includes 9, 10, 11 numbered at page 172.

(4)  Zero-Subst Sync Threshold/PRGM Sync Threshold/PRGM Burst Test
This group includes 12, 13, 14, 15 numbered at page 172 and 131.

(5)  INS/OMI Error Addition/Clock Delay Test
This group includes 16, 17, 18 numbered at page 131.

NoteNoteNoteNote
It takes about an hour until all 5 diagnosis are performed.
During diagnosis (1), an exchange of cable connection is required twice.  Please follow
the display’s instruction.  The first time is about 2 minutes later and the second is 10
minutes later after starting of the diagnosis.
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9.4.5 Result panel

The Result panel displays start date, elapsed time, and results.

C

Fig. Fig. Fig. Fig. 9999----10101010  Result panel  Result panel  Result panel  Result panel

(1) Start Time
Displays start time.

(2) Elapsed
Displays elapsed time.

(3) Display Data
ALL List Displays all result.
Error List Displays only item which detects something trouble.

(4) Result display area
The results is displayed here.  Its format is described below.
  Test Code No. Diagnosis item number.
  Result Passed or Failed.
  Message Content of current diagnosis

(5) Start
Starts the self-test

NoteNoteNoteNote
Don't start any other applications during the self-test is running.
Some diagnosises are depend on if previous diagnosis passes or not.  If a diagnosis fails
and it disable following diagnosis's, the self-test is canceled immediately in such a case.
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9.4.6 Details of self-test

This section describes the details of self-test.
                                                    (       : Equipped with OPT01)

Table Table Table Table 9999----1111  Clock Loss/Sync Loss/Threshold&Margin/Mark Ratio/DC Impedance Test (1/  Clock Loss/Sync Loss/Threshold&Margin/Mark Ratio/DC Impedance Test (1/  Clock Loss/Sync Loss/Threshold&Margin/Mark Ratio/DC Impedance Test (1/  Clock Loss/Sync Loss/Threshold&Margin/Mark Ratio/DC Impedance Test (1/8888))))

Item No.Item No.Item No.Item No. Diagnosis contentsDiagnosis contentsDiagnosis contentsDiagnosis contents

01-01-01 Tests whether the instrument detects clock loss occurrence when the Clock  output is
set into "OFF".

01-01-02 Tests whether the instrument detects clock loss recovery when the Clock  output is
set into "ON".

01-02-01 Tests whether the instrument detects clock loss occurrence when the Clock output is
set into "OFF".

01-02-02 Tests whether the instrument detects clock loss recovery when the Clock output is set
into "ON".

02-01-01 Tests whether the instrument detects SYNC loss occurrence when the Data  output
is set into "OFF".

02-01-02 Tests whether the instrument detects SYNC loss recovery when the Data  output is
set into "ON".

02-02-01 Tests whether the data threshold of the ED ranges -1.300 V ±0.13 V when the level of
the PPG Data  output has been set into "ECL" and auto search has been performed.

02-02-02 Under 02-02-01 state, tests whether threshold margin is 640 mVp-p or more.

02-02-03 Under 02-02-01 state, performs error/alarm measurement and tests whether it is
error free.

02-02-04
Tests whether the data threshold of the ED ranges -1.000 V ±0.1 V when the level of
the PPG Data  output has been set into "VAR" (the amplitude is 2.0 V, the offset is -
1.0 Vth) and auto search has been performed.
Tests whether the data threshold of the ED ranges -2.000 V ±0.3 V when the level of
the PPG Data  output has been set into "VAR" (the amplitude is 4.0 V, the offset is -
2.0 Vth) and auto search has been performed.

02-02-05 Under 02-02-04 state, tests whether threshold margin is 1600 mVp-p or more.
Under 02-02-04 state, tests whether threshold margin is 2000 mVp-p or more.

02-02-06 Under 02-02-04 state, performs error/alarm measurement and tests whether it is
error free.

02-02-07
Tests whether the data threshold of the ED ranges +1.000 V ±0.1 V when the level of
the PPG Data  output has been set into "VAR" (the amplitude is 2.0 V, the offset is
+1.0 Vth) and auto search has been performed.
Tests whether the data threshold of the ED ranges +2.000 V ±0.3 V when the level of
the PPG Data  output has been set into "VAR" (the amplitude is 4.0 V, the offset is
+2.0 Vth) and auto search has been performed.

02-02-08 Under 02-02-07 state, tests whether threshold margin is 1600 mVp-p or more.
Under 02-02-07 state, tests whether threshold margin is 2000 mVp-p or more.

02-02-09 Under 02-02-07 state, performs error/alarm measurement and tests whether it is
error free.



184

Table 9-1  Clock Loss/Sync Loss/Threshold&Margin/Mark Ratio/DC Impedance Test (2/Table 9-1  Clock Loss/Sync Loss/Threshold&Margin/Mark Ratio/DC Impedance Test (2/Table 9-1  Clock Loss/Sync Loss/Threshold&Margin/Mark Ratio/DC Impedance Test (2/Table 9-1  Clock Loss/Sync Loss/Threshold&Margin/Mark Ratio/DC Impedance Test (2/8888))))

Item No.Item No.Item No.Item No. Diagnosis contentsDiagnosis contentsDiagnosis contentsDiagnosis contents

02-02-10
Tests whether the data threshold of the ED ranges -3.000 V ±0.3 V when the level of
the PPG Data output has been set into "VAR" (the amplitude is 2.0 V, the offset is -
3.0 Vth), and auto search has been performed.
Tests whether the data threshold of the ED ranges 0.000 V ±0.0 V when the level of
the PPG Data  output has been set into "VAR" (the amplitude is 4.0 V, the offset is
-0.0 Vth), and auto search has been performed.

02-02-11 Under 02-02-10 state, tests whether threshold margin is 1600 mVp-p or more.
Under 02-02-10 state, tests whether threshold margin is 2000 mVp-p or more.

02-02-12 Under 02-02-10 state, performs error/alarm measurement and tests whether it is
error free.

02-02-13 After PPG’s Data  output is set “TTL” and Auto search is performed, confirm the
ED’s Data Threshold is 2.00 V ±0.3 V.

02-02-14 Under 02-02-13 state, tests whether threshold margin is 2000 mVp-p or more.

02-02-15 Under 02-02-13 state, performs error/alarm measurement and tests whether it is
error free.

02-03-01

Tests whether the data threshold of the ED ranges -0.50 V ±0.1 V when settings of
PPG and ED have been set into bellow conditions, and auto search has been per-
formed.

Pattern type: PRBS15, Mark ratio: 1/2
Data  output of PPG: Amplitude 2.0 V and Offset -0.50 Vth

02-03-02 Under 02-03-01 state, tests whether threshold margin is 500 mVp-p or more.

02-03-03 Under 02-03-01 state, performs error/alarm measurement and tests whether it is
error free.

02-03-04

Tests whether the data threshold of the ED ranges -0.50 V ±0.1 V when the pattern
settings of the PPG and the ED have been set into bellow conditions and auto search
has been performed.

Pattern type: PRBS15   Mark ratio: 1/4   Bit shift: 1 bit
02-03-05 Under 02-03-04 state, tests whether threshold margin is 500 mVp-p or more.

02-03-06 Under 02-03-04 state, performs error/alarm measurement and tests whether it is
error free.

02-03-07

Tests whether the data threshold of the ED ranges -0.50 V ±0.1 V when the pattern
settings of the PPG and the ED have been set into bellow conditions and auto search
has been performed.
  Pattern type: PRBS15   Mark ratio: 1/4   Bit shift: 3 bit

02-03-08 Under 02-03-07 state, tests whether threshold margin is 500 mVp-p or more.

02-03-09 Under 02-03-07 state, performs error/alarm measurement and tests whether it is
error free.



185

Table 9-1  Clock Loss/Sync Loss/Threshold&Margin/Mark Ratio/DC Impedance Test (3/Table 9-1  Clock Loss/Sync Loss/Threshold&Margin/Mark Ratio/DC Impedance Test (3/Table 9-1  Clock Loss/Sync Loss/Threshold&Margin/Mark Ratio/DC Impedance Test (3/Table 9-1  Clock Loss/Sync Loss/Threshold&Margin/Mark Ratio/DC Impedance Test (3/8888))))

Item No.Item No.Item No.Item No. Diagnosis contentsDiagnosis contentsDiagnosis contentsDiagnosis contents

02-03-10

Tests whether the data threshold of the ED ranges -0.50 V ±0.1 V when the pattern
settings of the PPG and the ED have been set into bellow conditions and auto search
has been performed.
  Pattern type: PRBS15   Mark ratio: 1/8   Bit shift: 1 bit

02-03-11 Under 02-03-10 state, tests whether threshold margin is 1600 mVp-p or more.

02-03-12 Under 02-03-10 state, performs error/alarm measurement and tests whether it is
error free.

02-03-13

Tests whether the data threshold of the ED ranges -0.50 V ±0.1 V when the pattern
settings of the PPG and the ED have been set into bellow conditions and auto search
has been performed.
  Pattern type: PRBS15   Mark ratio: 1/8   Bit shift: 3 bit

02-03-14 Under 02-03-13 state, tests whether threshold margin is 500 mVp-p or more.

02-03-15 Under 02-03-13 state, performs error/alarm measurement and tests whether it is
error free.

02-03-16
Test whether it is error free when the pattern settings of the PPG and the ED into
bellow conditions and error/alarm measurement has been performed.
  Pattern type: PRBS15   Mark ratio: 0/8

02-03-17

Tests whether the data threshold of the ED ranges -0.50 V ±0.1 V when the pattern
settings of the PPG and the ED have been set into bellow conditions and auto search
has been performed.
  Pattern type: PRBS15   Mark ratio: 1/2

02-03-18 Under 02-03-17 state, tests whether threshold margin is 500 mVp-p or more.

02-03-19 Under 02-03-17 state, performs error/alarm measurement and tests whether it is
error free.

02-03-20

Tests whether the data threshold of the ED ranges -0.50 V ±0.1 V when the pattern
settings of the PPG and the ED have been set into bellow conditions and auto search
has been performed.
  Pattern type: PRBS15   Mark ratio: 3/4   Bit shift: 1 bit

02-03-21 Under 02-03-20 state, tests whether threshold margin is 500 mVp-p or more.

02-03-22 Under 02-03-20 state, performs error/alarm measurement and tests whether it is
error free.

02-03-23

Tests whether the data threshold of the ED ranges -0.50 V ±0.1 V when the pattern
settings of the PPG and the ED have been into bellow conditions and auto search
has been performed.
  Pattern type: PRBS15   Mark ratio: 3/4   Bit shift: 3 bit

02-03-24 Under 02-03-23 state, tests whether threshold margin is 500 mVp-p or more.

02-03-25 Under 02-03-23 state, performs error/alarm measurement and tests whether it is
error free.
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Table 9-1 Clock Loss/Sync Loss/Threshold&Margin/Mark Ratio/DC Impedance Test (4/Table 9-1 Clock Loss/Sync Loss/Threshold&Margin/Mark Ratio/DC Impedance Test (4/Table 9-1 Clock Loss/Sync Loss/Threshold&Margin/Mark Ratio/DC Impedance Test (4/Table 9-1 Clock Loss/Sync Loss/Threshold&Margin/Mark Ratio/DC Impedance Test (4/8888))))

Item No.Item No.Item No.Item No. Diagnosis contentsDiagnosis contentsDiagnosis contentsDiagnosis contents

02-03-26

Tests whether the data threshold of the ED ranges -0.50 V ±0.1 V when the pattern
settings of the PPG and the ED have been into bellow conditions and auto search
has been performed.

Pattern type: PRBS15   Mark ratio: 7/8   Bit shift: 1 bit
02-03-27 Under 02-03-26 state, tests whether threshold margin is 500 mVp-p or more.

02-03-28 Under 02-03-26 state, performs error/alarm measurement and tests whether it is
error free.

02-03-29

Tests whether the data threshold of the ED ranges -0.50 V ±0.1 V when the pattern
settings of the PPG and the ED have been into bellow conditions and auto search
has been performed.
  Pattern type: PRBS15   Mark ratio: 7/8   Bit shift: 3 bit

02-03-30 Under 02-03-29 state, tests whether threshold margin is 500 mVp-p or more.

02-03-31 Under 02-03-29 state, performs error/alarm measurement and tests whether it is
error free.

02-03-32
Tests whether it is error free when the pattern settings of the PPG and the ED have
been set into bellow conditions, and error/alarm measurement has been performed.
  Pattern type: PRBS15   Mark ratio: 8/8

02-04-01

Tests whether the data threshold of the ED ranges -1.000 ±0.1 V when the settings
have been set into bellow conditions, and auto search has been performed.

Pattern(PPG&ED): PRBS15, Mark Ratio 1/2
Data  interface    : Amplitude 2.0 V, Offset -1.0 Vth, DC Impedance 50Ω

Tests whether the data threshold of the ED ranges -2.000 ±0.1 V when the settings
have been set into bellow conditions, and auto search has been performed.

Pattern (PPG&ED): PRBS15, Mark Ratio 1/2
Data  interface     : Amplitude 4.0 V, Offset -2.0 Vth, DC Impedance 50Ω

02-04-02 Under 02-04-01 state, tests whether threshold margin is 1600 mVp-p or more.
Under 02-04-01 state, tests whether threshold margin is 2000 mVp-p or more.

02-04-03 Under 02-04-01 state, performs error/alarm measurement and tests whether it is
error free.

02-05-01 Tests whether the instrument detects SYNC loss occurrence when the Data output
is set into "OFF".

02-05-02 Tests whether the instrument detects SYNC loss recovery when the Data output is
set into "ON".

02-06-01
Tests whether the data threshold of the ED ranges -1.300 V ±0.13 V when the level
of the PPG Data output has been set into "ECL", and auto search has been per-
formed.

02-06-02 Under 02-06-01 state, tests whether threshold margin is 640 mVp-p or more.
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Table 9-1  Clock Loss/Sync Loss/Threshold&Margin/Mark Ratio/DC Impedance Test (5/Table 9-1  Clock Loss/Sync Loss/Threshold&Margin/Mark Ratio/DC Impedance Test (5/Table 9-1  Clock Loss/Sync Loss/Threshold&Margin/Mark Ratio/DC Impedance Test (5/Table 9-1  Clock Loss/Sync Loss/Threshold&Margin/Mark Ratio/DC Impedance Test (5/8888))))

Item No.Item No.Item No.Item No. Diagnosis contentsDiagnosis contentsDiagnosis contentsDiagnosis contents

02-06-03 Under 02-06-01 state, performs error/alarm measurement and tests whether it is
error free.

02-06-04
Tests whether the data threshold of the ED ranges -1.000 V ±0.1 V when the level of
the PPG Data output has been set into "VAR" (the amplitude is 2.0, the offset is -1.0
th), and auto search has been performed.
Tests whether the data threshold of the ED ranges -2.000 V ±0.3 V when the level of
the PPG Data output has been set into "VAR" (the amplitude is 4.0 V, the offset is -
3.0 Vth), and auto search has been performed.

02-06-05 Under 02-06-04 state, tests whether threshold margin is 1600 mVp-p or more.
Under 02-06-04 state, tests whether threshold margin is 2000 mVp-p or more.

02-06-06 Under 02-06-04 state, performs error/alarm measurement and tests whether it is
error free.

02-06-07
Tests whether the data threshold of the ED ranges +1.000 V ±0.1 V when the level of
the PPG Data output has been set into "VAR" (the amplitude is 2.0 V, the offset is
+1.0 Vth), and auto search has been performed.
Tests whether the data threshold of the ED ranges +2.000 V ±0.3 V when the level of
the PPG Data output has been set into "VAR" (the amplitude is 4.0 V, the offset is
+2.0 Vth), and auto search has been performed.

02-06-08 Under 02-06-07 state, tests whether threshold margin is 1600 mVp-p or more.
Under 02-06-07 state, tests whether threshold margin is 2000 mVp-p or more.

02-06-09 Under 02-06-07 state, performs error/alarm measurement and tests whether it is
error free.

02-06-10
Tests whether the data threshold of the ED ranges -3.000 V ±0.3 V when the level of
the PPG Data output has been set into "VAR" (the amplitude is 2.0 V, the offset is -
3.0 Vth), and auto search has been performed.
Tests whether the data threshold of the ED ranges -2.000 V ±0.3 V when the level of
the PPG Data output has been set into "VAR" (the amplitude is 4.0 V, the offset is -
2.0 Vth), and auto search has been performed.

02-06-11 Under 02-06-10 state, tests whether threshold margin is 1600 mVp-p or more.
Under 02-06-10 state, tests whether threshold margin is 2000 mVp-p or more.

02-06-12 Under 02-06-10 state, performs error/alarm measurement and tests whether it is
error free.

02-06-13 After PPG’s Data  output is set “TTL” and Auto search is performed, confirm the
ED’s Data Threshold is 2.00 V ±0.3 V.

02-06-14 Under 02-02-13 state, tests whether threshold margin is 2000 mVp-p or more.

02-06-15 Under 02-02-13 state, performs error/alarm measurement and tests whether it is
error free.
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Table 9-1  Clock Loss/Sync Loss/Threshold&Margin/Mark Ratio/DC Impedance Test (6/8)Table 9-1  Clock Loss/Sync Loss/Threshold&Margin/Mark Ratio/DC Impedance Test (6/8)Table 9-1  Clock Loss/Sync Loss/Threshold&Margin/Mark Ratio/DC Impedance Test (6/8)Table 9-1  Clock Loss/Sync Loss/Threshold&Margin/Mark Ratio/DC Impedance Test (6/8)

Item No.Item No.Item No.Item No. Diagnosis contentsDiagnosis contentsDiagnosis contentsDiagnosis contents

02-07-01

Tests whether the data threshold of the ED ranges -0.50 V ±0.1 V when settings of
PPG and ED have been set into bellow conditions and auto search has been per-
formed.

Pattern type: PRBS15, Mark ratio: 1/2
Data output of PPG: Amplitude 0.5 V and Offset -0.50 Vth

02-07-02 Under 02-07-01 state, tests whether threshold margin is 500 mVp-p or more.

02-07-03 Under 02-07-01 state, performs error/alarm measurement and tests whether it is
error free.

02-07-04

Tests whether the data threshold of the ED ranges -0.50 V ±0.1 V when the pattern
settings of the PPG and the ED have been set into bellow conditions and auto search
has been performed.
  Pattern type: PRBS15   Mark ratio: 1/4   Bit shift: 1 bit

02-07-05 Under 02-07-04 state, tests whether threshold margin is 500 mVp-p or more.

02-07-06 Under 02-07-04 state, performs error/alarm measurement and tests whether it is
error free.

02-07-07

Tests whether the data threshold of the ED ranges -0.50 V ±0.1 V when the pattern
settings of the PPG and the ED have been set into bellow conditions and auto search
has been performed.
  Pattern type: PRBS15   Mark ratio: 1/4   Bit shift: 3 bit

02-07-08 Under 02-07-07 state, tests whether threshold margin is 500 mVp-p or more.

02-07-09 Under 02-07-07 state, performs error/alarm measurement and tests whether it is
error free.

02-07-10

Tests whether the data threshold of the ED ranges -0.50 V ±0.1 V when the pattern
settings of the PPG and the ED have been set into bellow conditions and auto search
has been performed.
  Pattern type: PRBS15   Mark ratio: 1/8   Bit shift: 1 bit

02-07-11 Under 02-07-10 state, tests whether threshold margin is 500 mVp-p or more.

02-07-12 Under 02-07-10 state, performs error/alarm measurement and tests whether it is
error free.

02-07-13

Tests whether the data threshold of the ED ranges -0.50 V ±0.1 V when the pattern
settings of the PPG and the ED have been set into bellow conditions and auto search
has been performed.
  Pattern type: PRBS15   Mark ratio: 1/8   Bit shift: 3 bit

02-07-14 Under 02-07-13 state, tests whether threshold margin is 500 mVp-p or more.

02-07-15 Under 02-07-13 state, performs error/alarm measurement and tests whether it is
error free.

02-07-16
Tests whether it is error free when the pattern settings of the PPG and the ED have
been set into bellow conditions and error/alarm measurement has been performed.
  Pattern type: PRBS15   Mark ratio: 0/8
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Table 9-1  Clock Loss/Sync Loss/Threshold&Margin/Mark Ratio/DC Impedance Test (Table 9-1  Clock Loss/Sync Loss/Threshold&Margin/Mark Ratio/DC Impedance Test (Table 9-1  Clock Loss/Sync Loss/Threshold&Margin/Mark Ratio/DC Impedance Test (Table 9-1  Clock Loss/Sync Loss/Threshold&Margin/Mark Ratio/DC Impedance Test (7777/8)/8)/8)/8)

Item No.Item No.Item No.Item No. Diagnosis contentsDiagnosis contentsDiagnosis contentsDiagnosis contents

02-07-17

Tests whether the data threshold of the ED ranges -0.50 V ±0.1 V when the pattern
settings of the PPG and the ED have been set into bellow conditions and auto search
has been performed.
  Pattern type: PRBS15   Mark ratio: 1/2

02-07-18 Under 02-07-17 state, tests whether threshold margin is 500 mVp-p or more.

02-07-19 Under 02-07-17 state, performs error/alarm measurement and tests whether it is
error free.

02-07-20

Tests whether the data threshold of the ED ranges -0.50 V ±0.1 V when the pattern
settings of the PPG and the ED have been set into bellow conditions and auto search
has been performed.
  Pattern type: PRBS15   Mark ratio: 3/4   Bit shift: 1 bit

02-07-21 Under 02-07-20 state, tests whether threshold margin is 500 mVp-p or more.

02-07-22 Under 02-07-20 state, performs error/alarm measurement and tests whether it is
error free.

02-07-23

Tests whether the data threshold of the ED ranges -0.50 V ±0.1 V when the pattern
settings of the PPG and the ED have been set into bellow conditions and auto search
has been performed.
  Pattern type: PRBS15   Mark ratio: 3/4   Bit shift: 3 bit

02-07-24 Under 02-07-23 state, tests whether threshold margin is 500 mVp-p or more.

02-07-25 Under 02-07-23 state, performs error/alarm measurement and tests whether it is
error free.

02-07-26

Tests whether the data threshold of the ED ranges -0.50 V ±0.1 V when the pattern
settings of the PPG and the ED have been set into bellow conditions and auto search
has been performed.
  Pattern type: PRBS15   Mark ratio: 7/8   Bit shift: 1 bit

02-07-27 Under 02-07-26 state, tests whether threshold margin is 500 mVp-p or more.

02-07-28 Under 02-07-26 state, performs error/alarm measurement and tests whether it is
error free.

02-07-29

Tests whether the data threshold of the ED ranges -0.50 V ±0.1 V when the pattern
settings of the PPG and the ED have been set into bellow conditions and auto search
has been performed.
  Pattern type: PRBS15   Mark ratio: 7/8   Bit shift: 3 bit

02-07-30 Under 02-07-29 state, tests whether threshold margin is 500 mVp-p or more.

02-07-31 Under 02-07-29 state, performs error/alarm measurement and tests whether it is
error free.

02-07-32

Tests whether the error count is 0 when the pattern settings of the PPG and the ED
have been set into bellow conditions and error/alarm measurement has been per-
formed.
  Pattern type: PRBS15   Mark ratio: 8/8
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Table 9-1  Clock Loss/Sync Loss/Threshold&Margin/Mark Ratio/DC Impedance Test (Table 9-1  Clock Loss/Sync Loss/Threshold&Margin/Mark Ratio/DC Impedance Test (Table 9-1  Clock Loss/Sync Loss/Threshold&Margin/Mark Ratio/DC Impedance Test (Table 9-1  Clock Loss/Sync Loss/Threshold&Margin/Mark Ratio/DC Impedance Test (8888/8)/8)/8)/8)

Item No.Item No.Item No.Item No. Diagnosis contentsDiagnosis contentsDiagnosis contentsDiagnosis contents

02-08-01

Tests whether the data threshold of the ED ranges -1.000 V ±0.1 V when the settings
have been set into bellow conditions and auto search has been performed.

Pattern (PPG&ED): PRBS15, Mark Ratio 1/2
Data interface     : Amplitude 2.0 V, Offset -1.0 Vth, DC Impedance 50Ω

Tests whether the data threshold of the ED ranges -2.000 V ±0.3 V when the settings
have been set into bellow conditions and auto search has been performed.

Pattern (PPG&ED): PRBS15, Mark Ratio 1/2
Data interface     : Amplitude 4.0 V, Offset -2.0 Vth, DC Impedance 50Ω

02-08-02 Under 02-08-01 state, tests whether threshold margin is 1600 mVp-p or more.
Under 02-08-01 state, tests whether threshold margin is 2000 mVp-p or more.

02-08-03 Under 02-08-01 state, performs error/alarm measurement and tests whether it is
error free.
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Table Table Table Table 9999----2222  PLL Unlock&Frequency  PLL Unlock&Frequency  PLL Unlock&Frequency  PLL Unlock&Frequency////PRBS PatternPRBS PatternPRBS PatternPRBS Pattern////PDH/SDH FrPDH/SDH FrPDH/SDH FrPDH/SDH Freeeequency Test (1/quency Test (1/quency Test (1/quency Test (1/3333))))

Item No.Item No.Item No.Item No. Diagnosis contentsDiagnosis contentsDiagnosis contentsDiagnosis contents

03-01-01 Tests whether PLL unlock does not occur at 1600001 kHz.
03-01-02 Tests whether the error of frequency measurement is within 10 ppm at 1600001 kHz
03-01-03 Tests whether PLL unlock does not occur at 1700000 kHz.
03-01-04 Tests whether the error of frequency measurement is within 10 ppm at 1700000 kHz
03-01-05 Tests whether PLL unlock does not occur at 1700001 kHz.
03-01-06 Tests whether the error of frequency measurement is within 10 ppm at 1700001 kHz
03-01-07 Tests whether PLL unlock does not occur at 1800000 kHz.
03-01-08 Tests whether the error of frequency measurement is within 10ppm at 1800000 kHz
03-01-09 Tests whether PLL unlock does not occur at 1800001 kHz.
03-01-10 Tests whether the error of frequency measurement is within 10 ppm at 1800001 kHz
03-01-11 Tests whether PLL unlock does not occur at 1900000 kHz.
03-01-12 Tests whether the error of frequency measurement is within 10 ppm at 1900000 kHz
03-01-13 Tests whether PLL unlock does not occur at 1900001 kHz.
03-01-14 Tests whether the error of frequency measurement is within 10 ppm at 1900001 kHz
03-01-15 Tests whether PLL unlock does not occur at 2000000 kHz.
03-01-16 Tests whether the error of frequency measurement is within 10 ppm at 2000000 kHz
03-01-17 Tests whether PLL unlock does not occur at 2000001 kHz.
03-01-18 Tests whether the error of frequency measurement is within 10 ppm at 2000001 kHz
03-01-19 Tests whether PLL unlock does not occur at 2100000 kHz.
03-01-20 Tests whether the error of frequency measurement is within 10 ppm at 2100000 kHz
03-01-21 Tests whether PLL unlock does not occur at 2100001 kHz.
03-01-22 Tests whether the error of frequency measurement is within 10 ppm at 2100001 kHz
03-01-23 Tests whether PLL unlock does not occur at 2200000 kHz.
03-01-24 Tests whether the error of frequency measurement is within 10 ppm at 2200000 kHz
03-01-25 Tests whether PLL unlock does not occur at 2200001 kHz.
03-01-26 Tests whether the error of frequency measurement is within 10 ppm at 2200001 kHz
03-01-27 Tests whether PLL unlock does not occur at 2300000 kHz.
03-01-28 Tests whether the error of frequency measurement is within 10 ppm at 2300000 kHz
03-01-29 Tests whether PLL unlock does not occur at 2300001 kHz.
03-01-30 Tests whether the error of frequency measurement is within 10 ppm at 2300001 kHz
03-01-31 Tests whether PLL unlock does not occur at 2400000 kHz.
03-01-32 Tests whether the error of frequency measurement is within 10 ppm at 2400000 kHz
03-01-33 Tests whether PLL unlock does not occur at 2400001 kHz.
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Table 9-2  PLL Unlock&FrequencyTable 9-2  PLL Unlock&FrequencyTable 9-2  PLL Unlock&FrequencyTable 9-2  PLL Unlock&Frequency////PRBS PatternPRBS PatternPRBS PatternPRBS Pattern////PDH/SDH FrPDH/SDH FrPDH/SDH FrPDH/SDH Freeeequency Test (2/quency Test (2/quency Test (2/quency Test (2/3333))))

Item No.Item No.Item No.Item No. Diagnosis contentsDiagnosis contentsDiagnosis contentsDiagnosis contents

03-01-34 Tests whether the error of frequency measurement is within 10 ppm at 2400001 kHz
03-01-35 Tests whether PLL unlock does not occur at 2500000 kHz.
03-01-36 Tests whether the error of frequency measurement is within 10 ppm at 2500000 kHz
03-01-37 Tests whether PLL unlock does not occur at 2500001 kHz.
03-01-38 Tests whether the error of frequency measurement is within 10 ppm at 2500001 kHz
03-01-39 Tests whether PLL unlock does not occur at 2600000 kHz.
03-01-40 Tests whether the error of frequency measurement is within 10 ppm at 2600000 kHz
03-01-41 Tests whether PLL unlock does not occur at 2600001 kHz.
03-01-42 Tests whether the error of frequency measurement is within 10 ppm at 2600001 kHz
03-01-43 Tests whether PLL unlock does not occur at 2700000 kHz.
03-01-44 Tests whether the error of frequency measurement is within 10 ppm at 2700000 kHz
03-01-45 Tests whether PLL unlock does not occur at 2700001 kHz.
03-01-46 Tests whether the error of frequency measurement is within 10 ppm at 2700001 kHz
03-01-47 Tests whether PLL unlock does not occur at 2800000 kHz.
03-01-48 Tests whether the error of frequency measurement is within 10 ppm at 2800000 kHz
03-01-49 Tests whether PLL unlock does not occur at 2800001 kHz.
03-01-50 Tests whether the error of frequency measurement is within 10 ppm at 2800001 kHz
03-01-51 Tests whether PLL unlock does not occur at 2900000 kHz.
03-01-52 Tests whether the error of frequency measurement is within 10 ppm at 2900000 kHz
03-01-53 Tests whether PLL unlock does not occur at 2900001 kHz.
03-01-54 Tests whether the error of frequency measurement is within 10 ppm at 2900001 kHz
03-01-55 Tests whether PLL unlock does not occur at 3000000 kHz.
03-01-56 Tests whether the error of frequency measurement is within 10 ppm at 3000000 kHz
03-01-57 Tests whether PLL unlock does not occur at 3000001 kHz.
03-01-58 Tests whether the error of frequency measurement is within 10 ppm at 3000001 kHz
03-01-59 Tests whether PLL unlock does not occur at 3100000 kHz.
03-01-60 Tests whether the error of frequency measurement is within 10 ppm at 3100000 kHz
03-01-61 Tests whether PLL unlock does not occur at 3100001 kHz.
03-01-62 Tests whether the error of frequency measurement is within 10 ppm at 3100001 kHz
03-01-63 Tests whether PLL unlock does not occur at 3200000 kHz.
03-01-64 Tests whether the error of frequency measurement is within 10 ppm at 3200000 kHz
03-02-01 Tests whether PLL unlock does not occur at 1600000 kHz.
03-02-02 Tests whether the error of frequency measurement is within 10 ppm at 1600000 kHz
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Table 9-2  PLL Unlock&FrequencyTable 9-2  PLL Unlock&FrequencyTable 9-2  PLL Unlock&FrequencyTable 9-2  PLL Unlock&Frequency////PRBS PatternPRBS PatternPRBS PatternPRBS Pattern////PDH/SDH FrPDH/SDH FrPDH/SDH FrPDH/SDH Freeeequency Test (quency Test (quency Test (quency Test (3333////3333))))

Item No.Item No.Item No.Item No. Diagnosis contentsDiagnosis contentsDiagnosis contentsDiagnosis contents

03-02-03 Tests whether PLL unlock does not occur at 800000 kHz.
03-02-04 Tests whether the error of frequency measurement is within 10 ppm at 800000 kHz
03-02-05 Tests whether PLL unlock does not occur at 400000 kHz.
03-02-06 Tests whether the error of frequency measurement is within 10 ppm at 400000 kHz
03-02-07 Tests whether PLL unlock does not occur at 200000 kHz.
03-02-08 Tests whether the error of frequency measurement is within 10 ppm at 200000 kHz
03-02-09 Tests whether PLL unlock does not occur at 100000 kHz.
03-02-10 Tests whether the error of frequency measurement is within 10 ppm at 100000 kHz
03-02-11 Tests whether PLL unlock does not occur at 50000 kHz.
03-02-12 Tests whether the error of frequency measurement is within 10 ppm at 50000 kHz
03-02-13 Tests whether PLL unlock does not occur at 25000 kHz.
03-02-14 Tests whether the error of frequency measurement is within 10 ppm at 25000 kHz
03-02-15 Tests whether PLL unlock does not occur at 12500 kHz.
03-02-16 Tests whether the error of frequency measurement is within 10 ppm at 12500 kHz

04-01-01 Tests whether it is error free when pattern type is PRBS7 (1/2 mark ratio) and fre-
quency is 3200000 kHz.

04-01-02 Tests whether it is error free when pattern type is PRBS9 (1/2 mark ratio).
04-01-03 Tests whether it is error free when pattern type is PRBS11 (1/2 mark ratio).
04-01-04 Tests whether it is error free when pattern type is PRBS15 (1/2 mark ratio).
04-01-05 Tests whether it is error free when pattern type is PRBS20 (1/2 mark ratio).
04-01-06 Tests whether it is error free when pattern type is PRBS23 (1/2 mark ratio).
04-01-07 Tests whether it is error free when pattern type is PRBS31 (1/2 mark ratio).
04-02-01 Tests whether it is error free at 51840 kHz.
04-02-02 Tests whether it is error free at 155520 kHz.
04-02-03 Tests whether it is error free at 622080 kHz.
04-02-04 Tests whether it is error free at 2488320 kHz.
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Table Table Table Table 9999----3333  Total Error Addition  Total Error Addition  Total Error Addition  Total Error Addition////PRBS Sync ThresholdPRBS Sync ThresholdPRBS Sync ThresholdPRBS Sync Threshold////PRBS Burst TestPRBS Burst TestPRBS Burst TestPRBS Burst Test

Item No.Item No.Item No.Item No. Diagnosis contentsDiagnosis contentsDiagnosis contentsDiagnosis contents

05-01-01 Tests whether the measured error rate ranges from 5.0E-2 to 5.0E-4 when the PPG
adds 1E-3 rate error.

05-01-02 Tests whether the measured error rate ranges from 5.0E-3 to 5.0E-5 when the PPG
adds 1E-4 rate error.

05-01-03 Tests whether the measured error rate ranges from 5.0E-4 to 5.0E-6 when the PPG
adds 1E-5 rate error.

05-01-04 Tests whether the measured error rate ranges from 5.0E-5 to 5.0E-7 when the PPG
adds 1E-6 rate error.

05-01-05 Tests whether the measured error rate ranges from 5.0E-6 to 5.0E-8 when the PPG
adds 1E-7 rate error.

05-01-06 Tests whether the measured error rate ranges from 5.0E-7 to 5.0E-9 when the PPG
adds 1E-8 rate error.

05-01-07 Tests whether the measured error rate ranges from 5.0E-8 to 5.0E-10 when the PPG
adds 1E-9 rate error.

05-01-08 Tests whether the measured error count is 1 when the PPG adds single error.

06-01-01
Tests whether it is error free when the settings is same conditions as following.
  Sync Gain threshold: 1E-5, Sync Loss threshold: 1E-4,
  Error Addition: OFF  Pattern type: PRBS15

06-01-02 Tests whether SYNC loss is not detected when the PPG adds 1E-4 rate error under
06-01-01 state.

06-01-03 Tests whether SYNC loss is detected when the PPG adds 1E-3 rate error under
06-01-01 state.

06-01-04 Tests whether SYNC loss is not detected when the PPG adds 1E-5 rate error under
06-01-01 state.

06-01-05 Tests whether SYNC loss is not detected when the PPG adds 1E-6 rate error under
06-01-01 state.

06-01-06
Tests whether it is error free when the settings are same conditions as following.
  Sync Gain threshold: 1E-8, Sync Loss threshold: 1E-7
  Error Addition: OFF  Pattern type: PRBS15

06-01-07 Tests whether SYNC loss is not detected when the PPG adds 1E-7 rate error under
06-01-06 state.

06-01-08 Tests whether SYNC loss is detected when the PPG adds 1E-6 rate error under
06-01-06 state.

06-01-09 Tests whether SYNC loss is not detected when the PPG adds 1E-8 rate error under
06-01-06 state.

06-01-10 Tests whether SYNC loss is not detected when the PPG adds 1E-9 rate error under
06-01-06 state.

06-02-01 Tests whether it is error free when burst pattern is measured.  The burst cycle is
50000us, the enable length is 1us, pattern type is PRBS15.

06-02-02 Tests whether it is error free when burst pattern is measured.  The burst cycle is
50000 us, the enable length is 49999 us, pattern type is PRBS15.
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Table Table Table Table 9999----4444  Zero-Subst Sync Threshold  Zero-Subst Sync Threshold  Zero-Subst Sync Threshold  Zero-Subst Sync Threshold////PRGM Sync ThresholdPRGM Sync ThresholdPRGM Sync ThresholdPRGM Sync Threshold////PRGM Burst Test (1/2)PRGM Burst Test (1/2)PRGM Burst Test (1/2)PRGM Burst Test (1/2)

Item No.Item No.Item No.Item No. Diagnosis contentsDiagnosis contentsDiagnosis contentsDiagnosis contents

07-01-01
Tests whether it is error free when the settings are same conditions as following.
  Sync Gain threshold: 1E-5, Sync Loss threshold: 1E-4, Sync method: "Normal"
  Error Addition: OFF  Pattern type: Zero-Subst (215)

07-01-02 Tests whether SYNC loss is not detected when the PPG adds 1E-4 rate error under
07-01-01 state.

07-01-03 Tests whether SYNC loss is detected when the PPG adds 1E-3 rate error under
07-01-01 state.

07-01-04 Tests whether SYNC loss is not detected when the PPG adds 1E-5 rate error under
07-01-01 state.

07-01-05 Tests whether SYNC loss is not detected when the PPG adds 1E-6 rate error under
07-01-01 state.

07-01-06
Tests whether it is error free when the settings are same conditions as following.
  Sync Gain threshold: 1E-8, Sync Loss threshold: 1E-7, Sync method: "Normal"
  Error Addition: OFF  Pattern type: Zero-Subst (215)

07-01-07 Tests whether SYNC loss is not detected when the PPG adds 1E-7 rate error under
07-01-06 state.

07-01-08 Tests whether SYNC loss is detected when the PPG adds 1E-6 rate error under
07-01-06 state.

07-01-09 Tests whether SYNC loss is not detected when the PPG adds 1E-8 rate error under
07-01-06 state.

07-01-10 Tests whether SYNC loss is not detected when the PPG adds 1E-9 rate error under
07-01-06 state.

08-01-01
Tests whether it is error free the settings are same conditions as following.
  Pattern type: PRGM  Pattern length: with 8,388,608 bits (edited 1/2 mark ratio)
  Sync method: "Frame"  Frame length: 32 bits

08-01-02 Tests whether it is error free when the pattern logic is inverted under 08-01-01

09-01-01

Tests whether it is error free when the settings are same conditions as following.
Sync Gain threshold: 1E-5, Sync Loss threshold: 1E-4,
Sync method: "Frame"  Frame length: 32 bits  Error Addition: OFF

  Pattern type: PRGM  Pattern length: 8,388,608

09-01-02 Tests whether SYNC loss is not detected when the PPG adds 1E-4 rate error under
07-01-01 state.

09-01-03 Tests whether SYNC loss is detected when the PPG adds 1E-3 rate error under
09-01-01 state.

09-01-04 Tests whether SYNC loss is not detected when the PPG adds 1E-5 rate error under
09-01-01 state.

09-01-05 Tests whether SYNC loss is not detected when the PPG adds 1E-6 rate error under
09-01-01 state.
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Table 9-4  Zero-Subst Sync ThresholdTable 9-4  Zero-Subst Sync ThresholdTable 9-4  Zero-Subst Sync ThresholdTable 9-4  Zero-Subst Sync Threshold////PRGM Sync ThresholdPRGM Sync ThresholdPRGM Sync ThresholdPRGM Sync Threshold////PRGM Burst Test (2/2)PRGM Burst Test (2/2)PRGM Burst Test (2/2)PRGM Burst Test (2/2)

Item No.Item No.Item No.Item No. Diagnosis contentsDiagnosis contentsDiagnosis contentsDiagnosis contents

09-01-06

Tests whether it is error free when the settings are same conditions as following.
  Sync Gain threshold: 1E-8, Sync Loss threshold: 1E-7,
  Sync method: "Frame"  Frame length: 32 bits  Error Addition: OFF
  Pattern type: PRGM  Pattern length: 8,388,608

09-01-07 Tests whether SYNC loss is not detected when the PPG adds 1E-7 rate error under
09-01-06 state.

09-01-08 Tests whether SYNC loss is detected when the PPG adds 1E-6 rate error under
09-01-06 state.

09-01-09 Tests whether SYNC loss is not detected when the PPG adds 1E-8 rate error under
09-01-06 state.

09-01-10 Tests whether SYNC loss is not detected when the PPG adds 1E-9 rate error under
09-01-06 state.

09-02-01 Tests whether it is error free when burst pattern is measured.  The burst cycle is
50000 us, the enable length is 1us, pattern is 8,388,608 bits length PRGM.

09-02-02 Tests whether it is error free when burst pattern is measured.  The burst cycle is
50000 us, the enable length is 49999 us, pattern is 8,388,608 bits length PRGM.
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Table Table Table Table 9999----5555  INS/OMI Error Addition  INS/OMI Error Addition  INS/OMI Error Addition  INS/OMI Error Addition////Clock Delay TestClock Delay TestClock Delay TestClock Delay Test

Item No.Item No.Item No.Item No. Diagnosis contentsDiagnosis contentsDiagnosis contentsDiagnosis contents

10-01-01
Tests whether it is error free when the settings are same conditions as following.

Sync method: "Normal"
Pattern type: PRGM  Pattern length: 8,388,608 (edited all bits 0)

10-02-01 Tests whether it is error free when the pattern logic is inverted under 10-01-01
state.

10-03-01 Tests whether insertion errors are counted when the PPG adds errors under
10-01-01 state.

10-03-02 Tests whether no omission errors are counted when the PPG adds errors under
10-01-01 state.

11-01-01
Tests whether it is error free when the settings are same conditions as following.

Sync method: "Normal"
Pattern type: PRGM  Pattern length: 8,388,608 (edited all bits 1)

11-02-01 Tests whether it is error free when the pattern logic is inverted under 11-01-01
state.

11-03-01 Tests whether insertion errors are counted when the PPG adds errors under
11-01-01 state.

11-03-02 Tests whether no omission errors are counted when the PPG adds errors under
11-01-01 state.

12-01-01 Tests whether busy state is canceled when the clock delay of the PPG has changed
into –1000 ns from 0 ns.

12-01-02 Tests whether busy state is canceled when the clock delay of the PPG has changed
into +1000 ns from -1000 ns.

12-01-03 Tests whether busy state is canceled when the clock delay of the PPG has changed
into –1000 ns from +1000 ns.

12-01-04 Tests whether busy state is canceled when the clock delay of the ED has changed
into –1000 ns from 0 ns.

12-01-05 Tests whether busy state is canceled when the clock delay of the ED has changed
into +1000 ns from -1000 ns.

12-01-06 Tests whether busy state is canceled when the clock delay of the ED has changed
into –1000 ns from +1000 ns.
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CHAPTER10  MAINTENANCE⋅⋅⋅⋅SCRAPPING
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10.1 Introduction

This chapter describes about daily maintenance, transportation, and scrapping of the
MU163220C and MU163240C (hereafter called these units).

10.2 Daily Maintenance

1. If the surface of the unit is stained, wipe it with a cloth damped with synthetic detergent.

2. If dust settles on the surface of the unit, remove it with a vacuum cleaner.

3. If the mounted parts becomes loose, tighten screws with the specified tools.

 

10.2.1 Precautions for Storage

When storing these units, follow the precautions given below.

1. Before storing this unit, remove dust and stain.

2. Avoid storing this unit in a place where the temperature becomes higher than +60°C or
lower than -20°C or the humidity becomes higher than 85%.

3. Do not store this unit in a place exposed to direct sunlight or heavy dust.

4. Do not store this unit in a place exposed to water splashes or active gases.

5. Do not store this unit in a place where oxidization could occur or in a place exposed to
strong vibrations.

 

 Recommended log-term storage conditions
The instrument should be stored over a long period of tike in an environment meeting the follow-
ing conditions, as well as those suggested above.

1. Temperature : 5 to 30°C

2. Relative humidity : 40 to 75%

3. Little temperature and humidity change per day
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10.3 Transportation

When transporting this unit, use the original package if it has been stored.  If you do not have
the original package, pack the unit as described below.  Be sure to put on clean gloves and handle
the unit carefully so that the unit does not get scratched or dented.

1. Remove dust off the unit surface using a dry cloth.

2. Check screws for looseness and slipping out.

3. Cover the projections and easy-to-deform portions with protective materials and wrap the
unit with a polyethylene sheet and moisture-proof paper.

4. Put the packed unit in the corrugated cardboard box and fasten the seams with adhesive
tape.  Crate the package depending on the transportation distance and method.

 

 

 

10.4 Scrapping

This instrument contains GaAs.  Its scrapping must conform to the requirements of the govern-
ing national and local regulations.
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APPENDIXES
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Appendix A  Sending and Receiving Patterns

MP1632C enables you to select one of the following five types of sendable and receivable patterns:

(1) Programmable pattern (PRGM pattern)
(2) Pseudo random binary sequence pattern (PRBS pattern)
(3) Zero-substitution pattern (Zero-Subst pattern)

PRGM patternPRGM patternPRGM patternPRGM pattern

A pattern the user can specify arbitrarily.  For a channel set in the PRGM pattern, a sent or
received pattern can be edited using the Pattern Editor dialog box and Customize panel.

PRBS (Pseudo Random Binary Sequence) patternPRBS (Pseudo Random Binary Sequence) patternPRBS (Pseudo Random Binary Sequence) patternPRBS (Pseudo Random Binary Sequence) pattern

A pattern generated by the principle shown in Table 1.  If successive N bits are selected in a bit
array of the PRBS pattern having a 2N - 1 cycle, the same bit array as this bit array does not exist
in one cycle.  In other words, the PRBS pattern has all assumable bit arrays other than 0.  Us-
ing the PRBS pattern as a test signal, the user can execute the test under conditions similar to an
actual signal that passes through a transmission line.
For the PRBS output pattern, logical value 1 corresponds to low level and logical value 0 to high
level.
The circuit shown in Figure 1 enables to set a PRBS pattern marking rate (logical value 1 genera-
tion probability in pattern) to 1/2, 1/4, and 1/8.  As shown in Figure 1, there are two methods of
generating the 1/4 and 1/8 marking rates: ANDing with a bit shifted by one bit and ANDing with
a bit shifted by three bits.  Inverting the logical value of these bits enables to generate a 1/2inv,
3/4, and 7/8 marking rates.
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Table 1  Pseudo random binary sequence pattern generation princTable 1  Pseudo random binary sequence pattern generation princTable 1  Pseudo random binary sequence pattern generation princTable 1  Pseudo random binary sequence pattern generation princiiiipleplepleple

Period Generation
polynomial Pattern generation block diagram
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２－１

２－１

２－１

２－１

２－１

２－１

7

9

15

20
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31

Output

Output

Output

Output

Output

Output

N : Shift register

：Exclusive-OR

１―Ｘ―Ｘ
5 9

１―Ｘ―Ｘ

１―Ｘ―Ｘ
6 7

１―Ｘ―Ｘ
9 11

１―Ｘ―Ｘ
14 15

１―Ｘ―Ｘ
28 31

１―Ｘ―Ｘ
18 23

１―Ｘ―Ｘ
3 20

28 29 30 31 Output

1 2 3 4 5 6 7

1 2 3 4 5 6 7

1 2 3 4 5 6 7

8 9

8 9 10 11

1 2 3 4

17 18 191 2 3 4 5

1 2 3

1 2 3

20

17 18 19 20 21 22 23

27

11

13 14 15

Shift registers Mark ratio

1/4 (1 bit shift)

1/8 (1 bit shift)

1/4 (3 bits shift)

1/8 (3 bits shift)

1/2PRBS pattern
generator

(See Table 1)

１ ２ ３ ４ ５ ６

Fig. 1  Marking rate 1/4, 1/8 generator circuitFig. 1  Marking rate 1/4, 1/8 generator circuitFig. 1  Marking rate 1/4, 1/8 generator circuitFig. 1  Marking rate 1/4, 1/8 generator circuit
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Zero-Subst patternZero-Subst patternZero-Subst patternZero-Subst pattern

In this pattern, values following the longest successive 0s in a PRBS pattern in which a bit having
a logical value 1 is added are substituted with logical value 0 by the specified number of bits.
When the bit following the bit substituted with 0 is 0, it is inverted to 1.

Example: 27 cycle PRBS
The number of longest successive 0s is 7 - 1 = 6 bits, and the substitution with 0 begins with the
position below.

1000000 1000001100001010....   ←27 cycle PRBS pattern

1 bit 1000000 010 　　  Since the bit following the bit substituted with
5 bits1000000 0000011         0 is 0, it is inverted to 1.
7 bits1000000 000000010
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Appendix B  Burst Pattern Generation Principle

To generate a burst pattern, specify two attributes: burst cycle and enable length.  As shown in
Figure 7, the burst cycle means a cycle ranging from the restart of pattern generation to its next
restart.  The enable length means a duration in which a pattern is generated in the burst cycle.
A burst trigger signal is generated in the PPG unit according to the specified burst cycle and en-
able length.  It is available to control the pattern generation.
The burst trigger signal is also input from an external unit.  An external signal is input from the
EXT Burst Input connector on the rear of the PPG unit.  In this case, the burst cycle and enable
length cannot be specified in the PPG unit.
Patterns generated successively are generically called a repeat pattern.  In other words, the re-
peat pattern means a burst pattern having "burst cycle = enable length."

Pattern
(Burst)

Pattern
(Repeat)

Burst trigger
Burst cycle

Enable length

Fig. 2  Burst Pattern Generation PrincipleFig. 2  Burst Pattern Generation PrincipleFig. 2  Burst Pattern Generation PrincipleFig. 2  Burst Pattern Generation Principle
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Appendix C  Auto Sync

 Auto Sync n pattern cycleAuto Sync n pattern cycleAuto Sync n pattern cycleAuto Sync n pattern cycle

Auto Sync is a function that automatically synchronizes a pattern received by the ED unit with a
reference pattern in the ED unit.  If an error rate exceeds a specific threshold value during
measurement as Auto Sync is ON, the ED unit assumes that the synchronization of the input
pattern with the reference pattern is released.  In this case, the ED unit generates the Pattern
Sync Loss alarm to stop the error count, recovers the synchronization, and restarts the error
count.
In the Pattern Sync mode, there are two methods of recovering the synchronization.

Normal Recovers the synchronization while comparing the input pattern with the refer-
ence pattern and switching Demux route order and bit shifting, during one full
cycle.

Frame A synchronization recovery trigger is assumed to be a timing when the same
pattern as a specified frame (some bits at the beginning of the reference pattern)
appears in the input pattern.
If pattern type is set to PRBS, you cannot select this Pattern Sync mode.

As compared with Normal, Frame is available to release the synchronization at higher speed.
When bit rows having the same pattern exist at different positions in a frame, the input pattern
may abnormally synchronize with the reference pattern.
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Appendix D  Relationships among Amplitude, Offset, and Termination

When the data output and clock output levels are set to Variable, they are uniquely determined
depending on two values: offset voltage (Voh, Vth, or Vol) and amplitude.

When amplitude and Voh are already specified:When amplitude and Voh are already specified:When amplitude and Voh are already specified:When amplitude and Voh are already specified:
Voh

Amplitude(Vp-p) Vth = Voh - 
Vp-p
2

Vol = Voh - Vp-p

Fig. 3Fig. 3Fig. 3Fig. 3
When amplitude and Vth are already specified:When amplitude and Vth are already specified:When amplitude and Vth are already specified:When amplitude and Vth are already specified:

Amplitude(Vp-p) Vth

Vp-p
2

Vol = Vth - 

Vp-p
2

Voh = Vth + 

Fig. 4Fig. 4Fig. 4Fig. 4

When amplitude and Vol are already specified:When amplitude and Vol are already specified:When amplitude and Vol are already specified:When amplitude and Vol are already specified:

Amplitude(Vp-p)

Vol

Voh = Vol + Vp-p 

Vp-p
2

Vth = Vol + 

Fig. 5Fig. 5Fig. 5Fig. 5

Fig. 6 shows the amplitude and offset settable range for each terminal value.

5

0 +1 +2 +3 +4 +5-1-2-3-4-5 0 +1 +2 +3 +4 +5-1-2-3-4-5 0 +1 +2 +3 +4 +5-1-2-3-4-5

-3.75 +1.75

Amplitude(V)

offset (V)

Amplitude(V)

offset (V)

Amplitude(V)

offset (V)

4

3

2

1

5

4

3

2

1

5

4

3

2

1

+1.50

+0.50 +0.50

-3.50

+0.50

                (a) Vol                      (b) Vth                    (c) Voh

Fig. 6  Relationships between amplitude and offsetFig. 6  Relationships between amplitude and offsetFig. 6  Relationships between amplitude and offsetFig. 6  Relationships between amplitude and offset
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Appendix E  Error Addition

The error addition method can be selected in the Error Addition dialog box.  This section explains
how to add an error in each method.

1. Single
A 1-bit error is inserted at a timing when the Single button is pressed while the lamp on the side
of the Error Addition button lights on.

 Error Addition Button
Single Button

Pattern

Added error(1 bit)

 Fig. 7  Error addition (1)Fig. 7  Error addition (1)Fig. 7  Error addition (1)Fig. 7  Error addition (1)

2. Rate (1E-3 to 1E-9)
An error is successively added with the specified rate after the Error Addition button is pressed.

 Error Addition Button

Pattern Error addition area

 Fig. 8  Error addition (2)Fig. 8  Error addition (2)Fig. 8  Error addition (2)Fig. 8  Error addition (2)

3. EXT
A 1-bit error is added synchronously with the falling edge of a pulse signal sent from the EXT
ERR Input connector on the rear panel of the PPG unit.

Error Addition Button

Pattern

EXT Error Input
   (Rear panel)

Added error(1bit)

Fig. 9  Error addition Fig. 9  Error addition Fig. 9  Error addition Fig. 9  Error addition ((((3333))))
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Appendix F  Printer Output Format

 Error/Alarm measurement immediate dataError/Alarm measurement immediate dataError/Alarm measurement immediate dataError/Alarm measurement immediate data

This section shows a printing format used when File-Print is selected on the master window menu
to specify Error/Alarm output while an error alarm is measured by the MU163240C 3.2G error
detector.

--------------- MP1632C Error/Alarm Immediate Data ------------
Start Time 98-07-01 14:25:00  Intermediate Time 98-07-01 14:26:00
Power Fail Interval  *.****E**
Alarm Interval

Clock Loss Sync Loss
---------------------------------
 *.****E**  *.****E**
---------------------------------
Error
           ER            EC          EI        %EFI
------------------------------------------------
INS    *.****E-**  *.****E**  ---------  -------- ←*1
OMI    *.****E-**  *.****E**  ---------  --------
Total  ---------   --------- *.****E**  ***.****%
-------------------------------------------------
Threshold EI
    >1E-3    >1E-4      >1E-5     ･･･   >1E-8     =<1E-8
---------------------------------------------------------------
INS     *.****E** *.****E** *.****E**         *.****E** *.****E**  ←*2
OMI     *.****E** *.****E** *.****E**         *.****E** *.****E**
Total   *.****E** *.****E** *.****E**         *.****E** *.****E**
---------------------------------------------------------------
Threshold %EFI
    >1E-3    >1E-4      >1E-5     ･･･  >1E-8       =<1E-8
--------------------------------------------------------------
INS      ***.****%  ***.****% ***.****%        ***.****% ***.****%  ←*2
OMI      ***.****%  ***.****% ***.****%        ***.****% ***.****%
Total   ***.****%  ***.****% ***.****%        ***.****% ***.****%
---------------------------------------------------------------
Error Performance

ES    EFS       SES     US         DM   EC
------------------------------------------------------------------
INS    *.****E** *.****E** *.****E** *.****E** *.****E** *.****E** ←*2
OMI    *.****E** *.****E** *.****E** *.****E** *.****E** *.****E**
Total  *.****E** *.****E** *.****E** *.****E** *.****E** *.****E**
------------------------------------------------------------------
Error Performance
     ES% %EFS   %SES %US     %DM
--------------------------------------------------------
INS     ***.****% ***.****% ***.****% ***.****% ***.****%     ←*2
OMI     ***.****% ***.****% ***.****% ***.****% ***.****%
Total   ***.****% ***.****% ***.****% ***.****% ***.****%
---------------------------------------------------------
Clock Frequency
-----------------
     *******.*kHz
-----------------
*1: This format is depend on the Error Type on the 'Measurement: Test Menu' panel.  If

"INS/OMI" is selected, three lines are printed out as shown above, if "Total" is selected, only
the third line whose beginning is "Total" is printed out.

*2: These formats are depend on the Error Type on the 'Measurement: Test Menu' panel.  If
"INS/OMI" is selected two lines whose beginning is "INS" or "OMI" are printed out, if "Total"
is selected only the third line whose beginning is "Total" is printed out.
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 Eye margin resultEye margin resultEye margin resultEye margin result

Threshold margin

-------------MP1632C 3.2G ED Threshold Margin--------------

Start Time 98-07-01-15:30:00 End Time   98-07-01-15:31:50
Error Rate *.****E-*
Phase ********** ps
>> Result <<
Threshold Margin ********** mV

Phase margin

-------------MP1632C 3.2G ED Phase Margin--------------

Start Time 96-02-02-15:30:00 End  Time 98-07-01-15:31:50
Error Rate *.****E-*
Threshold ********** mV
>> Result <<
Phase Margin ********** ps

Phase&Threshold margin

-------------MP1632C 3.2G ED Phase&Threshold Margin-------------

Start Time 96-02-02-15:30:00 End Time   98-07-01-15:31:50
Error Rate *.****E-*
Threshold ********** mV
Phase ********** ps
>> Result <<
Threshold Margin ********** mV
Phase Margin ********** ps
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Eye Diagram

-------------MP1632C 3.2G ED Eye Diagram-----------------

Start Time 98-07-01 15:30:00 End Time  98-07-01 15:31:50
Threshold ********** mV
Phase ********** ps
>> Result <<
************************** 1E-3 *****************************
 1.(***.*,***.***)    2.(***.*,***.***) …  4.(***.*,***.***) ←*1
 5.(***.*,***.***)    6.(***.*,***.***) …  8.(***.*,***.***)

:
:

29.(***.*,***.***)   30.(***.*,***.***) … 32.(***.*,***.***)
************************** 1E-4 *****************************
 1.(***.*,***.***)    2.(***.*,***.***) …  4.(***.*,***.***) ←*1
 5.(***.*,***.***)    6.(***.*,***.***) …  8.(***.*,***.***)

:
:

************************** 1E-12 ****************************
 1.(***.*,***.***)    2.(***.*,***.***) …  4.(***.*,***.***) ←*1
 5.(***.*,***.***)    6.(***.*,***.***) …  8.(***.*,***.***)

:
:

29.(***.*,***.***)   30.(***.*,***.***) … 32.(***.*,***.***)

*1  Each result is shown as coordinate whose X-axis is phase, Y-axis is threshold.

 PatternPatternPatternPattern

-------------------MP1632C 3.2G ED Pattern (Slot 4)------------------

0                           64                         128
+ -----------------------+-----------------------+--------------
----

+

0| 00 0A 3C EE 53 21 01 0E 48 FF C9 CC 67 85 4D 66   … |
192| 01 02 03 55 CD CD E7 00 35 7E 54 A0 0B 5B 54 22   … |
384| DD CB 5E 90 26 71 A9 BA EE 87 77 20 00 03 FE 6D   … |

| : |
| : |

13056| 55 6C 67 80 01 28 01 21 D8 89 7C 1C 7D 90 AA 00   … |
+ -----------------------+-----------------------+-------------- +
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Appendix G  Details on error alarm measurement

 Explanation of measurement termsExplanation of measurement termsExplanation of measurement termsExplanation of measurement terms
(1) Error rate

(2) Number of errors
Number of error pulses in specified time

(3) Number of error intervals (EI)
Number of intervals including one or more error pulses in specified measurement time.
The interval time is 100 ms or 1 sec.

(4) Error free interval rate (%EFI)
A rate of the total number of intervals with the number of intervals excluding intervals
having one or more error pulses in specified measurement time.  The error free inter-
val rate is obtained from EI in the expression below.

The interval time is 100 ms or 1 sec.

(5) Number of power fail intervals
Number of intervals in which power cut-off occurred

(6) Number of clock loss intervals
Number of intervals in which clock cut-off occurred

(7) Number of SYNC loss intervals
Number of intervals in which asynchronization occurred.

(8) Threshold EI
Number of intervals in which the 1-second average error rate satisfies the threshold
conditions below in the specified measurement time
1-second average error rate>10-3, >10-4, >10-5, >10-6, >10-7, >10-8, ≤10-8

(9) Threshold %EFI
A rate of the total number of intervals with the number of intervals in which the 1-
second average error rate does not satisfy the threshold conditions shown in item (8) in
the specified measurement time.  This rate is obtained from threshold EI in the ex-
pression below.

Number of error pulses to be measured in specified
Number of clocks to be measured in specified time

Number of measured intervals - EI
Number of measured intervals )( × 100%%EFI =

Threshold %EFI = Number of measurement intervals - Threshold EI
Number of measurement intervals )( × 100%
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 Error performance dataError performance dataError performance dataError performance data
A parameter used to estimate the transmission line defined in ITU-T (old CCITT) Recom-
mendation G821.  The range from the start of measurement to the end of measurement is
divided into an available and unavailable periods in 1-second intervals.  Various items are
mainly obtained in the available period.

(1) Definition of available and unavailable periods
When a unavailable interval of which 1-second average error rate exceeds the unavailable
threshold is continued for 10 seconds, the unavailable period begins; the 10 seconds is in-
cluded in the unavailable period.
When an unavailable interval of which 1-second average error rate does not exceed the un-
available threshold is continued for 10 seconds in the unavailable period, the unavailable
period ends and the 10 seconds is included in the unavailable period.

(2) Unavailable threshold and DM threshold
The unavailable threshold and DM threshold can be selected on the Measurement Condi-
tion dialog box (see Figure 5-69).

Unavailable threshold = 10-3, DM threshold = 10-6

Unavailable threshold = 10-4, DM threshold = 10-8

(3) Measurement items
• Error count (EC)

A bit error count value in measurement duration

• Error second (ES)
Total number of intervals in which one or more bit errors occurred in the available period

• Error free second (EFS)
Total number of intervals in which no bit error occurred in the available period

• Severe error second (SES)
Total number of intervals in which a bit error exceeding the unavailable threshold occurred
in the available period

• Unavailable second (US)
When SES continues for 10 seconds or more, its beginning is assumed to be the beginning of
the unavailable time.  If other than SES continues for 10 seconds or more, the part preced-
ing its beginning is assumed to be the end of the unavailable time.  When a measurement
cycle ends and the next one starts while deciding whether the unavailable time starts or ends,
the decision counter is reset at the start of measurement.

• Degraded minutes (DM)
This system obtains an error rate every 60 packets excluding SES above, in available inter-
vals calculated for the available time.  The degraded minutes means the total number of
packets of which the error rate exceeds the DM threshold.  One is added to a duration in
which 60 seconds is not satisfied at the end of measurement if the duration exceeds the DM
threshold.
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• Error second rate (%ES)
A rate of all intervals calculated for the available time with error intervals calculated for the
available time

• Error free second rate (%EFS)
A rate of all intervals calculated for the available time with error free intervals calculated for
the available time

• Severe error second rate (%SES)
A rate of all intervals calculated for the available time with unavailable intervals calculated
for the available time

• Unavailable second rate (%US)
A rate to a measurement time in unavailable time

• Degraded minutes rate (%DM)
An error rate is obtained every 60 packets excluding SES above in available intervals calcu-
lated for the available time.  A rate of all packets with the number of packets of which error
rate exceeds the DM threshold

 Measured data processing at alarm occurrenceMeasured data processing at alarm occurrenceMeasured data processing at alarm occurrenceMeasured data processing at alarm occurrence

(1) Power fail

Power cut-off processing is valid only when it is specified.  For details on specifying power cut-off
processing, refer to Section 6.4, "Specifying System Operations" in the MP1632C Digital Data
Analyzer Operation Manual.
If power fail occurs during measurement, data measured until just before the interval in which
power fail occurred is held while the power is cut off.

(a) Error measurement
This system excludes the number of clocks and number of errors calculated in the interval
in which power fail occurred.  After power fail was recovered, measurement is continued if
measured data is held correctly.

(b) Interval and threshold interval measurements
This system includes the intervals in which power fail occurred and intervals in which pow-
er fail is continued in the number of power fail intervals, and does not include other items.
After power fail was recovered, measurement is continued if measured data is held cor-
rectly.

(c) Error performance
An interval that was being decided at occurrence of power fail is not calculated for the un-
available and available seconds.
After power fail was recovered, measurement is restarted from the initial state.
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(2) Clock loss

When clock loss occurs during measurement, the user can select one of the following two methods:

(a) Excluding clock loss processing from calculation
( i). Error measurement

The number of clocks and number of errors calculated in the interval in which clock loss
occurred are not calculated.

( ii). Interval and threshold interval measurements
The interval in which clock loss occurred is calculated only for the clock loss interval,
not other items.

(iii). Error performance
The interval in which clock loss occurred is not calculated for the unavailable and
available seconds.  Neither is an interval that was being decided calculated for un-
available and available seconds.

 After clock loss is recovered, measurement is continued from the initial state.

(b) Including clock loss processing in calculation
( i). Error measurement

The number of clocks and number of errors calculated in the interval in which clock
loss occurred are not calculated.

( ii). Interval and threshold interval measurements
The interval in which clock loss occurred is calculated as a clock loss interval and in-
cluded in the total number of intervals; however, it is not included in the number of
threshold EIs.

( iii). Error performance
The interval in which clock loss occurred is calculated for a unavailable interval.  If
the interval is calculated for an available second, it is also included in the number of
error seconds.
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(3) SYNC loss

When a SYNC loss occurred during measurement, the user can select one of the following two
methods:

(a) Excluding SYNC loss processing from calculation
( i). Error measurement

The number of clocks and number of errors calculated in the interval in which SYNC
loss occurred are not calculated.

( ii). Interval and threshold interval measurements
The interval in which SYNC loss occurred is calculated only for the SYNC loss interval,
and not for other items.

( iii). Error performance
The interval in which SYNC loss occurred is not calculated for unavailable and avail-
able seconds.  Neither is an interval that was being decided calculated in unavailable
and available seconds.

 After SYNC loss is recovered, measurement is continued from the initial state.

(b) Including SYNC loss processing in calculation
( i). Error measurement

The number of clocks and errors measured in the interval in which SYNC loss occurred
are not calculated.

( ii). Interval and threshold interval measurements
The interval in which SYNC loss occurred is calculated as an SYNC loss interval and
included in the total number of intervals; however, it is not included in the number of
threshold EIs.

( iii). Error performance
The interval in which SYNC loss occurred is assumed to be a unavailable interval.  If
the interval is calculated for an available second, it is also included in the number of
error seconds.
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Appendix H  Measurement Extent During Burst Pattern Receiving

During MU163240C receives burst pattern, it measures the pattern only for a period that the
burst trigger signal is high.  When the burst trigger signal rises, MU163240C first becomes a
synchronization state then it begins synchronization processing.  The period until it gains syn-
chronization is not included in the measurement period although the burst trigger signal is high.
The SYNC Gain/Loss is forced to fall when the burst trigger signal rises.  It remains low until the
measurement period starts, then raises and falls according to synchronization state for measure-
ment period.  While the burst trigger signal is low, the SYNC Gain/Loss signal keeps the state at
the end of last measurement period.

Burst Trigger

Pattern

Enable Length

Beginning synchronization processing

Synchronization gain

Measurement period
SYNC Gain/Loss

SYNC loss occurrs.
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Appendix I  Internal Route Mask

This section describes error rate calculate method depend on the internal route mask setting.

Input data signal of MU163240C is demultiplexed into eight routes.  Every route has a their own
error counter. Consequently MU163240C has eight error counters.  Input clock of MU163240C is
divided by 8.

Data Input

Clock Input

1:8

EC1

EC2

EC8

EC4

EC3

EC5

EC6

EC7

CC
1/8

Error counters

Clock counter

The error rate calculate method is depend on the internal route mask condition.

 No masks
Error Rate = (EC1+EC2+EC3+EC4+EC5+EC6+EC7+EC8)/(CC×8)

 Mask from the second mask to the eighth
Error Rate = (EC1)/(CC)

 Mask from the third mask to the eighth
Error Rate = (EC1+EC2)/(CC×2)

(Example 1) Errors are distributed evenly
Assumption: EC1 = EC2 = EC3 = EC4 = EC5 = EC6 = EC7 = EC8 = 1, CC = 1000
If no route is masked
  Error Rate = (1+1+1+1+1+1+1+1)/(1000×8) = 0.001
If the from second route to eighth are masked
  Error Rate = 1/1000 = 0.001

(Example 2) Errors are distributed partially to a route.(e.g. Error addition by PPG unit)
Assumption: EC1 = 8, EC2 = EC3 = EC4 = EC5 = EC6 = EC7 = EC8 = 0, CC = 1000
If no route is masked
  Error Rate = (8+0+0+0+0+0+0+0)/(1000×8) = 0.001
If the from second route to eighth are masked
  Error Rate = 8/1000 = 0.008
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Appendix J  Internal Threshold

The internal threshold values for synchronization / asynchronization is depend on the pattern
type and the pattern synchronization method.  This section describes these threshold value.

 PRBS pattern
Sync Loss ThresholdSync Loss ThresholdSync Loss ThresholdSync Loss Threshold Sync Gain ThresholdSync Gain ThresholdSync Gain ThresholdSync Gain Threshold
2000 / 80000 1 / 64

 PRGM or Zero-Subst pattern with "Frame" synchronization method
Pattern LengthPattern LengthPattern LengthPattern Length Sync Loss ThresholdSync Loss ThresholdSync Loss ThresholdSync Loss Threshold Sync Gain ThresholdSync Gain ThresholdSync Gain ThresholdSync Gain Threshold
8 to 5120 100 / 1200000 1 / Pattern Length
5121 to 10240 100 / 2200000 1 / Pattern Length
10241 to 51200 100 / 10400000 1 / Pattern Length
51201 to 102400 100 / 22000000 1 / Pattern Length
102401 to 204800 100 / 42000000 1 / Pattern Length
204801 to 307200 100 / 64000000 1 / Pattern Length
307201 to 409600 100 / 82000000 1 / Pattern Length
409601 to 524288 100 / 104857600 1 / Pattern Length
524289 to 1048576 100 / 220000000 1 / Pattern Length
1048577 to 2097152 100 / 420000000 1 / Pattern Length
2097153 to 4194304 100 / 840000000 1 / Pattern Length
4194305 to 8388608 100 / 16800000001 / Pattern Length

 PRGM or Zero-Subst pattern with "Normal" synchronization method
Pattern LengthPattern LengthPattern LengthPattern Length Sync Loss ThresholdSync Loss ThresholdSync Loss ThresholdSync Loss Threshold Sync Gain ThresholdSync Gain ThresholdSync Gain ThresholdSync Gain Threshold
2 to 16 2000 / 80000 1 / 64
17 to 160 200 / 80000 1 / 640
161 to 1600 20 / 80000 1 / 6400
1601 to 16000 2 / 80000 1 / 64000
16001 to 80000 2 / 400000 1 / 160000
80001 to 160000 2 / 800000 1 / 320000
160001 to 320000 2 / 1600000 1 / 640000
320001 to 524288 2 / 2097152 1 / 1280000
524289 to 1048576 2 / 4194304 1 / 2560000
1048577 to 2097152 2 / 8388608 1 / 5120000
2097153 to 4194304 2 / 16777216 1 / 10240000
4194305 to 8388608 2 / 33554432 1 / 20480000
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Appendix K  Pattern Synchronized Output Period

1111 Pesudorandom patternPesudorandom patternPesudorandom patternPesudorandom pattern

           Period =                ×(2N-1) × 32

                  N = 7, 9, 11, 15, 20, 23, 31

                  (Where pulse width =                × 32, plus pulse)

2.2.2.2. Programmable patternProgrammable patternProgrammable patternProgrammable pattern

(1)  PRGM pattern

(a)  Pattern Length ≤ 131,072

           Period =                × (least common multiple between 64 and pattern length)

           (Example 1) Pattern length = 8

                Period =                × 64

           (Example 2) Pattern length = 10

                Period =                × 320

(b)  Pattern Length > 131,072

            Period =                × (pattern length)

(2)  Zero-Subst pattern

           Period =                × 2N    N = 7, 9, 11, 15

(3)  Pulse width
For any of the programmable patterns above, the pulse with =                × 32.
The output signal polarity is plus pulse.

(Set frequency)
1

(Set frequency)
1

(Set frequency)
1

(Set frequency)
1

(Set frequency)
1

(Set frequency)
1

(Set frequency)
1

(Set frequency)
1
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Appendix L  Entry Table of Performance Test Result

Instrument Name : MU163220C 3.2G Pulse Pattern Generator
Serial No. :                                           
Ambient Temperature :             °C
Ambient Humidity :             %

 Trigger output interface

Output Level[V]Output Level[V]Output Level[V]Output Level[V] Standard[V]Standard[V]Standard[V]Standard[V] ResultResultResultResult
0.0 0.0 ±0.2
-1.0 -1.0 ±0.2

 Clock output interface

Output Level[V]Output Level[V]Output Level[V]Output Level[V] Standard[V]Standard[V]Standard[V]Standard[V] ResultResultResultResult
-0.9 -0.9 ±0.135
-1.7 -1.7 ±0.255
-3.0 -3.0 ±0.45
-4.0 -4.0 ±0.6
2.0 2.0 ±0.3
1.0 1.0 ±0.15
4.25
(Equipped with OPT02)

4.25 ±0.64

3.25
(Equipped with OPT02)

3.25 ±0.49

 Data output interface

Output Level[V]Output Level[V]Output Level[V]Output Level[V] Standard[V]Standard[V]Standard[V]Standard[V] ResultResultResultResult
-0.9 -0.9 ±0.135
-1.7 -1.7 ±0.255
-3.0 -3.0 ±0.45
-4.0 -4.0 ±0.6
2.0 2.0 ±0.3
1.0 1.0 ±0.15
4.25
(Equipped with OPT01)

4.25 ±0.64

3.25
(Equipped with OPT01)

3.25 ±0.49

 Burst trigger output interface
Output Level[V]Output Level[V]Output Level[V]Output Level[V] Standard[V]Standard[V]Standard[V]Standard[V] ResultResultResultResult

0.0 0.0 ±0.2
-1.0 -1.0 ±0.2
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Instrument Name : MU163240C 3.2G Error Detector
Serial No. :                                           
Ambient Temperature :             °C
Ambient Humidity :             %

 Trigger output interface

Output Level[V]Output Level[V]Output Level[V]Output Level[V] Standard[V]Standard[V]Standard[V]Standard[V] ResultResultResultResult
0.0 0.0 ±0.2
-1.0 -1.0 ±0.2

 Clock Counter

Frequency [Hz]Frequency [Hz]Frequency [Hz]Frequency [Hz] Standard[Hz]Standard[Hz]Standard[Hz]Standard[Hz] ResultResultResultResult
3.2 G 3.2 G ±32k
50 M 50 M ±500
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Appendix M  Initial Settings

We show here Initial settings of MU163220C 3.2G Pulse Pattern Generator and MU163240C 3.2G
Error Detector.  Setting items of unit which isn't inserted the main fame doesn't appear.  To
restore initial settings, select Initialize from the File menu. of the parent window.

Table 2  Initial settingsTable 2  Initial settingsTable 2  Initial settingsTable 2  Initial settings

PanelPanelPanelPanel Group boxGroup boxGroup boxGroup box Setting itemSetting itemSetting itemSetting item Initial conditionInitial conditionInitial conditionInitial condition
Setup: Setup Slot3&Slot4

Common Setting
Pattern OFF

Setup: Clock I/F 3.2G PPG: Output ON
Delay 0
Level VAR
Duty 0
Amplitude 1.00
Offset 0.000

Voh
3.2G ED: Polarity POS

Delay 0
Termination GND

Setup: Data I/F 3.2G PPG: Output ON
Cross Point 50
Level VAR
Amplitude 1.00
Offset 0.000

Voh
3.2G ED: Level VAR

Threshold -0.500
Termination GND
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Table 2  Initial setting (continued)Table 2  Initial setting (continued)Table 2  Initial setting (continued)Table 2  Initial setting (continued)

PanelPanelPanelPanel Group boxGroup boxGroup boxGroup box Setting itemSetting itemSetting itemSetting item Initial conditionInitial conditionInitial conditionInitial condition
Setup: Pattern 3.2G PPG Pattern Output Repeat

Pattern PRBS15
Mark Ratio 1/2
Bit Shift 1bit Shift

(Zero-Subst is selected Pattern Zero-Subst
as the pattern type) Pattern Length 2^7

Zero-Length 7
Logic POS

(PRGM is selected Pattern PRGM
as the pattern type) Pattern Length 2

Logic POS
Burst Setting Mode INT

Burst Cycle 1000
Enable Length 10

3.2G ED Pattern Input Repeat
Pattern PRBS15
Mark Ratio 1/2
Bit Shift 1bit Shift

(Zero-Subst is selected Pattern Zero-Subst
as the pattern type) Pattern Length 2^7

Zero-Length 7
Logic POS

(PRGM is selected Pattern PRGM
as the pattern type) Pattern Length 2

Logic POS
Sync Setting Auto Sync ON

Setup: Trigger I/F 3.2G PPG: Source 1/8 Clock Sync
3.2G ED: Source 1/8 Clock Sync

Setup: Utility 3.2G PPG PRBS Logic Mark Low
PRGM Logic Mark high
Clock I/F 0 ohm
Data I/F 0 ohm

3.2G ED PRBS Logic Mark Low
PRGM Logic Mark high
MEAS. Restart Off
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Table 2  Initial setting (continued)Table 2  Initial setting (continued)Table 2  Initial setting (continued)Table 2  Initial setting (continued)

PanelPanelPanelPanel Group boxGroup boxGroup boxGroup box Setting itemSetting itemSetting itemSetting item Initial conditionInitial conditionInitial conditionInitial condition
 Test Item Error/AlarmTest Menu:

Measurement MEAS. Mode Repeat
MEAS. Time 00:00:00:01
Timed Start OFF

3.2G ED: Error Type Total
MEAS. Condition EI/%EFI Interval 100 ms

Performance ON
Threshold EI/%EFI ON
Power Fail ON

 Test Item Eye Margin
MEAS. Mode Margin

Phase & Threshold
Error Threshold 1E-3

Coarse
 Test Item Eye Margin

MEAS. Mode Diagram
16 points

Error Threshold 1E-3
3.2G PPG Rate 1E-3Test Menu:

Error Addition Addition Route 1
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Table 2  Initial setting (continued)Table 2  Initial setting (continued)Table 2  Initial setting (continued)Table 2  Initial setting (continued)

PanelPanelPanelPanel Group boxGroup boxGroup boxGroup box Setting itemSetting itemSetting itemSetting item Initial conditionInitial conditionInitial conditionInitial condition
Result: ALL  Display Current

Time Elapsed
Result: Zoom  Display Current

Time Elapsed
Display1 Item Error Rate
Display2 Item Error Count
Display3 Item Sync Loss
Display4 Item Clock Loss

Result: Monitor Display Current
Time Elapsed

Customize Setup1 Item Frequency
Unit 3.2G CG

Setup2 Item Clock/Amplitude
Unit 3.2G PPG (Slot3)

Setup3 Item Clock/Delay
Unit 3.2G ED (Slot4)

Setup4 Item OFF
Unit OFF

Setup5 Item OFF
Unit OFF

Setup6 Item OFF
Unit OFF

Pattern Edit Unit 3.2G PPG (Slot3)
Result Item Error Rate
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